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Getting Started
Basic
Hardware
Setup

Basic hardware setup with Livegrade and LUT boxes

Video
Signals
on
Set

Typical digital film cameras on a film set have HD-SDI outputs for external display and processing of the live image. In comparison with other video
standards, HD-SDI has the following advantages:

HD-SDI allows long
cable
length (e.g. 30m – 100m for 1080p, depending on cable type), and
HD-SDI is easily
routable
and
switchable.

Usually the live signals of all cameras on set end up at a DIT cart or similar setup for monitoring, inspecting, and further processing.

Basic
Device
Requirements

For most use cases a setup with Livegrade is built on top of an existing HD-SDI monitoring setup. You will need:

HD-SDI signals (via BNC cables) coming from the cameras on set, and
a good and calibrated HD-SDI monitor of decent size (e.g. 24 inch) with 1-2 HD-SDI inputs.

Livegrade uses LUT boxes for processing the live signals. A LUT box is a device with one (or more) HD-SDI inputs and one (or more) HD-SDI outputs.
When powered up, the device applies a lookup table (LUT) when the signal passes through. Livegrade controls that LUT and thus controls the
appearance of the live image.

Using LUT boxes for processing has the following advantages:

Hardware
solution
for
signal
processing: If the computer with Livegrade is closed, shut down, or restarted, the signal is still being processed in
the LUT box (with the last loaded LUT).
Scalable
multi-channel
setup: Adding one more HD-SDI signal channel to the setup can be achieved by simply adding one more LUT box. As the
computer running Livegrade is not busy with processing any image (as this is done in LUT boxes), a setup with for example six live signals being
processed at the same time can be implemented with a notebook running Livegrade and six LUT boxes for the signal processing.

Additional
Features
of
LUT
Boxes

In addition of applying a LUT, some LUT boxes have additional features:

Time
Code: Some LUT boxes can provide time code to the software. This helps when looks are stored in the software, as an associated timecode
can help match the looks to recorded clips later, e.g. for dailies creation.
Framegrabs: Some LUT boxes can provide framegrabs to the software. This helps to store visual references in Livegrade for alter review and
comparison, or simply as a visual reference when transferring looks to post production.
Camera
Metadata: Some LUT boxes can provide camera metadata from the ancillary (ANC) data parts of the HD-SDI signal. This metadata allows
to monitor camera settings within Livegrade, and can also act as reference information for later shooting days.

More
Options
For
HD-SDI
Connectivity

For information about additional HD-SDI setup options with Livegrade please see the article HD-SDI Setup Options.

The following topics are covered there:

Using HD-SDI capture devices in the application for framegrabs and recording.
Using HD-SDI output devices for viewing reference material and live signals on HD-SDI.
Controlling an HD-SDI router from the application.

The
Main
Screen
The main screen of Livegrade contains all primary controls for operating the software. You switch between devices, control the look of live signals, work
with stored looks, and add entries to the shot library.
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A lot of the controls have tooltips, that further describe what the control is doing. Tooltips are shown when you move the mouse over a control without
clicking it.

Some elements offer a context menu when right-clicking, for example shot entries in the shot library, the current image in slots, or look presets in the look
library. These context menus offer additional options for the right-clicked element.

Most of the actions triggered from controls in the main window can also be found in the main menu and can be triggered by keyboard shortcuts. The
keyboard shortcuts are designed for quick interaction with the application, and can be customized to your specific needs.

Livegrade’s main screen (click to enlarge)

Shot
library:

The shot library stores snapshots of the look settings and the settings of attached devices such as cameras. Over the course of a project the shot library
grows to a detailed camera log and acts as a reference database for the camera department.

New shot entries can be created in various ways and detail. For some projects where camera settings and the set and lighting is not changing often
throughout the day, you may want to only create a few shot entries, in projects with complex setup changes and varying camera and lighting conditions, a
regular creation of shots is necessary to create all needed records for covering the shooting day.

Shots always reside in bins, and bins can be grouped in folders. Folders and bins can be used to give your project a logical structure by for example
grouping shots in shooting days, cameras, units, or scenes.

You can create bins and folders with the corresponding buttons above the shot library. Drag and drop bins for grouping bins in folders or reordering bins
and folders.

Right-click on a bin or folder in the shot library for more options.

Smart
groups:

There is an advanced “Smart Groups” view accessible from the shot library window, that displays a hierarchical structured outline of the currently
selected folder level of the shot library. Smart groups are auto-generated based on shot metadata. You can define the hierarchy levels for the outline in a
gear menu, that provides the metadata fields “Season”, “Episode”, “Flagged”, “Label”, “Crew Unit”, “Shooting Day”, “Scene”, “Shot”, “Take”, “Camera”,
“Caption”, “Location” and “Rating” to choose from. You can also apply from predefined layouts or save custom layouts.

Note: Smart groups are pre-filtered by the selected folder/bin in the shot library sidebar. When you want to view all available items in the library, make
sure to select the “Library” home folder in the shot library sidebar.

Shots
table:

The shots table displays the shot entries of the currently selected bin or folder in the shot library.

A shot can contain various metadata fields shown in columns. Fields for metadata include color correction metadata from the grade controls, timecode
information and clip names, slate information such as scene and take, camera settings, manual comments and notes, and a preview image if available.
You can edit most of the metadata by clicking or double clicking the metadata field in the table.

You can change the list shown columns with the gear menu on top of the shots table. You can reorder the table columns by dragging them.

You can sort by a metadata filed by clicking on the header of a column.

You can set the row height in the shots table by changing “Shot Thumbnail Size” in the “View” menu.

You can choose to only view shots with framegrabs or recorded clips by choosing the filter buttons above the shot list. You can search for specific shots
in the currently displayed list of shots with the search field.

Right-click on the row of a shot for more options.
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Toolbar:

The toolbar contains important controls for main tasks in Livegrade, including actions to manage shots, to create a shot report from the shot library, to
open the image viewer, and to configure the user interface.

The toolbar offers specific access to the important actions to create new shots in the shot library (including creating framegrabs and recording clips),
apply the look of a stored shot on the current slot, update existing shots, and load shots into the library slot for reference.

The “Shades” button dims the entire main window. This can be useful when working in very dark studio environments. You can set the level of dimming in
the preferences.

Look
library:

In the look library you can store specific settings of the grade controls for later use as “look presets” and “node presets”.

Look presets contain the settings for a full set of grade settings and a preview image, if available. Examples for look presets are the show looks (a hand
full of looks predefined by a colorist or prepared in pre-production), or specific looks that my be reused regularly for certain setups.

Node presets only contain settings of a single or a few grade nodes. Node presets are specific, single transforms that are applied to already created
looks. Examples are ASC-CDL adjustments for a certain lens or filter that shall be applied on a live signal in addition to the creative look, or a pre-LUT that
needs to be applied to the signals of a specific camera.

The look and node presets are stored in bins, bins can be grouped in folders. You can create bins and folders with the corresponding buttons above the
look library. Drag and drop bins for grouping bins in folders or reordering bins and folders.

Right-click on a bin or folder in the look library for more options.

Note: The right panel with the look library has different tabs. To display the look library switch to the “Look Library” tab, or choose the “Color” user
interface configuration.

Looks
list:

The looks list displays look presets and node presets of the currently selected bin or folder in the look library. The presets are created with settings from
the grade controls of the currently displayed slot by clicking the corresponding “+” button. Double click a preset to apply it to the grade controls of the
current slot.

You can also create a look from a stored shot by dragging the shot from the shots table to the looks list.

You can update presets with the buttons above the looks list. Drag the thumbnail icon of a preset to move it into another bin. You can search for text in
the currently displayed list of presets with the search field.

You can lock shots in order to prevent updating them. Choose “Lock Selected Shots” from the “Library” menu.

Right-click on a thumbnail icon of a preset for more options.

Project
chooser:

With the project chooser you can switch projects. Each project has its own shot and look library.

User
interface
configurations:

In Livegrade you can manually adjust the user interface to your needs, e.g. by resizing panels,  switching tabs, and hiding and showing user interface
elements.

Additionally you can also switch to a certain configuration in the toolbar of the user interface (UI), that is targeted for a particular task. Available UI
configurations are:

Color: This UI configuration puts the color correction and adjusting of looks into the main focus of the application’s user interface
Metadata: This UI configuration puts monitoring metadata received from live signals and devices in the main focus.
Browser: This UI configuration puts browsing and inspecting stored shots and their metadata in the main focus.

Device
slots:

Slots contain controls and metadata for independent hardware systems. Each slot can represent one camera in multi-camera setups for example. You
can imagine slots as independent tabs of a web browser – changes in one slot don’t affect the state of other slots.

Slots are automatically assigned characters, starting with “A” for the first device slot.  Additionally you can add a slot label to describe their function or
contained devices.

You can also use a custom character (A-Z) for as slot character.

Each slot has a configured set of hardware devices attached. The slot user interface shows a short list of configured devices and indicators that display
connection issues.

You can quickly add a device to the current slot by choosing “Add device” from the “Slots” menu.

Some devices are capable of offering either framegrabs or live image. The current image is shown in the slot user interface. Livegrade also can display
this image in a separate viewer window.

For each slot you can maintain a set of metadata.This metadata is then stored in the shot library whenever you create a new shot entry from that slot.
Metadata can be edited manually (such as information about used filters), or automatically updated from the attached devices (such as camera settings).

You can create a shot entry in the shot library with the information from current slot by clicking the “+” button in the slot user interface of each slot.

Slots consist of the slot user interface, as well as the grade controls and the video scopes below, e.g. for controlling and inspecting the look of a slot. You
can change the height of the slot and its controls by dragging the bar above the slot.
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Device
Manager:

The configuration of devices and slots is done in the device manager. Open the device manager with “Devices…” button above the slot bar or by
choosing “Manage Devices…” from the “Slots” menu.

Global
metadata:

While the device slots display metadata that is specific to the slot’s devices, the global slot allows you to see and edit metadata that is valid for all device
slots. These are slate information with scene and take fields, production information such as episode and unit, and time and date information. This
information is stored together with the slot specific metadata to the shot library with every new shot created for any slot.

You can create new shots for every slot by clicking the “+” button in the global slot. You can configure the shown metadata field with the options menu
button above the global metadata.

Note: In the slots appearance “Tabs Only” the global slot is not visible. Switch to another slot appearance or to the metadata user configuration to see the
global metadata slot.

Configure
slot
appearance:

The slot user interface can have different appearances. You can change between appearances with or without a live image, metadata, and primary
controls, and choose different height and size settings.

Library
slot:

The library slot is a special slot that cannot contain devices. You can use it to inspect shots form the shot library, and for example for permanently
outputting a shot’s framegrab on HD-SDI for reference.

You load a shot into the library slot by clicking the “Load” button from the toolbar, choose “Load in Library Slot” from the “Library” menu, or use the
context menu of the shot table.

Note: The library slot is not shown by default. You can show and hide it by choosing “Show Library Slot” from the “View” menu.

The library slot has two option buttons that influence the behavior of selecting shots and slots together with the library slot:

“Fix HD-SDI output to this slot” (pin button): When enabled, the viewer window and the HD-SDI output always show then content of the library slot –
also when another slot is selected. This option can be used to permanently show a reference image from the library slot to HD-SDI output, e.g. in
order to compare the live image to this reference image in side-by-side mode of a HD-SDI monitor. When disabled (default behavior), the viewer and
HD-SDI output always show the image of the currently selected shot.
“Load the currently selected shot in the library slot” (“L” button): When enabled, the library slot always loads the selected shot in the shot library.
This allows quick browsing of shots and immediately seeing them on the HD-SDI output or viewer. When disabled (default behavior), you need to
manually load an image

State
indicators:

State indicators display the state of three device categories:

Status of attached hardware control panels (such as Tangent panels),
status of the video output device, and
status and activity indication for automation events and actions.

Grade
Controls
With Livegrade Pro you can interactively change the color appearance of live signals. The processing of the image is in general not performed within the
computer, but with the use of external processing devices such as LUT boxes, cameras systems, or monitors.

Livegrade Pro’s color grading feature focus on primary color correction transforms (e.g. ASC-CDL, 3D and 1D LUT and curve editor). For these transforms
typical controls are available and grouped in the user interface as “nodes”.

For most of the attached devices such as LUT boxes, the transforms of all nodes are combined into one transform whenever you change anything in the
grade. That transform is then automatically converted into a 3D LUT and sent to the device, often multiple times per second – as long as you modify the
controls, such as turning a knob.

With some devices such as cameras, ASC-CDL values and lookup tables are updated independently in the camera.

The automatic and continuous update of the attached device allows interactive look control and fine adjustments of the appearance of the live image.

Livegrade Pro’s grade controls

Nodes:


The grade controls for the currently selected slot are grouped in “nodes”. A node can for example contain controls for a ASC-CDL transform, or for
loading  a 3D LUT preset. Nodes are applied to the live signal from top to bottom, the top node is applied first, and the following nodes subsequently. If
the grade node is reset or freshly added, it doesn’t affect the image. Change the controls of a node to give the node effect to the image. Each control or
group of controls in grade nodes has a button with a little arrow that resets the controls.

You can enable and disable single nodes by using the checkbox on the left of each node. Disabled nodes are greyed out.
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Nodes can have names. Click on the small pen symbol that appears when you move the mouse over the column on the left of each node. You can use
names to better identify nodes with different roles (e.g., “pre LUT” and “post LUT”). Node names are also used when applying node presets from the look
library for identifying nodes to be updated.

Note: Grade controls can be invisible, if the entire slot and control area is minimized in height. Drag the bar above the grade controls or the slots in order
to make space for displaying grade controls.
The video scopes have a minimum height that also influences the minimum height of the grade controls. Open the scopes in a separate window or hide
the video scopes in order to resize the grade controls to smaller height.

Grading
mode
control:

Livegrade Pro comes with a set of grading modes, targeted to different color pipelines. There are basically four different groups of grading modes:

ASC-CDL + 3D LUT modes, (typical color pipelines for a broad range of cameras and projects)
ACES modes (for use in projects that choose the ACES pipeline),
device specific modes (targeted to the capabilities of certain devices), and
freestyle modes (without any limitations in color pipeline, but reduced compatibility).

With some grading modes you can edit the list of used nodes in the grade controls. An “Edit” button appears in the bar with the grading mode if the
grading mode allows modification of the grade nodes. For example in the “CDL Advanced” mode you can add more grade nodes, e.g. for additional 3D
LUTs or ASC-CDL nodes.

Note: In order to match looks with clips for dailies creation and create the same color appearance on dailies as on the live image, it is needed to
coordinate the grade mode and the node pipeline with the dailies creation process.

Look
name:

When creating a look preset in the look library or a shot entry in the shot library, a look name will be added. You can prepare and edit this look name in the
look name field of the grade controls.

Look
display
modes:

In a slot you can switch between different look display modes. Look display modes temporarily enable and disable specific grade nodes:

Graded: All nodes are enabled. The result image shows the original image with all nodes applied.
Bypass: Only 3D and 1D LUT nodes are enabled. The result image shows the original image with only these nodes applied, this will result in a
“neutral” image.
Original: All nodes are disabled. The result image shows the original image with no nodes applied.

Disabled nodes are greyed out.

With the “False Color” control you can enable and disable the false color mode. The false color mode is always applied to the current result image.

Each slot also has controls to switch look display modes in the slot user interface.

Reset
look:

With the reset look controls you can reset a look. “Neutral” clears and resets all nodes. “Reset colors” leaves 3D and 1D LUT nodes untouched and only
clears all other nodes such as ASC-CDL nodes.

Video
scopes:

The video scopes panel offers histogram, waveform, and vectorscope inspection tools with individual settings. The video scopes show the analysis of the
current image of a slot with the current grade nodes applied.

The histogram and vectorscope also include a curve overlay that display the result curve of the combined transforms of all active grade nodes in the slot.
The result curve is always shown, also when there is no current image available in a slot.

You can show and hide the video scopes from the main menu and from the toolbar. You can open the video scopes in a separate window by clicking on
the “Toggle Windowed / Docked View” button in the bar above the video scopes.

Configure
video
scopes:

To switch between different types and combinations of video scopes choose the controls in the bar above the video scopes.

You can configure the update frequency of the video scopes from the wedge menu in the bar above the video scopes. The update frequency can have an
impact on CPU use of your computer. Lower update frequency (e.g. less updates per second) lead to less CPU usage.

Slot
User
Interface
The slot UI summarizes all information for a slot, and acts as a tab user interface element to switch between tabs. The selection of a tab is indicated by a
blue background.
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Slot details

Slot
name:

Each slot has a character and a label. You can edit the slot character and the slot label in the device manager.

Clip
identifier:

The clip identifier can be used to uniquely identify shots in the look library. It can be considered as the default name for an entry in the shot library, and
acts a the default name for exported looks, CDLs, stills etc. A common clip identifier format consists of a camera character, reel number, and clip number
(e.g. A003C012).

There are different ways keeping the clip identifier updated, so that each created shot gets a meaningful and unique clip identifier:

Increase clip and reel numbers: By default the clip name is assembled from the slot character, the “Clip” field and the “Reel” field of the slots
metadata. There are shortcuts in the main menu for increasing the clip number and increasing the reel number (and resetting the clip number to 1) in
the “Slot” menu.
Clip name from camera metadata: If the attached devices provide camera metadata, the actual clip name from the camera is often available. This
automatically will use the clip name of the camera as the clip name for a saved shot.
Edit the clip name manually: You can also edit the clip name manually.

You can configure clip identifier updating for each slot separately in the menu of the “Configure metadata” button of each slot. Clip identifiers can
be “Slot-Reel-Clip” (as a clip filename), the clipname metadata field coming through HD-SDI ANC data, or your custom wildcard configuration, e.g. made
up of shot and scene names. There is also a setting for the default behavior for new slots in the preferences.

Summary
of
configured
devices:

Small icons represent the configured devices in a slot. The number of icons shown is limited to three, if more devices are configured, only the first three
are shown.

If a device has a connection problem, a yellow warning symbol is shown. The device icons offer tooltips for quick access of the device name, and the
warning message in case of a problem.

Below the clip name, a summary indicator is shown, that is also visible, when the slot is in “Tabs only” mode.

You can configure the devices, add new and remove devices of a slot in the device manager.

Reload
devices:

Clicking this button manually triggers a reconnect to all devices of a slot. Sometimes this can solve connection problems, e.g. when a connection was lost
due to bad Wifi.

Current
image:

If one of the configured devices of a slot provides framegrabs (e.g. from a LUT boxes or attached camera) or live image (e.g. from a capture device), the
current image is updated in the slot.

The image shown here can also be shown larger in the viewer window.

The image shown here is also the image that is analyzed by the videoscope.

You can use any framegrab stored or imported image from the shot library to be shown here. This can be used to review the current look of a slot with
other images. Choose “Set as Image for Current Slot” from the context menu of a shot row in the shot list, or drag a shot from the shot list on to the image
of the slot.

A little “A|B” icon on the current image indicates, that a reference image is set, that is used in the image viewer for comparison. You can remove a
reference image by choosing “Remove reference” from the context menu of the current image.

Update
framegrab:

With the update framegrab button you can manually request a new framegrab from the attached device. If the shown image is a live image (e.g. from a
capture device) or no current image is shown, the update framegrab button is hidden.

Save
still
image:

With the save still image button you can save the current image as an image file to the file system. A temporary overlay will show the path the image file is
saved to.

You can configure the file system location, the format, as well as the naming convention of the still image file in the preferences.
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Display
options
for
slot:

In a slot you can switch between different look display modes. Look display modes temporarily enable and disable specific grade nodes:

Graded: All nodes are enabled. The result image shows the original image with all nodes applied.
Bypass: Only 3D and 1D LUT nodes are enabled. The result image shows the original image with only these nodes applied, this will result in a
“neutral” image.
Original: All nodes are disabled. The result image shows the original image with no nodes applied.

Disabled nodes are greyed out.

With the “False Color” control you can enable and disable the false color mode. The false color mode is always applied to the current result image.

The controls for the display options of the currently selected slot are also accessible from the bottom bar of the main window.

Slot
metadata:

The fields in the slot metadata table can either be edited manually, or updated automatically with camera metadata from the attached devices:

An “A” icon indicates, that the metadata field is updated automatically from the device,
a little pen icon indicates, that the metadata field is edited manually, although metadata for that field is sent by a device, and
no icon indicates, that the metadata field needs to be edited manually, because no metadata for that field is available from any device.

You can switch between editing and automatic update by clicking on the little icons.

For the “Clip” and “Reel” fields you can use the up and down buttons to quickly increase the clip and reel numbers.

You can configure which metadata field is shown in the menu of the “Configure metadata” button.

You can reorder the displayed metadata fields by dragging and dropping the fields to another position.

You can configure how many rows of metadata are shown in the menu of the “Configure slot appearance” button.

You can configure, which device should be the source of the metadata (if multiple devices provide metadata) in the menu of the “Configure metadata”
button.

Time
code:

Time code is shown, if one of the attached devices provides time code information.

You can configure which device should provide time code (if multiple devices provide metadata) in the menu of the “Configure metadata” button.

Timecode can later be used in workflows where stored shot and look information shall be matched to recorded camera clips.

Configure
metadata:

When clicking the “Configure metadata” button, a menu with all available metadata fields is being displayed, as well as options for the metadata
processing, merging, and display.

“Metadata from…” and “Timecode from…” let you choose what should be used as the source for that information in case multiple devices provide that
information. When “Combine metadata from all devices” is checked, metadata fields from multiple devices are merged.

The “Clip identifier” submenu lets you choose a scheme for the updating of the clip identifier. You can choose either predefined schemes, or create your
own by choosing “Edit custom clip identifier…”.

The metadata fields are grouped in sections, you can show and hide a single metadata field by checking or unchecking it. You can show and hide entire
sections by clicking on the section heading.

If a metadata field’s value is automatically updated from a device, the value is shown behind the field’s name.

“Add entries with values from devices” adds all metadata fields that currently have values from devices.

“Apply selection to all slots” will set the selection of displayed fields of all other slots to the selection of displayed fields of the current slot.

The
Device
Manager
The device manager contains all controls to setup devices and slots, and represents the core configuration dialog for attached and controlled hardware
devices.

You can open the device manager either by clicking on the “Devices…” button in the slot bar, or by choosing “Manage Devices…” in the “Slots” menu.

The device setup is saved and restored on every application restart. So once the devices are configured, they will show up in the same way after the
computer, the devices, or just the application performed a restart.
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Device Manager (click to enlarge)

List
of
Slots:

The device manager shows the same list of slots as the slot bar in the main window.

You can add a slot by clicking the “Add Slot” button on the bottom of the window. You can delete a slot by clicking the “Delete Slot…” button in the slot.

Slot
character:

When creating a slot the next available letter (A-Z) is being used as slot character. The slot character also appears in the slot user interface in the main
window.

Custom
slot
character:
You can also use a custom slot character by clicking into the “Char” field and typing in a letter (A-Z) that is still available.

Slot
label:

In addition to the slot character each slot can also have a descriptive name (slot label). Type into the “Label” text field to edit the slot label. The slot label
also appears in the slot user interface in the main window.

If you prefer to use multi-digit slot names instead of one slot character, you can enable the “Show Slot Label Only” option, which hides the slot character
from the UI and indicates slots consistently using your custom slot label text within

the slot interface,
all slot-based menu items,
and the device manager.

Furthermore, slot-based menu items and the device manager interface display a slot index number for quick referencing associated controller actions,
(e.g., for Stream Deck controller actions).

Device manager with “Show Slot Label Only” enabled

Note: If “Show Slot Label Only” is enabled the automatic camera value is set up to use the slot label value automatically.

Tip: Consider updating your wildcards and Stream Deck layout when using this option, e.g., set the clip identifier naming scheme “D4” (Slot Label – Reel
– Clip).

List
of
devices
in
a
slot:

Each slot contains a list of devices. Each device is represented by a device row with an icon. You can move devices from one slot to another by dragging
and dropping the device rows.

Some devices also can act as an image source, such as LUT boxes that support framegrabs. For these devices an additional row is added that
represents the image source.

Each device shows information about the identity or the connection of the device, such as a device name or IP address.

Capture devices also show up as devices of a slot. You can enable and disable auto-record behavior of each capture device in the device manager.
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Manage
devices
in
a
slot:

You can add devices by clicking the “Add Device…” button, and choose the device type from the shown menu.

You can delete a selected device by clicking the “Delete…” button.

Configure
a
device:

Devices can have different configuration options.

LUT boxes can be identified with the “Blink” button, a cycle of primary colors will be displayed on the output image of the LUT box to identify the
right physical device.
With the “Config…” button you can configure connection options of the specific device.
Some devices offer the possibility to set video range options and color management options.

Slot
and
device
configurations:

You can save and restore entire configurations of slots and devices with the “Save and Restore” button. The list of slots and devices with their
configurations can be stored in an external file, and restored from such a file at a later time.

This can be used either to transfer your hardware setup to another computer (e.g. when replacing a computer), or to switch between different hardware
setups with the same computer (e.g. when switching between an advanced setup in a DIT cart and a smaller, more mobile setup).

Refresh
controls:

“Reload Devices” re-initializes the connections to all devices.

“Refresh ICC Profiles” reloads the list of ICC profiles for color management settings.

Link
slots:

You can link slots to interact with multiple slots simultaneously. This can be used e.g. for parallel processing of signals, for parallel SDR and HDR viewing
of the same signal, or for interacting with multiple camera signals at the same time.

 

Stages:

Livegrade Studio lets you group slots into stages for handling independent scenes (e.g., from multiple units) within one project.

You can configure stages in the device manager. You can set a custom name for your stages, e.g., “Main Unit” and “Splinter Unit”. Slots are
automatically assigned to the first configured stage. You can change the assignment individually for each slot in the device manager. See detailed article
Grouping Slots into Stages.

Configuring stages within the device manager

 

Exporting
Shot
Information
The shot library can contain a lot of information, that is valuable for other steps and roles in the workflow.

The most important destination for look information is the dailies creation process. For that there are two possibilities of exporting the look of stored
shots:

Exporting a shot log PDF report.
Exporting single look files in various formats, such ASC-CDL, 3D LUT, AMF (for ACES looks), and camera specific look files.
Exporting entire folders or bins of the shot library for matching the looks to recorded camera clips in other applications such as Silverstack Lab.
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Exporting
a
shot
log
PDF
report:

You can export the shots of the currently selected bin or folder with their metadata as a PDF report. Either choose the “Report” button in the toolbar,
choose “Export Folder as Look Report…” from the “File” menu, or use the context menu of the bin or folder to create a PDF report.

The report consists of a table of shots with metadata columns. The selection of columns follows the selection of columns in the shot table of the main
window. You can change the columns in the report by changing the columns in the shot table.

Exporting
Shot
Metadata
as
CSV:

You can export the shots of the currently selected bin, folder, or smart group as a CSV metadata sheet by choosing “Export as Shot Metadata (CSV)”
from the “File” menu or from the associated contextual menu items in the shot library.

The shot metadata sheet includes all columns of the shots table’s current view. The clip-identifier is used to identify the shot and is therefore displayed as
the first column. You can change the columns in the sheet by changing the columns in the shots table.

Exporting
single
look
files:



By choosing “Save selected shots as…” from the “Library” menu, a file save dialog opens that contains options for the exported file formats.

The “Export looks” setting lets you choose from a list of formats, containing ASC-CDL, various 3D LUT formats, and device specific files such as Alexa
look files.

Note: Not all export formats are available for all shots. The list of offered export formats depends on the grading modes of the looks stored with the
selected shots.

The “Naming scheme” lets you choose a scheme for the use of file names for the to-be-exported shots. You can either choose one of the predefined
schemes, or create your own scheme based on metadata from the shot.

You can also export a still image for each shot, based on the available framegrab for a shot. You can choose which format the image file shall be, and if
the look shall be applied, or of the original image should be exported.

Additionally, you can share graded still images of shots via Airdrop for instant communication with other team members on set.

You can enable and disable the export of both look files and image files, so that you can export only look files, only image files, or both.

You can find more information about exporting look metadata in the article Exporting Look Metadata.

Exporting
folders
of
shots
for
look
matching:

You can export a look archive that contains information of multiple shots with thumbnail, and all metadata and look information. You can use this look
archive to export a folder (e.g. a shooting day) of your shot library to Silverstack Lab for automatic matching of look and camera metadata with the
recorded camera clips.

For exporting a look archive, choose “Export Folder as Look Archive…” from the “File” menu, or use the context menu of a folder or bin in the shot library.

Media
Folders
and
Record
Folder
Media files imported or recorded within Livegrade are stored in a designated “Media Folder”. Each project uses one media folder as the current “Record
Folder.” When you import new media files or generate new recordings within Livegrade, the corresponding media files are saved into the currently set
record folder.

Media folders and the current record folder are project-depending settings. Consequently, it makes sense to use a separate media folder/record folder for
each project.

You can set the record folder when creating a new project or change the record folder in the “Recording” preferences. The default parent directory for
project Media is “Livegrade Media” in ~/Movies.
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“New Project” window with suggested record folder

 

Unique
media
folder
references
and
media
status

Each Livegrade media folder contains a “LIVEGRADE-ASSET-FOLDER.json” file holding an UUID for unambiguous referencing of media assets in
Livegrade projects.

JSON file in media folder holds UUID

Note: Livegrade detects a media folder by reading the UUID stored in the JSON file of the folder. Make sure that the corresponding JSON file always
remains in its media folder. 

When you change a project’s media folder in the recording preferences, Livegrade automatically detects the UUID of the new media folder and
reconnects any matching media if the project holds media files that are associated with the UUID.

Removing a media folder that contains project media files results in an offline media status for the associated shots. When you add a matching
media folder again, offline media files reconnect immediately, also if the directory was renamed or moved in Finder or it is a copy of the original
directory on another drive.

You can see if a media file for a shot is offline by checking the opacity of the type icon in the shots table or the info tab. A light-grey “Media Offline” image
indicates the offline media status also in the info tab and in slots using the media as current image source.

Shots with offline media status

The offline media status of media folders (and volumes) is also indicated by a lower opacity of the rows in the table of the recording preferences.

Offline media folder in recording preferences

Livegrade’s media storage system also allows sharing Pomfort look archives (.pfla), including media; see Sharing look archives with media.
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Progress
bar
for
monitoring
media
import/export
tasks

You can monitor running media import or media export jobs in the progress bar. If required you can cancel running jobs. All jobs are also canceled
automatically when you quit Livegrade and will not be resumed when Livegrade is opened again.

Note: Already copied files will not be deleted after canceling a job. Make sure to delete redundant files manually in the Finder if necessary.

Progress bar indicates status of running import/export jobs

 

Multiple
media
folders

Livegrade Pro is limited to one active media folder (record folder) per project, while Livegrade Studio also supports using multiple media folders in one
project simultaneously:

In Livegrade Studio you can add multiple media folders to the same project. In the media folders table of your project’s recording preferences you can
add and remove media folders. One media folder can be made the current record folder. You can remove all media folders with the exception of the
currently set record folder. When importing PFLAs with media you can add the corresponding media folder to your project’s recording preferences and
use it immediately without copying the files to your record folder. Learn more about Sharing look archives with media.

Recording Preferences Livegrade Studio

Note: When adding a media folder from another project to your project’s recording preferences and you delete shots and the associated media files within
one of the projects, the files will be offline in both projects

Direct
import
of
a
directory
with
media

With the menu item “Add Media Folder and Import Media…”, you can add a directory with media as a new media folder to your project’s recording
preferences and import all containing media files directly into your shot library (without copy process). All importable media files, including files in
subdirectories, will be imported as new shots.

Important
Note: The media folder will be managed by Livegrade so that deleting a shot will also delete the associated media file on your hard drive.

 

Handling
media
files

Livegrade provides various options to handle the media files of your recordings and framegrabs:

Duplicate
As
Shot
With
Still
Image: You can duplicate shots with movie recordings as new shots with still images (e.g., to save disk space or to
create a duplicate with reference image for working in mobile environments with reduced equipment). The still image is created at the position of the
shot’s thumbnail frame and is stored in the currently active record folder, even if the original movie recording is stored in a different media folder.
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Delete
Shots:
When deleting shots, you can choose to delete the shot and the associated media file or to delete the shot and keep the media file
(e.g., to avoid conflicts with files in a shared media folder).
Delete
Media
of
Selected
Shots: If you do not need the media files of some shots anymore, you can delete the associated media files of shots and
convert your shots with media into “look-only” shots.
Reveal
Media
In
Finder:  A “Reveal Media In Finder” item in the contextual menu of the shot library lets you quickly reveal the associated media file
of a selected shot in its media folder in the Finder.

The
Image
Viewer
The image viewer shows the image of the currently selected shot or the library slot.

When an HD-SDI output device is configured, the HD-SDI output of that device always shows the same image as the image viewer.

You can set the image viewer to fullscreen on the screen where the viewer is currently shown by clicking the green little icon in the window header bar, or
click “Fullscreen” in Livegrade Pro’s toolbar.

In a setup with two computer screens attached to your Mac (or a notebook screen with an additional external monitor) the viewer can go fullscreen on
one computer screen, while the Livegrade Pro main window is shown on the other screen. To do so, move the image viewer window to the second screen
and then go to fullscreen.

The image viewer can display a second image or look (e.g. from a framegrab or a movie of a shot) for reference in a split-screen or overlay mode.

 

Image
Overlay:

The image overlay displays the display options for switching between “Graded”, “Bypass”, and “Original” image. These controls double the controls from
the slot user interface.

The image overlay also offers a “Export image” button. This button saves the current image in the file system of your Mac. This control doubles the
control from the slot user interface.

Reference
Overlay:

The reference overlay shows the name of the image shown for reference, and allows to remove the reference.

Reference
Options

In the reference options you can choose which compositing mode should be used for displaying the reference image with the viewers image.

Options are

Left – Right: Side-by-side with movable image splitter, viewer image is left, reference image is on the right.
Overlay: Reference image is composited over the viewer image with variable opacity.
Show / hide the reference
Flip (mirror vertically) and flop (mirror horizontally) the reference image for improved arrangement

Image
Splitter:

You can move the image splitter (e.g. shown in “Left – Right” mode) by dragging it.

Image
Information:

The header of the image viewer displays the current slot name, the name of the image and the name of the reference image.

Playback
Controls:

The playback controls provide buttons for play, next frame, previous frame and go to start/end of the movie.

A timeline slider indicates the current position and allows scrubbing to a specific position. Playback can also be controlled using the keyboard shortcuts
J, K and L:
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Playback: Press L to play forward, K to stop and J to play reverse 
Shuttle: Pressing the keys L or J two or multiple times increases the playback speed by factors 2x up to 64x
Jog: Holding K and pressing L or J allows users to frame-step through a clip forwards (L) and backwards (J)

Other shortcuts for navigation in movies are available from the main menu.

JKL keyboard navigation works for all movies loaded in slots, either in the viewer window or via SDI connected monitoring devices.

A “Loop” checkbox lets you enable/disable loop playback.

Jump
To
Timecode:

The player HUD displays the timecode for recordings and imported movies. There is an arrow button on the right hand side of the timecode display.
Pressing the arrow button opens the “Jump to Timecode or Time” sheet with two tabs “Timecode” (displays current timecode) and “Time” (displays
current clip runtime calculated from starting timecode 00:00:00:00).

“Jump to Timecode or Time” sheet

Copied timecode references can be pasted in various formats, e.g. “05:57:45:12” or “05:57:45;12” or “05574512”. Pressing Enter moves the
playback position to the desired frame in the video.
In the “Timecode” tab you can type in a timecode in the format “HH:MM:SS:FF” (e.g. “10012212” = TC “10:01:22:12”). If you enter less than 8
digits, the timecode will automatically fill in the first timecode digits of the current movie, e.g. if the video has a starting timecode of “10:00:00:00”
and you enter “2315″ the playback position jumps to TC “10:01:23:15”. 
In the “Time” tab you can enter the clip runtime, you want to move the playback position to. The clip runtime is always calculated from starting
timecode 00:00:00:00, so that entering e.g. “0124” moves the playback position to the clip runtime 1 second, 24 frames.

“Jump to Timecode or Time…” can also be accessed via the “Edit” menu.

Set
Thumbnail
Frame
and
Jump
To
Thumbnail
Frame:

There are buttons for “Set Thumbnail Frame” and “Jump To Thumbnail Frame” in the player HUD. A little marker icon in the time slider indicates the
current position of the thumbnail frame. “Set Thumbnail Frame” changes the thumbnail for the shot in the shot library. “Jump To Thumbnail Frame” moves
the playhead to the current position of the thumbnail frame.

“Set Thumbnail Frame” and “Jump to Thumbnail Frame” in Player HUD
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Setting up Devices
HD-SDI
Setup
Options

Basic
Hardware
Setup

Basic hardware setup with Livegrade and LUT boxes

The article Basic Hardware Setup covers the most common hardware setup with Livegrade for live color grading.

The article explains:

Video signals on set (HD-SDI for video signals)
Basic Device Requirements (monitor and LUT boxes)
Additional features of LUT boxes (time code, frame grab, and metadata)

Please make sure you read the article Basic Hardware Setup first, before you proceed with more advanced options below.

In addition to LUT boxes some cameras and monitors can also perform the look processing (“in-camera grading” and “in-monitor grading”).  See the
article All Supported Devices for an overview of all supported devices and their capabilities.

Using
HD-SDI
capture
devices

The application can use connected capture devices to get access to live image within the software. 

Capturing video signals with a capture device with Livegrade

By capturing live signals you can:

Monitor live signals in the application’s image viewer,
store thumbnails of the current image in the shot library, and
store frame grabs and record clips for later reference.

Using
HD-SDI
output
devices

The application can use connected video output devices to output image from within the software to HD-SDI.
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Video output to HD-SDI

You can output:

Stored frame grabs and for reference output,
playback of recorded clips,
processed live image (when also using a capture device), and 
combined and split view of frame grabs and live image

Learn more about video output in the article Image View Output to HD-SDI.

Controlling
an
HD-SDI
router


HD-SDI video routers allow to route signals from any source to any destination. The application can control a video router and automate routings
depending on the state (e.g. selection of slots) in the user interface.

Video routing with cameras, monitors, LUT boxes, capture devices and video output devices

Please see the article Controlling an External Video Router for learning more about controlling a video router.

Setting
up
HDR/SDR
dual
monitoring

For HDR/SDR dual monitoring the camera’s video signal can be wired to one grading device configured to display the signal in Rec.2020 HDR
colorspaces on an HDR monitor and another grading device (or second LUT box channel) to display the signal in Rec.709 colorspace on an SDR monitor.
Alternatively, the camera’s video signal can also be distributed to two devices via a video router (see above).
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Video setup for HDR/SDR dual monitoring

Setting
up
Flanders
Scientific
BoxIO
Livegrade comes with support for Flanders Scientific’s BoxIO LUT box.

FSI BoxIO

For general information about setting up Livegrade with HD-SDI devices please refer to the article HD-SDI Setup for Livegrade.

Adding
the
FSI
BoxIO
as
a
Device

In order to exchange look information with Livegrade, the FSI BoxIO needs to have a working network connection with the Mac where Livegrade is
running on.

The default IP address for BoxIO can be found on the bottom of the device (e.g. 192.168.1.244).

Once you obtained the correct IP address, launch Livegrade and you can proceed to add the BoxIO as a device. In order to do that, you can choose
“Slots” in the main menu and then “Add Device”. Alternatively, you can add the device through the Device Manager.

After that, a wizard window opens:

Enter the IP address of the BoxIO
Click on “Add FSI Device ”
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Single-
vs.
Dual-Channel
Mode

The BoxIO possesses two separate processing chains and can be used in so called single-
or
dual-channel
mode. You can learn more about the
different modes on the FSI web page.

You can change the mode of the device via the BoxIO utility provided by FSI.

In single-channel mode Livegrade will use BoxIO as a usual device and will add it to a slot:

BoxIO in the Device Manager in single-channel mode.

In dual-channel mode BoxIO will generate two device instances named with “Ch. 1” (Channel 1) and “Ch. 2” (Channel 2) that will be added to successive
slots in the Device Manager:

BoxIO in the Device Manager in dual-channel mode.

Please be aware that you will have to re-add the BoxIO device after changing modes. Once the gradin mode is changed, hit the refresh button in
Livegrade and you will see the device name indicate the status in the Slots view.

While transitioning from single-channel to dual-channel mode delete the BoxIO from the slot and add it again to see two channels populate. While
transitioning from dual-channel to single-channel mode simply erase the second device (Channel 2) from the slot.

When initially connecting the device in dual channel mode you can switch back and forth between the two modes while always refreshing the devices.
Switching into single-channel mode will activate channel one to work solely while channel two will immediately work again when switching to dual-
channel mode and refreshing the devices in the slots in Livegrade.

Getting
the
FSI
BoxIO
Image
in
Livegrade

BoxIO is capable of taking a framegrab from the SDI signal that is connected to it.

In the main Livegrade window, the FSI BoxIO is now displayed in the corresponding grading slot as a device, as well as the FSI BoxIO image as an Image
Source of the same slot.

You can open the Image Viewer to display the image by double clicking on the «FSI BoxIO Image» thumbnail.
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The FSI BoxIO’s image in the Image Viewer

In case that the live image has changed, you can update the image shown in Livegrade by clicking on the «Refresh Image» button. After that you will have
the latest frame of the live image.

Controlling
the
SDI
Signal
Range
Through
Livegrade

Livegrade allows to control the SDI signal range through the device manager. When controlling the SDI signal range through the BoxIO application,
Livegrade will display the selected range in the Device Manager:

The signal range set through the BoxIO app.

Click the “Advanced…“ button (highlitted in yellow) to enable the signal range control by Livegrade:

Controling the signal range through the Livegrade Device Manager.

You will now be able to control the signal range inside of Livegrade. Please refer to the article Legal and Extended – SDI-Signals and LUTs in Livegrade to
learn more about the range control in Livegrade.

 

You can generally check if the FSI BoxIO is properly connected by going to the Device Manager. A green indicator shows a positive connection status.
You can use the «Blink» button to send a red-green-blue screen flash sequence to check if the BoxIO is ready for the use with Livegrade.

FSI BoxIO can also be connected via Wifi. For best performance concerning fluid look interaction and framegrabs we recommend a tethered ethernet
connection.

25

Livegrade Studio 
Setting up Devices



ScopeStream

The FSI device provides a technology called “ScopeStream” that calculates scopes for the signal on the hardware device and provides it for display on
your Mac.

When adding a FSI device (DM monitor series or BoxIO) you can choose to enable the ScopeStream with the according checkbox:

Enable ScopeStream when adding a FSI device.

Livegrade automatically opens the ScopeStream window:

The ScopeStream window showing a waveform

After closing the ScopeStream window it can be reopened again by clicking the gear button next to the device in the slot view:

Reopening the ScopeStream window.

Please
be
aware that the scopes are drawn from the unprocessed signal. Looks that are applied to the FSI device are not taken into account for the
ScopeStream scopes.

 

Tags: waveform, vectorscope

Setting
up
Teradek
COLR
Livegrade comes with support for Teradek COLR. The Teradek COLR is a LUT-Box that can be controlled wirelessly by Livegrade and offers a LUT size
of 33 x 33 x 33.

For general information about setting up Livegrade with HD-SDI devices please refer to the article HD-SDI Setup for Livegrade.

Adding
the
Teradek
COLR
as
a
Device

In order to exchange look information with Livegrade, the Teradek COLR needs to have a working network connection with the Mac where Livegrade is
running on.

It’s possible to wirelessly connect Livegrade to the Teradek COLR by choosing the wireless network the COLR device is producing from the list of
networks on your computer:
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Choose the wireless network of the Teradek COLR from the list of networks.

The COLR device can also be connected via USB or Ethernet for a tethered connection.

Once a correct connection is established, launch Livegrade and you can proceed to add the COLR as a device. In order to do that, you can choose
“Slots” in the main menu and then “Add Device”. Alternatively, you can add the device through the Device Manager.

After that, a configuration window opens:

Add Teradek Device

By hitting “Refresh” you can search for compatible devices connected to your network. All devices found will show up in the table view. Select the
intended device and click “Add Device” to add the device to the selected slot.

If you want to add devices by a certain IP-address rather than letting Livegrade search for them in your network you can hit the button “Custom IP” to
reveal a text field where you can enter the IP-address of the chosen device.

If connected properly the Teradek COLR will show up as a “Device” row in the Device Manager with a green button indicating a positive connection
status :

The Device Manager shows a properly connected Teradek COLR.

 

By clicking on the button “Config…”  an info window opens where you can see all information available on your device:
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Teradek Device Info

The Teradek COLR has a web interface where you can make changes to the configuration of the device. You can access the web interface by clicking on
the button “Show Web Interface”. There you can e.g. alter the name of the Teradek COLR as shown in the Device Manager.

 

Working
with
the
Teradek
COLR
in
Livegrade

In the main Livegrade window, the Teradek COLR is now displayed in the corresponding grading slot as a device.

After selecting the correct grading slot you will be able to adjust the look that is sent to the COLR by modifying it in the Main Window of Livegrade.

Note: The Teradek COLR can be used with different grading modes such as e.g. “CDL and LUT”, “CDL Advanced” or “ACES CDL”. The interaction speed
may vary in different modes: As the COLR device natively supports CDL plus LUT grading modes, a setup with CDL plus LUT node in this order will
interact fluently. Other more complex grading modes may interact a bit slower.

You can permanently store up to 32 looks on the Teradek COLR. In order to store a new look on the COLR perform a right click on a look from the Look
Library and choose “Permanently Store Look on… -> Teradek Device at A – Colr… -> …” to either add the look as a new preset or overwrite an existing
preset:

Permanently store a look on the Teradek COLR.

 You can also manage the looks (rename, delete) in COLR’s web interface.

Above all, a look can also be applied to the HDMI output of the Teradek COLR. That even allows a conversion from HD-SDI to HDMI containing looks.

Setting
up
IS-Mini
Livegrade comes with support for the following IS-mini LUT box devices:

IS-mini 4K
IS-miniX
IS-mini
IS-miniX Rack4K
IS-mini Rack4K

Note: As the IS-mini integration does not run under M1 natively, make sure to install Rosetta on your machine. However, you do not need to open
Livegrade using Rosetta as the IS-mini integration will run in its dedicated service in the background.

For general information about setting up Livegrade with HD-SDI devices please refer to the article HD-SDI Setup for Livegrade.

Configuring
an
IS-mini
device

It is recommended to connect the IS-mini via USB. Once a correct connection between the IS-mini device and your computer is established, launch
Livegrade and then proceed to add the IS-mini as a device. In order to do that, you can choose “Slots” in the main menu and then “Add Device”.
Alternatively, you can add the device through the Device Manager.

Set up your camera type for appropriate ANC metadata transfer. You can also choose to “Continuously refresh framegrab and metadata” and set an
update interval for refreshing.

Note: When using the IS-mini 4K it is only recommended to enable frame grab for HD video signals due to hardware limitations.

Setting
up
AJA
ColorBox
Livegrade comes with support for AJA’s ColorBox LUT box devices.
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AJA ColorBox

For general information about setting up Livegrade with HD-SDI devices, please refer to the article HD-SDI Setup for Livegrade.

Adding
the
AJA
ColorBox
as
a
device:

To exchange look information with Livegrade, the AJA ColorBox needs to have a working network connection with the Mac where Livegrade is running. 

Note: It is strongly recommended to connect the device hard-wired via Ethernet.

Please refer to the manufacturer’s documentation for setting up the ColorBox in your network with a dedicated IP address.

The ColorBox has a web interface for configuring the device’s IP address, watching a preview of the live video signal, configuring the system settings, and
more.

Once you have obtained the device’s IP address, you can add the ColorBox to any slot using the Device Manager or the associated “Add Device…”
menu item.

Configuring
AJA
ColorBox:

While adding the AJA ColorBox, you have the following options to configure the device:

IP
Address: Enter the device’s IP address
ANC
Metadata: Choose your camera’s manufacturer for appropriate detection of ANC metadata
System
Settings: Open the device’s web interface for configuring system settings such as signal range and color conversion
Framegrab: Enable a continuous framegrab (ungraded 16-bit Tiff at native resolution) and choose an update interval 

Note: A high update interval at 4K resolutions requires a high performant hard-wired network connection.

Setting
up
AJA
FS-HDR
Livegrade comes with support for AJA FS-HDR devices. Livegrade can control the FS-HDR via a network connection in two different modes:

“Dynamic
3D
LUT” can be used to apply a grade as a 3D LUT to the live signal.

“Colorfront
Film” can be used to apply processing of the Colorfront Engine to the live signal. See Using the Colorfront Film Grading Mode on details
about using the Colorfront Engine with FS-HDR.

A list of all devices supported in Livegrade can be found in the Knowledge Base article All Supported Devices in Livegrade.

For general information about setting up Livegrade with HD-SDI devices please refer to the article HD-SDI Setup for Livegrade.

Adding
the
AJA
FS-HDR
as
a
Device

In order to receive look information from Livegrade, the AJA FS-HDR needs to have a working network connection with the Mac where Livegrade is
running on. Once a correct connection is established, launch Livegrade and you can proceed to add the AJA FS-HDR as a device. In order to do that, you
can choose “Slots” in the main menu and then “Add Device”. Alternatively, you can add the device through the Device Manager.

After that, a configuration window opens:

By hitting “Refresh” you can search for compatible AJA FS-HDR devices connected to your network. All AJA FS-HDR devices found will show up in the
table view. Select the intended device and click “Add
Device” to add the box to the selected slot.

Working
with
the
AJA
FS-HDR
device

In the main Livegrade window, the AJA FS-HDR device is now displayed in the corresponding grading slot as a device.

After selecting the correct grading slot you will be able to adjust the look that is sent to the AJA FS-HDR device by modifying it in the Main Window of
Livegrade.

FS-HDR’s “Dynamic 3D LUT” mode is available in “Single Channel” mode for 4K applications (the same 3D LUT will be applied to all four channels of the
device) as well as in “Multi-Channel” mode for  independent LUTs for each of the four HD channels of the device. In order to use the four channels
independently from Livegrade, you need to add the FS-HDR device multiple times, each configured with a different channel.

Checking
the
Connection
Status
in
the
Device
Manager

To learn more about the connection state of the AJA FS-HDR device, you can open the Device Manager by clicking on “Devices” above the Grading Slots
view.

If connected properly the AJA FS-HDR will show up as a “Device” row in the Device Manager with a green indicator confirming a positive connection
status. By clicking on “Config…”  an info window opens where you can see all information available about the connection of Livegrade with your AJA FS-
HDR device.

Setting
up
ARRI
Cameras
Livegrade comes with support for remote look control of ARRI cameras. This includes the following ARRI Alexa camera types:

ARRI Alexa SXT
ARRI Alexa Mini
ARRI Amira
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ARRI Alexa 65
ARRI Alexa LF
ARRI Alexa Mini LF
ARRI Alexa 35

With this feature set you can send looks (as ASC-CDL and LUT) to be applied on the outputs of the camera by using a network connection (LAN or WiFi
depending on your setup).

Additionally, it’s possible to receive metadata and framegrabs from the current live image of the camera. This way you can include camera and lens
metadata to your shots and include the graded framegrabs to the Look Reports.

Furthermore, you can use the camera’s image source as an image reference in the Image Viewer, allowing the fine tuning of the looks later – even if the
camera is not available.

Note: The in-camera grading integration requires working in the ARRI CAP Compatible grading mode and does not support working within an ACES
pipeline. However, you can use a basic setup with a LUT box or another real-time grading device for working in the ACES CDL or ACES CDL Advanced
grading modes.

Adding
the
ARRI
Camera
as
a
Device

In order to exchange look information with Livegrade, the camera needs to have a working network connection with the Mac where Livegrade is running
on.

In order to connect Livegrade to the camera you have to enable the “Camera
Access
Protocol” in the ARRI camera’s network menu at “System ->
Network”. You can also set a password there to protect access to the camera.

Make sure that you have set the monitor output to “Look File” in the camera’s Color menu, in order to have the look applied to your monitor out.

Once a correct connection is established, launch Livegrade and you can proceed to add the ARRI Camera as a device. In order to do that, you can
choose “Slots” in the main menu and then “Add Device”. Alternatively, you can add the device through the Device Manager.

After that, a wizard window opens:

Add ARRI Camera wizard

Choose your ARRI camera from the list of automatically discovered cameras by clicking on the entry in the “Found Cameras” box
Alternatively you can enter the IP address or the camera’s serial number based host name (e.g. serial number: 6712 -> host name: alexa6712.local)
manually. To do so click the checkbox “Use Custom IP Address” and fill in the information in the text field that appears.
Enter the password for that camera (if you set any in the network settings of the camera)
Enter a client name that should be shown in the camera menu (e.g. your name)
Click on “Add ARRI Camera”

You can enable / disable, if you want to receive framegrabs from this camera by checking the “Enable Framegrab” checkbox.
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Under “Grading” you can choose between different ways to add the camera as a device:

“Interactive” for grading the camera’s signal interactively
“Manual” to upload looks onto the camera manually
“Disabled (Metadata Only)” to add the camera as a metadata only device (also available in other grading modes)

Working
with
the
Camera
in
Livegrade

In the main window of Livegrade, the ARRI camera is now displayed in the corresponding grading slot as a device.

On connect, Livegrade will load the look currently selected in the camera. Furthermore if you change the selected look in the camera, Livegrade will load
the new look automatically.

Once you alter the initial look loaded from the camera the Alexa will show a * next to the look name to indicate that it is changed.

When creating new looks in Livegrade you can choose if they should be stored to the camera as well.

While the current active look settings will be added as metadata to the recorded clips, you have to store the look to the camera in order to change the
look name displayed on the camera and written to the metadata.

Getting
the
Camera’s
Image
in
Livegrade

If framegrabs are enabled the camera image will be shown as an image source of the slot.

You can open the Image Viewer to display the current image by double clicking on the framegrab thumbnail in the Image Sources section.

The Livegrade Image Viewer

In case that you want to display an updated live image, you can perform a framegrab in Livegrade by clicking on the «Refresh Image» button. After that
you will have the latest frame of the live image.

You can generally check if the ARRI camera is properly connected by going to the Device Manager. A green indicator shows a positive connection status.

Please be aware that due to the frame size (especially of the ARRI Alexa 65), taking framegrabs can take longer than maybe expected. Please grant the
camera and application some time to process the framegrab.

Search Code: LG-SA1

 

Further
Reading

For more information, also visit ARRI’s workflow page. In the downloads section, you will, for example, find the “ALEXA 35 – How to set up Pomfort
Livegrade” workflow guideline with step-by-step instructions on how to set up ARRI’s ALEXA 35 camera with Livegrade.

Search Code: LG-SU1

Sony
VENICE
2
Remote
Grading
Livegrade integrates with the remote grading features of Sony VENICE 2 cameras. You can configure the camera as interactive grading device to grade
via ASC-CDL compliant grading nodes in real-time, or as non-interactive grading device to upload looks as User 3D LUT.

1.
Connect
Sony
VENICE
2
to
Livegrade

Sony
VENICE
2: Configure the camera’s authentication and network settings and make sure the Mac machine running Livegrade can access the
camera’s network.
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Livegrade: Set the grading mode of your slot to “CDL + LUT” and add the Sony VENICE 2 camera as a device to your slot in the device manager.
Make sure to specify the correct authentication and network settings and choose the desired grading method “Interactive” or “Manual”:

The “Interactive” grading method adds the camera as interactive grading device and lets you grade in real-time via ASC-CDL compliant
nodes (CDL, SAT) in the grading mode “CDL + LUT”.
The “Manual” grading method adds the camera as non-interactive grading device, so that you can upload the look from your current slot as
User 3D LUT manually.

2.
Setup
Interactive
Grading

Sony
VENICE
2:
In the Home View, click on the “LOOK” button, select “Edit Look” and choose the desired LUT file in the “User 3D LUT” menu.
Then, go to “ASC CDL Process” and select “CDL -> Look”, then go to “ASC CDL Select” and select the “Livegrade.cdl” from the menu.

Note: Make sure to use the same LUT in the Livegrade LUT node as in the camera, e.g., use a Sony LUT preset (Sony Look Profile) or a Show LUT from
your colorist.
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Livegrade: Load the desired LUT into the Livegrade LUT node or choose from a pre-installed LUT preset (“Sony Look Profiles”). You can now start
interactive grading on your Sony VENICE 2 camera from Livegrade via the ASC-CDL compliant nodes “CDL” and “Saturation”.

3.
Look
Upload
From
Shot
Libray

Livegrade: In addition to the interactive grading via CDL, you can also upload saved looks from Livegrade’s shot library as a User 3D LUT onto a
connected Sony VENICE 2 camera by using the menu item “Permanently Store Look On” and choosing the camera’s desired User 3D LUT memory
slot as target. This option is also compatible for looks created with other grading modes.

Sony
VENICE
2: To apply the uploaded look in the Sony VENICE 2 camera, select the appropriate User 3D LUT memory slot in the camera’s “User
3D LUT” menu.

4.
Manual
Look
Upload

Livegrade: If you configure the grading method for the camera as “Manual”, you can also upload the current look from your slot to the Sony
VENICE 2 camera directly by pressing the “Upload” button in the toolbar or by choosing the menu item “Upload Current Look to Non-Interactive
Grading Devices”.

Sony
VENICE
2: To apply the uploaded look in the Sony VENICE 2 camera, select the appropriate User 3D LUT memory slot in the camera’s “User
3D LUT” menu.

Note: The in-camera grading integration does support working within an ACES pipeline. However, you can use a basic setup with a LUT box or another
real-time grading device for working in the ACES CDL or ACES CDL Advanced grading modes.

Tip: Learn more about Livegrade’s Sony VENICE 2 integration by watching the On-Set Workflows with Sony VENICE 2 and Pomfort Livegrade Webinar

Setting
up
Panavision
DXL
2
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Livegrade comes with support for Panavision DXL 2 cameras. The application can send CDL values and 3D LUTs that are applied on the live image
processed in the Panavision DXL 2 camera via a network connection (LAN and WiFi depending on camera hardware and setup).

A list of all the Panavision DXL models supported in Livegrade can be found in the Knowledge Base article All Supported Devices in Livegrade.

For general information about setting up the application with HD-SDI devices please refer to the article HD-SDI Setup for Livegrade.

Adding
the
Panavision
DXL
2
as
a
Device

In order to receive look information from Livegrade, the Panavision DXL 2 needs to have a working network connection with the Mac where the application
is running on.

SETUP
THE
NETWORK
ON
THE
CAMERA

Go to the Panavision DXL 2 Menu
Choose Lan or Wlan depending on your setup

Once a correct connection is established, launch Livegrade and you can proceed to add the Panavision DXL 2 as a device. In order to do that, you can
choose “Slots” in the main menu and then “Add Device”. Alternatively, you can add the device through the Device Manager.

After that, a configuration window opens. By hitting “Refresh” you can search for compatible Panavision DXL 2 cameras connected to your network. All
Panavision DXL 2 cameras found will show up in the table view. Select the intended device and click “Add
Device” to add the box to the selected slot.

Updating
the
Look
in
the
Panavision
DXL
2
Camera

In the main Livegrade window, the Panavision DXL 2 camera is now displayed in the corresponding grading slot as a device.

After selecting the correct grading slot you will be able to adjust the look. The look is not updated in the camera interactively, you need to click “Upload”
in the toolbar, or choose “Upload Current Look to Non-Interactive Devices” in the Slot menu. The look metadata is then sent to the camera.

Updating
Slate
Metadata
in
the
Panavision
DXL
2
Camera

When enabling the “Auto-update slate info in camera” checkbox in the connection dialog of the Panavision DXL 2 camera, every change in the global
metadata area of the application is automatically sent to the camera.

Checking
the
Connection
Status
in
the
Device
Manager

To learn more about the connection state of the Panavision DXL 2, you can open the Device Manager by clicking on the button “Devices” above the
Grading Slots view.

If connected properly the Panavision DXL 2 will show up as a “Device” row in the Device Manager with a green indicator confirming a positive connection
status. By clicking on the button “Config…”  an info window opens where you can see all information available on the connection of Livegrade with your
Panavision DXL 2.

Setting
up
Panasonic
Varicam
Livegrade comes with support for the Panasonic Varicam. Livegrade can send CDL values and 3D LUTs that are applied on the live image and recordings
in the camera using a network connection (LAN and WiFi depending on camera hardware and setup).

The following Varicam models are supported:

Varicam 35
Varicam Pure
Varicam LT
Varicam HS

A list of all the Panasonic Varicam cameras supported can be found in the Knowledge Base article All Supported Devices in Livegrade.

Setting
up
the
camera

In order to receive look information from Livegrade the Varicam needs to have a working network connection with the Mac where Livegrade is running on.
The grading mode on the Varicam 35 has to be enabled.

 

SETUP
NETWORK

Go to Varicam Menu -> Peripheral -> Network Sel.
Choose Lan or Wlan depending on your setup
Go to Varicam Menu -> Peripheral -> Lan Property to see the IP Address if using DHCP or set an IP Address if DHPC is disabled (see Picture)
Note the IP Address. We will need it later in Livegrade
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Varicam 35 network settings

 

ENABLE
GRADING

From the home screen press the Color button (upper middle)
Set the main color to V-Log by pressing the upper left button until Main Color reads V-Log
Turn on grading by pressing the Grading SEL (upper middle) button until it reads On
If CDL grading is Off, enable CDL grading by pressing the CDL button (lower middle) and pressing the upper right CDL button until the title reads On
=> go back to the color view.
Set the 3D Lut setting to V-709 (for other setups see advanced Lut modes below) by pressing the lower left button. In the 3D Lut view press the
upper left button 3D Lut Sel until it reads V-709
Back in the grading view press Mon Set (lower right) to configure on which output you want to see the graded image instead of the log image. For
example to see the graded image on the Mon Out 1, press the Mon Out 1 (upper left) button until it reads Graded
The final settings are shown in the next image:

 

Enabling the grading mode on the Varicam 35

 

ADVANCED
LUT
MODES

There are three 3D LUT modes you can use.

1. Off: no LUT is applied to the V-Log image (not recommended)
2. V-709: the default log to video LUT is applied by the camera (recommended)
3. Loaded File: the LUT can be configured in Livegrade (more flexibility but slower)

 

35

Livegrade Studio 
Setting up Devices



Advanced LUT modes on the Varicam 35

 

 

The LUT mode you want to use depends on your workflow and needs to be specified in the Livegrade device configuration:

 

Varicam 35 settings

 

Setting
Up
Livegrade

Once a correct connection is established, launch Livegrade and you can proceed to add the Varicam as a device. In order to do that, you can choose
“Slots” in the main menu and then “Add Device”. Alternatively, you can add the device through the Device Manager.

After that, a configuration window opens:

Varicam 35 configuration

Enter the IP address of the Varicam as well as user name and password
Optional: choose the LUT mode if you want to use an advanced LUT mode
Click on “Add Varicam”

Livegrade will check the connection and show a green “connected” message if the camera was successfully added.
You can now use the CDL grading mode of Livegrade to control the live image of the Varicam Mon Out 1. While using the default LUT workflow option the
3D LUT section in Livegrade shows the default V-709 LUT applied by the camera. If you want to use a custom LUT or want to add a custom curve you
will have to set the camera to loaded file and change the setting using the device manager.

 

Setting
up
SONY
F65

Livegrade comes with support for remote look control of the SONY F65 cinema camera. This feature enables the user to control
the
ASC-CDL
values
inside the SONY F65 that affect the look of the SDI1 output signal of the camera. Livegrade is connected to the SONY F65 via a network connection (LAN
or WiFi depending on your setup).
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Content

This
article
covers
the
following
topics:

How to set up the network settings in the camera to connect to Livegrade.
How to set the look configuration in the camera to work with Livegrade.
Guide through the process of adding the SONY F65 as a device in Livegrade.
How to export a compatible 3D LUT from Livegrade and load it into the F65.

Setting
Up
the
SONY
F65
Network
Connection

In order to exchange look information with Livegrade, the SONY F65 camera needs to have a working network connection with the Mac where Livegrade
is running on.

The SONY F65 is capable of using DHCP to set its IP address automatically. Go to the “Network” settings of the camera and enable DHCP:

The network settings of the F65.

If not using DHCP, configure the IP and subnet mask manually for the Mac and the SONY F65 to be in the same network.

The shown IP address  in the network settings of the camera (in this case 192.168.2.190) will be used in Livegrade to connect to the F65.

Setting
Up
the
Look
Configuration
of
the
SONY
F65

In order for the interactive control of the ASC-CDL values of the camera to work the color control of the SDI1 output of the F65 has to be set to a certain
state.

The camera settings can be reached either directly on the camera to be output through the SDI or you can access them via a web interface. If the network
settings are set up correctly you can access the web interface by entering the IP address of the camera into a web browser and hitting enter. Please note
that those interfaces may have slightly different appearance.

In
order
to
set
the
look
settings
of
the
camera
for
the
use
with
Livegrade
follow
these
steps:

1. Access the settings of the F65
2. Navigate to the section “VF
/
SDI“
3. Navigate to the page  “SDI1
Look”:

“VF/ SDI” > “SDI1 Look”
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4.     From the “Select” dropdown choose “3D
LUT”:

1. 
“Select” > “3D LUT”

5. Make sure the “Process” is set as “1DLUT
–
CDL
–
3D
LUT”
6. At the entry “3D
LUT“ choose the intended 3D LUT (in this case called “red”). Scroll down to learn how to load a custom 3D LUT to the camera.
7. Make sure the “ASC-CDL” is set to “On”

8. Make sure the dropdown at “CDL” is set to “Edit
Mode”

Please note that due to hardware limitations Livegrade is not capable of controlling the 3D LUT inside the SONY F65 as it is possible with other integrated
devices in Livegrade. Please read on to learn how to load a custom 3D LUT into the SONY F65 (see section “Export a Custom 3D LUT from Livegrade to
Load it to the SONY F65”).

Adding
the
SONY
F65
Camera
as
a
Device

Once a correct connection is established, launch Livegrade and you can proceed to add the Sony F65 camera as a device. In order to do that, you can
choose “Slots” in the main menu and then “Add Device”. Alternatively, you can add the device through the Device Manager.

A window will appear that asks for an IP address of the camera to add it as a device:

Enter the IP address of the camera.

Enter the IP address of the camera as displayed in the camera settings. Hit “Add
F65
Camera”.

Open the Device Manger in Livegrade by clicking the button “Devices…” on the left side of the Livegrade user interface. The Device Manager will show a
connected SONY F65 camera:

The SONY F65 is connected to Livegrade.

Livegrade is now able to control the ASC-CDL values of the camera SDI1 output. Please refer to the article Using the CDL Grade Mode in Livegrade for
more information on grading controls in Livegrade.

Export
a
Custom
3D
LUT
from
Livegrade
to
Load
it
to
the
SONY
F65

Please note that due to hardware limitations Livegrade is NOT capable of controlling the 3D LUT that is set inside the camera. However it is possible to
load a custom 3D look up table to the camera via an SD card.

Livegrade is able to export a 3D LUT that is compatible with the SONY F65 (*.cube). Please refer to the article Exporting Grades to learn how to export 3D
LUTs from Livegrade.

You will find an entry in the list called “SONY
F65
(*.cube)”:

38

Livegrade Studio 
Setting up Devices

https://kb.pomfort.com/livegrade/primary-features/the-device-manager/
https://kb.pomfort.com/?p=435


Exporting a 3D LUT compatible with F65.

Now you can copy
the
3D
LUT
to
the
SD
card to load it to the camera.

First format the SD card inside the camera:

1. Put the SD card in the SD card slot of the F65
2. Go to the “File” menu of the camera settings and select “Media
Format”

“File“ > ”Media Format”

3. In the “Media
Format“ page select “M.S./SD
Format”. This formats the card with the needed SONY folder structure:

1. 
Formatting the SD card

Put the SD card into your Mac. Inside the folder structure on the SD card copy the LUT you exported from Livegrade into the “F65” folder that should be
located inside the PRIVATE/SONY/PRO/CAMERA/ directory.

Insert the SD card into the camera again. You will be able to import the 3D LUT from the “File”
>
“1DLUT/3DLUT
File” Menu:

Import the 3D LUT into the F65.

 

After a successful import the imported 3D LUT will be available from the 3D LUT dropdown of the “SDI1
Look” settings.

39

Livegrade Studio 
Setting up Devices



Setting
up
FSI
CM
and
DM
Monitors
Livegrade comes with support for the Flanders Scientific FSI DM monitor series. With these features you can send looks as 3D LUT to be applied on the
image in the monitor by using a network connection (LAN and WiFi depending your setup).

Additionally, it’s possible to get frame grabs of the graded image shown in the FSI DM series monitor. This way you can include the graded frame grab to
the Look Reports.

Furthermore, you use the FSI DM series monitor’s image source as an image reference on the Image Viewer, allowing the fine tuning of the looks.

For general information about setting up Livegrade with HD-SDI devices please refer to the article HD-SDI Setup for Livegrade.

This article is representatively tailored to the Flanders Scientific DM 250. A list of all the FSI DM monitors supported can be found in the Knowledge Base
article All Supported Devices in Livegrade.

Adding
the
FSI
DM
Monitor
as
a
Device

In order to receive look information from Livegrade the FSI DM monitor needs to have a working network connection with the Mac where Livegrade is
running on. Once the network connection has been established, you can check the IP address of the monitor.

Finding the monitor’s IP address

 

In order to find the monitor’s IP address:

Go to the Main Menu -> System Status -> IP address
Note the IP address. We will need it later in Livegrade

 

Setting
up
Livegrade

Once a correct connection is established, launch Livegrade and you can proceed to add the FSI DM monitor as a device. In order to do that, you can
choose “Slots” in the main menu and then “Add Device”. Alternatively, you can add the device through the Device Manager.

After that, a wizard window opens:

Entering the IP address

Enter the IP address of the FSI DM250 monitor
Click on “Add FSI Monitor”
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Getting
the
Monitor’s
Image
in
Livegrade

In the main Livegrade window, the FSI DM250 is now displayed in the corresponding grading slot as a device, as well as the Monitor Image as an Image
Source of the slot. You can open the Image Viewer to display the image by double clicking on the «Monitor Image» thumbnail in the slot.

 

the FSI DM monitor’s feed shown in the Image Viewer

In case that the live image has changed, you can update the image shown in Livegrade by clicking on the «Refresh Image» button. After that you will have
the latest frame of the live image.

You can generally check if the FSI DM monitor is properly connected by going to the Device Manager. A green indicator shows a positive connection
status. You can use the «Blink» button to send a red-green-blue screen flash sequence to check if the FSI DM monirot is ready for the use with Livegrade.

How
to
store
a
Framegrab

You can take frame grabs from the video signal by clicking on the “Framegrab” button. This takes a frame from the video stream and saves it on the Clip
Library with the associated grade for further reference.

Record and grab frames

More about this setup in use can be seen in FSI’s video FSI DM250 OLED and Pomfort Live Grade Pro Integration [via Flanders Scientific, Inc.].

 

ScopeStream

The FSI device provides a technology called “ScopeStream” that calculates scopes for the signal on the hardware device and provides it for display on
your Mac.

When adding a FSI device (DM monitor series or BoxIO) you can choose to enable the ScopeStream with the according checkbox:

Enable ScopeStream when adding a FSI device.

Livegrade automatically opens the ScopeStream window:
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The ScopeStream window showing a waveform

After closing the ScopeStream window it can be reopened again by clicking the gear button next to the device in the slot view:

Reopening the ScopeStream window.

Please
be
aware that the scopes are drawn from the unprocessed signal. Looks that are applied to the FSI device are not taken into account for the
ScopeStream scopes.

Setting
up
Canon
Monitors
Livegrade comes with support for Canon broadcast monitors. You’re able to send looks as 3D LUT to be applied on the monitor image by using a
network connection (LAN or WiFi depending on your setup). Additionally Livegrade is capable of taking a framegrab from the monitor that can be saved to
the Clip Library as a reference along with the look. In Dual Mode the monitors are capable of grading only one input.

For general information about setting up Livegrade with HD-SDI devices please refer to the article HD-SDI Setup for Livegrade.

A list of all the Canon Monitors supported can be found in the Knowledge Base article All Supported Devices in Livegrade.

Adding
the
Canon
Monitor
as
a
Device

Based on the example of the Canon DP-V2410 it will be demonstrated how to add a compatible Canon monitor as a device. In order to receive look
information from Livegrade, the Canon monitor needs to have a working network connection with the Mac where Livegrade is running on. Once a correct
connection is established, launch Livegrade and you can proceed to add the Canon monitor as a device. In order to do that, you can choose “Slots” in
the main menu and then “Add Device”. Alternatively, you can add the device through the Device Manager.

After that, a configuration window opens:
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Add Canon Monitor

By hitting “Refresh” you can search for compatible monitors connected to your network. All monitors found will show up in the table view. Select the
intended device and click “Add
Monitor” to add the monitor to the selected slot.

Working
with
the
Canon
monitor
in
Livegrade

In the main Livegrade window, the Canon monitor is now displayed in the corresponding grading slot as a device.

After selecting the correct grading slot you will be able to adjust the look that is sent to the monitor by modifying it in the Main Window of Livegrade.

As the monitor permanently stores the last look that was sent, there is no need for the “Permanently Store Look on Device” functionality of Livegrade.

The Canon DP-V2410 and DP-V3010 monitors support a LUT size of 17 x 17 x 17.

Checking
the
Connection
Status
in
the
Device
Manager

To learn more about the connection state of the Canon monitor you can open the Device Manager by clicking on the button “Devices” above the Grading
Slots view.

If connected properly the Canon monitor will show up as a “Device” row in the Device Manager with a green indicator confirming a positive connection
status :

The Device Manager shows a properly connected Canon DP-V2410.

By clicking on the button “Config…”  an info window opens where you can see all information available on the connection of Livegrade with your monitor:

Canon monitor configuration window

By hitting “Disconnect” you can temporarily disconnect and reconnect the selected monitor.
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Adding
a
Canon
Monitor
by
Using
a
Custom
IP
Address

If you want to add devices by a certain IP address rather than letting Livegrade search for them in your network you can select the checkbox “Use
Custom IP Address” to reveal a text field where you can enter the IP address of the chosen device:

Use a custom IP address to add a monitor

You can find out about the IP address of the monitor in the menu of the Canon monitor:

Finding the monitor’s IP address

In order to find the monitor’s IP address:

Go to the Main Menu of the DP-V2410 by hitting the physical button “Menu” on the monitor
Switch to the System Information tab by using the control knob of the monitor
Note the IP address and insert it into the “Use Custom IP Address” text field in Livegrade

Grading
on
a
Specific
Input
in
Dual
Input
Mode

When adding a Canon monitor to Livegrade you can select a certain input when the monitor is running in “Dual Mode”. Choose the according radio
button to add the left or the right input as the desired target.
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An additional panel when adding the monitor as a device lets you control the input selection in Dual Mode, the enablement of a framegrab and the framegrab input source.

Enabling
the
Framegrab
functionality

The supported Canon monitors are capable of taking a framegrab from the screen. To enable the framegrab funcitonality, please make sure to have the
“Enable
Framegrab” checkbox set when adding the Canon monitor as a device. The Framegrab Input dropdown lets you select the input the framegrab
is taken from.

In the main Livegrade window, the Canon monitor is now displayed in the corresponding grading slot as a device, as well as the Canon monitor image as
an Image Source of the slot.

You can open the Image Viewer to display the image by double clicking on the «Canon
Monitor
Image» thumbnail shown in the correspoinding slot.

The Canon Monitor Image in the Image Viewer

In case that the live image has changed, you can update the image shown in Livegrade by clicking on the «Refresh
Image» button. After that you will
have the latest frame of the live image.

Select the monitor image and click the
“Framegrab” button on the top right of the Livegrade task bar. This will send a look to the library that includes a
reference still.

Setting
up
QTake
Interaction
Livegrade Studio can provide look metadata to QTake systems. Therefore the application treats the QTake system similar to a LUT device and sends
updated look metadata to the QTake system whenever the user applies or manipulates a look in Livegrade.

QTake supports one ASC-CDL and one 3D LUT (in that order or operation). So Livegrade will send ASC-CDL as well as LUT information to QTake (e.g.
when being used in the CDL and LUT grading mode). Multiple CDL nodes from Livegrade will be merged and provided as one single CDL. Non-CDL
nodes will be merged and provided as one 3D LUT. In QTake the look metadata shows up in a “LOOK” effect. For information about setup and use in
QTake, please see the QTake manual.

For general information about setting up Livegrade with HD-SDI devices please refer to the article HD-SDI Setup for Livegrade.
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Adding
QTake
as
a
Device

In order to receive look information from Livegrade Studio, the computers running Livegrade and QTake need to have a working network connection.

Once network is set up, launch Livegrade and you can proceed to add the QTake system as a device in device manager. In order to do that, you can
choose “Slots” in the main menu and then “Add Device”. Alternatively, you can add the device through the Device Manager.

After that, a configuration window opens. By hitting “Refresh” you can search for QTake systems connected to your network. All QTake systems found
will show up in the table view. Select the intended device and click “Add Device” to add the box to the selected slot.

You can also specify a custom IP address.

Setup
in
QTake

Here are a few starting points for the setup in the QTake system:

Make sure “QTAKE LUT server” is enabled in the QTake preferences.

Once a connection is made:

Load a “Look VFX” filter with the right channel.
Assign the “QTAKE LUT server” to the grading controls.

Please refer to the QTake documentation for further details.

Working
with
the
QTake
connection

In the main window, the connected QTake system is now displayed in the corresponding grading slot as a device icon.

After selecting the correct grading slot you will be able to adjust the look that is sent to the QTake system.

Checking
Connection
Status
in
the
Device
Manager

To learn more about the connection state of the QTake system, you can open the Device Manager by clicking on “Devices” above the Grading Slots view.

If connected properly the QTake system will show up as a “Device” row in the Device Manager with a green indicator confirming a positive connection
status.
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Color Grading Features
Color
Controls
and
Grading
Modes
Color correcting live signals and reference media is done in the grade controls area of the main window.

Grade controls are grouped in grading nodes, a grading node can be understood as one image filter with one or more parameters. A certain set of
grading nodes belong to a grading mode. A grading mode is a color pipeline for a certain purpose or tailored to a certain hardware device (e.g. “CDL and
LUT”, or “ACES CDL”).

Grade
controls

 

Grading modes and grade controls

The grade controls consist of the following elements:

Grading
node: Grouping element containing the actual grade controls
Node
enabling: Enable or disable the effect of a grading node
Look
name: The name of the currently applied look
Grading
mode
selector: Switch between the different grading modes available on the drop down menu
Edit
node
structure: Some grading nodes can have variable grading nodes, you can add and reorder grading nodes in the edit mode.
Look
actions: The look action menu contains actions for interacting with looks stored in the shot library.
Control
panels: The control panels button and indicator shows the attached grading panel. You can disable / lock the attached grading panel to
prevent unwanted changes.
Clear
buttons: Clear either all grading nodes (“Neutral”) or just the creative color manipulation nodes (e.g. CDL node) and not LUTs or tone
mapping curves (Reset Colors)
Filter
configuration: Temporarily bypass creative color manipulation nodes, or show the original signal with no filtering at all, or enable the false
color mode.
Result
curve: The video scopes shows the resulting curves for all enabled grading nodes in the three RGB channels.

Copy
And
Paste
Looks
Between
Slots

You can copy a look from a slot to another slot. Choose from “Grade” in the main menu:

“Copy Look from Current Slot” to copy a look
“Paste Look to Current Slot” to paste a look
“Paste Look to All Slots” to paste a look to all slots

Pasting a look to a slot replaces any existing grades.

Note: Looks can only be pasted, if the grading mode of the two slots is the same. When the grading mode is different the user will be asked, if the grading
mode should be changed before the copied look is being applied.

Grading
Modes

The application supports different grading modes designed for specific camera setups and workflow environments.

The node-based design allows you to disable and reorder individual filter nodes to have greater grading freedom. You can disable a certain node by
unchecking the blue check box. Have in mind that the processing order is from «top to bottom» when reordering the nodes.

Each mode allows different levels of grade customization, as the compatibility of the grades down the workflow creates some restrictions on how the
color information has to be processed. For example, the camera compatible grading modes can have the nodes locked in a certain position to ensure the
compatibility of the grade when being uploaded into the camera.

The available grading modes are:

CDL
and
LUT:
More information in the article Using the CDL Grade mode.
CDL
Advanced:
Allows you to add and reorder multiple nodes on advanced workflows.
ACES
CDL:
A mode adapted to the ACES standard. More information in the article Using the ACES grading mode.
ACES
CDL
Advanced:
A mode adapted to the ACES standard. Allows you to add and reorder multiple nodes on advanced workflows.
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Alexa
Looks
(Deprecated):
This mode is designed to create .xml ALEXA Looks compatible with ARRI ALEXA cameras. More information in the
article Using the ALEXA Looks grading mode.
Amira
Compatible:
This mode is designed to create .aml AMIRA Looks compatible with ARRI AMIRA cameras.
ARRI
CAP
Compatible:
This mode is designed to interact with an ARRI camera via the CAP protocol. See Setting up ARRI Cameras for more
information.
Varicam
Compatible:
This mode is designed to create 3D LUTs and looks compatible with Panasonic Varicam cameras. See Setting up Panasonic
Varicam for more information.
Freestyle:
This grading mode has been created to allow complete grading freedom. For this reason, there are some limitations on the available
export formats for looks created on this mode.
Freestyle
ACES: This grading mode has been created to allow complete grading freedom for ACES based workflows.

FilmLight
BLG: This grading mode allows to grade natively in FilmLight’s proprietary color pipeline and allows creating looks in the BLG format
for round-tripping with FilmLight applications. See Using the FilmLight BLG Grading Mode for more information.

Colorfront
Film: This mode is designed to interact with an AJA FS-HDR device in the Colorfront Film mode. See Using the Colorfront Film
Grading Mode for more information.

Node
Editing

Some grading modes allow you to reorder, add and delete filter nodes. To start customizing the grading nodes, you have to click on «Edit».

Once you are in the «Edit» mode, it is possible to reorder the nodes using drag and drop. You can remove a node by clicking on the «x» button. The «+»
button allows you to add new filter nodes to the grading mode.

In order to maximize the compatibility of the grades along the production workflow, as well as the ability to export the grades in a certain format, there are
some limitations on how you can reorder the grading nodes. The Freestyle modes do not have these limitations, but you can only export those looks as
3D LUTs and not as CDL files. These are the limitations:

Nodes Reordering Default
Nodes Export
Options

CDL and LUT (not editable) 1CDL, 1Sat, 1LUT3D (not editable), CDL + Sat + LUT3D CDL + Sat + LUT3D ASC-CDL, 3D LUT
CDL
Advanced xCDL, xSat, xLUT1D, xLUT3D, x2ndary (not editable), CDL + Sat + LUT3D CDL + CDL + Sat + LUT3D

ASC-CDL, 3D LUT

ACES
CDL (not editable) 1IDT, 1CDL, 1Sat, 1ODT (no edit) IDT + CDL + Sat + ODT ASC-CDL, 3D LUT, AMF
ACES
CDL
Advanced 1IDT, xCDL, xSat, xLUT1D, xLUT3D,

x2ndary, 1ODT
xCDL + xSat (All CDL nodes together, all saturation
nodes together), IDT before ODT,

ASC-CDL, 3D LUT

Alexa
Look
(deprecated) Alexa Look has fixed nodes Alexa Look has fixed nodes 3D LUT, Alexa Look
(deprecated)

Amira
Compatible xCDL, xSat, xLUT1D, xLUT3D, x2ndary,
xLUT3D

xCDL + xSat (All CDL nodes together, all saturation
nodes together), nothing before xCDL+xSat

ASC-CDL, 3D LUT, ALF-
2

ARRI
CAP
Compatible xCDL, xSat, xLUT1D, xLUT3D, x2ndary,
xLUT3D

xCDL + xSat (All CDL nodes together, all saturation
nodes together), nothing before xCDL+xSat

ASC-CDL, 3D LUT, ALF-
2

Varicam
Compatible xCDL, xSat, xLUT1D, xLUT3D, x2ndary,
xLUT3D

xCDL + xSat (All CDL nodes together, all saturation
nodes together), nothing before xCDL+xSat

CDL, Sat, LUT3D

ASC-CDL, 3D LUT

FilmLight
BLG 1In, xCDL, xSat, 1Grade, 1Out xCDL + xSat, before and/or after Grade Stack  BLG, 3D LUT
Colorfront
Film 1CFEIn, xCDL, xSat, 1CFELook,

1CFEOut
CFE

Freestyle xCDL, xSat, xLUT1D, xLUT3D, x2ndary
3D LUT

ACES
Freestyle 1IDT/1ODT, xCDL, xSat, xLUT1D,
xLUT3D, x2ndary

IDT before ODT
3D LUT

 

 

* xCDL, xSat, where «x» means multiple nodes.

For more details regarding export options see also Exporting Look Metadata.

Available
Grading
Nodes

CDL
Node

The CDL node holds controls for the slope, offset, and power (SOP) values of the ASC-CDL formula.

The CDL node has several interaction types with different controls for different interaction styles. The interaction types of one CDL node all work on the
same set of CDL values, so changing controls in one interaction type might change control positions also in the other interaction types.

The available interaction types:

48

Livegrade Studio 
Color Grading Features

https://kb.pomfort.com/?p=5449
https://kb.pomfort.com/livegrade/built-in-integrations/using-the-filmlight-blg-grading-mode/
https://kb.pomfort.com/livegrade/browsing-exporting/exporting-grades/


CDL
interaction
type:

CDL node – CDL interaction type

The CDL interaction type allows to manipulate the nine values of the SOP triples (for each color channel R, G, B) of the CDL. The values in the nine text
fields are the same values as in an exported ASC-CDL file.

The color wheels have a global control (in the bottom left of each wheel), an indicator around the ring shows if the global control is modified. Changing the
wheel control doesn’t change the gloabl luma of that control, e.g. the channels are balanced and the global control doesn’t change by changing the wheel
position.

Lift,
Gamma,
Gain
(LGG)
interaction
type:

CDL node – LGG interaction type

The LGG interaction type allows to manipulate lift, gamma, and gain (LGG) values as known from other grading systems. These control values are
mapped to CDL values in the background. The nine text fields show lift, gamma, and gain values (not ASC-CDL values) – switch back to the CDL
interaction type to see the CDL values of a certain setting of LGG values.

Note: Although ASC-CDL doesn’t specify limits of its values, some 3rd party software products limit values in their ASC-CDL grade controls. An indicator
(“i”) on the very right of the grade UI Livegrade indicates that values are out of the range that is commonly accepted.

The color wheels have a global control (in the bottom left of each wheel), an indicator around the ring shows if the global control is modified. Changing the
wheel control doesn’t change the global luma of that control, e.g. the channels are balanced and the global control doesn’t change by changing the wheel
position.

Simplified
(SPL)
interaction
type:

CDL node – SPL interaction type

The SPL interaction type allows to manipulate the values of the CDL filter with the controls Contrast, Stretch, Warmer and Greener.

Increasing the contrast control makes the resulting curve steeper by clipping black and white. Increasing the stretch control increases contrast in the
highlights, while decreasing stretch increases contrast in the shadows. Increasing the warmer control gives the image a warmer appearance by giving the
shadows a warmer tint while the whites stay unmodified. Increasing the greener control gives the image a greener appearance by giving the shadows a
greener tint while the whites stay unmodified.

Printer
Lights
(PRT)
interaction
type:

CDL node – PRT interaction type

The PRT interaction type allows to simulate a color correction based on printer lights. Printer lights can be approximated by an offset in camera log
encodings. Additional buttons for each color channel allow for changes in fixed steps.

ASC-CDL files can be directly loaded and saved to/from the CDL node (supported format: *.cdl).  Click the gear button on the left side of the CDL node
and select if you want to load or save a CDL.

Please be aware that the ASC-CDL specification always includes a saturation value. When one saturation node is present CDLs will be loaded and saved
from/to the present saturation node. When multiple CDL and saturation nodes are present you will be pointed choose the saturation node you want to
load the saturation to (indicators A,B,C etc.).

The size of the color wheels can be adjusted in the Preferences menu. Just choose a size that fits your display resolution.

The CDL node can be controlled by an external hardware grading panel. To have more information on how to use it, please check the following articles:

Tangent Element setup
Tangent Wave setup
Avid Artist Color setup
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Saturation
Node

Just drag the slider to either side to increase or decrease the saturation on your look.

figure 7: Saturation node

3D
LUT
Node

The 3D LUT node is designed to load your own 3D LUTs by pressing the «Load…» button. Alternatively, you can also use one of the available preset 3D
LUTs to convert the image to a Rec.709 color space.

figure 8: 3D LUT node

Supported formats for loading into the 3D LUT node are:

Adobe Speedgrade (.cube; size 32,33, 65)

Assimilate Scratch (.3dl; size 32)

Panasonic Varicam (.vlt)

Autodesk Lustre ( .lut) 

Truelight (.cub)

1D
LUT
Node

The 1D LUT lets you load your own 1D LUT file. Click the “Load…” button and select the 1D LUT you want to load to the node.

figure 9: 1D LUT Node

In contrast to the curve node the LUT in the 1D LUT node can not be edited afterwards.

Supported formats are:

*.txt
channels: 3
range: 0.0 … 1023.0 (float)
header: “R G B – HDLINK GAMMA TABLE”
entries: 1024
row example: “221.37 221.37 221.37”

*.data
channels: 4
range: 0 … 16383 (integer)
entries: 16384
row example: 15040,15040,15040,15040

*.lut
channels: 3 (4 columns with leading index (0…65535, R, G, B)
range: 0 … 65535 (integer)
header: “LUT16”
entries: 65536
row example: 45490 58366 58366 58366

RGB
Curves
Node

 

figure 10: RGB Curves node

The RGB Curves node lets you apply precise curve adjustments to master RGB values or to individual luma, red, green, blue and/or custom color
channels. Click on “Edit” to open the RGB Curves Editor window, which allows you to precisely grade your footage:

There are two modes to choose from:
“RGB-Based” adjusts the selected color channel including its luma and saturation values, while the “Master” curve is a ganged RGB
curve influencing the red, green and blue channel at the same time
“Luma-Based” adjusts the colors red, green, blue and/or the custom set color without influencing their luma and saturation values,
while the “Luma” curve can be adjusted independently

In the “Custom” color curve you can pick a custom target hue, for adjusting a certain color in your image precisely
To add a curve point just click on a curve, and in order to modify it’s value just drag and drop. You can adjust curve points using the left/right and
up/down arrow keys as well.
To remove a point, select the point and press Backspace.
When you move your mouse over the curve editor, the graph shows you the value of the exact point where it is. When the mouse pointer is not
moving or it is outside of the curve editor window the values of the currently selected curve point are being displayed.
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There is a color picker tool, that lets you pick a specific target color value in the viewer window. Picking a color automatically creates a curve point
in the graph of the current tab. The color picker tool can also be used to pick the target hue of the “Custom” color curve.

figure 11: RGB Curve Editor

Hue-Sat-Lum
Curves
node

The Hue-Sat-Lum (HSL) Curves node lets you apply precise secondary curve adjustments based on hue vs. hue, hue vs. saturation, hue vs. luma, luma
vs. saturation and saturation vs. saturation values. The associated tabs in the HSL Curves node allow you to precisely grade your footage:

The graphs on the x-axis in the individual mode windows (Hue vs. Hue, Hue vs. Sat, Hue vs. Lum, Lum vs. Sat, Sat vs. Sat) represent the target
values of the associated mode. Added curve points can be dragged to change the values accordingly along x and y-axis.
To add a curve point just click on a curve, and in order to modify its value just drag and drop. You can adjust curve points using the left/right and
up/down arrow keys as well.
To remove a point, select the point and press Backspace.
When you move your mouse over the curve window, the graph shows you the value of the exact point where it is. When the mouse pointer is not
moving or it is outside of the curve editor window the values of the currently selected curve point are being displayed.
There is a color picker tool, that lets you pick a specific target color range in the viewer window. Picking a color automatically creates curve points
in the graph of the current tab.

figure 12: HSL Curves nodes

HHS
Node

The HHS node –Hue to Hue and Saturation– is a new kind of node that allows you to map a certain hue on the image and replace it by another color with
different hue and saturation. Here is an example where the red has been desaturated, but the other colors remain the same:

The HHS editor allows you to drag and drop the hue circles to another location on the color space to replace the original color with another one.
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figure 13: HHS editor

Knee
Curve
Node

The Knee Curve node lets you create simple technical curve adjustments with three parameters for “Black (toe)” and “White (knee)”:

Limit: Increases/decreases the limit for white or black on the curve’s y-axis
Offset:
Increases/decreases the offset between limit and knee or toe curve point
Threshold: Increases/decreases the x + y coordinates of the knee or toe curve point

figure 14: Knee Curve Node

You can save your curve correction as a 1D LUT (.cube) file (or the inverse 1D LUT) for loading the adjustment in other color grading systems.

Amount
Slider

CDL nodes, RGB curve nodes, HSL curve nodes and HHS nodes have an amount slider which allows to fine-tune the effect of the associated grading
node. There is an intensity level indicator on the right hand side of the node. When clicking on it, you can adjust the intensity in a popover window, either
with a slider or by typing in a value from 0-100%.

Note: The initially set values in CDL nodes remain the same when changing the intensity. When you create a shot, the values of the grade are re-
calculated with the applied intensity amount and saved as new resulting values in the shot table.

figure 15: CDL node with amount slider

Grading
modes
with
custom
color
pipelines

The ACES grading modes have special grading nodes representing the specific transforms of the ACES pipeline, e.g. IDT and ODTs. You can learn more
about these grading modes in the article Using the ACES CDL Grading Mode.

The Colorfront Film grading mode that’s used with AJA FS-HDR (Studio only) has specific transforms, e.g. CFE In and CFE Look.  You can learn more
about these grading modes in the article Using the Colorfront Film Grading Mode.

Linked
Looks

You may have noticed that on the right side of each node in the grading panel a chain symbol appeared. It indicates the synchronization state of the node:

Blue
chain
button: Node is synced between linked slot (indicated
with
a
red
frame)
Grey
chain
button: Node is unsynced between linked slots and therefore controlled independently
(indicated
with
a
grey
frame)


It’s possible to switch the linked state of a node by clicking on the chain buttons. For more detailed information about the node synchronization, please
check the article Linked Looks.

Output
Colorspaces
Livegrade lets you manage looks with an output colorspace attribute for streamlined handling of looks and video signals within multi-monitoring setups
and advanced color pipelines.
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Assigning
an
Output
Colorspace

You can assign the desired output colorspace in the output colorspace node at the bottom of the grade editor. Livegrade automatically detects the
correct output colorspace of built-in LUT presets, ACES ODTs, FilmLight Viewing Colorspaces or Colorfront CFE Out transforms.

Output colorspace node in grade editor

For custom LUTs you can assign the correct output colorspace on loading. Once the output colorspace for a custom LUT is defined Livegrade handles
the output colorspace for your custom LUT automatically.

Choosing output colorspace when loading custom LUT

On look export Livegrade adds the output colorspace attribute as a LUT comment to all 3D LUT formats so that other Livegrade systems auto-detect the
appropriate output colorspace of your custom LUT on import.

Handling
shots
using
the
Output
Colorspace
attribute

A look’s output colorspace is stored as shot attribute in the shot library so that you can

view and sort the output colorspace column in the shots table,
inspect a shot’s output colorspace in the info tab,
or include it in reports.

Furthermore, you can filter your shot library using the output colorspace smart group (e.g., when applying looks for HDR/SDR dual monitoring setups).
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Output Colorspace Smart Groups

For further communicating the output colorspace attribute, you can use the output colorspace token within the wildcards for the Clip Identifier, in the file
naming scheme for  saving shots and for the still image export.

Output colorspace token used in clip identifier wildcards

Tag
Still
Images
with
a
Color
Profile
depending
on
Output
Colorspace

You can enable the color profile tagging for still images within the “Advanced” preferences. Livegrade then tags still images with an appropriate color
profile for most common output colorspaces (Rec.709/Rec.2020/Rec.2100 PQ/Rec.2100 HLG/sRGB) on export. The image tagging applies to still images
exported from the viewer window as well as when saving shots from the shot library.
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Enable color profile tagging for most common output colorspaces in advanced preferences

Auto-configure
Video
Scopes
depending
on
Output
Colorspace

The correct color primaries value for video scopes can be detected automatically depending on the current look’s output colorspace so that the video
scopes are always configured appropriately for the currently selected slot (e.g., when working with HDR/SDR dual monitoring setups).

Auto-configure video scopes depending current output colorspace

Collect
Shot
and
Look
Information
The shot library can stores shot entries in order to maintain a complete shooting history.

Each shot can include a broad range of metadata fields, e.g.

clip name,
camera identification,
look metadata,
slate information,
exposure information,
lens information,
comments, and
ratings, flags.
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Note: You can customize the behavior for editing the slate info fields in the “Slating” preferences, see the article Application Preferences for further
information.

Shot entries can also have media assets attached. So a shot can be stored as:

Still: Still images stored as captured (may be “log”), with look metadata
Clip: Movie recordings as captured (may be “log”), with look metadata

The icon in the “Type” column will help you differentiate them:

  Shoot with look (no media asset available)

  Still (captured or imported frame in full resolution available)

  Clip (captured clip in full resolution available)

 Pre-graded still (look has already been applied to still before capturing (e.g. by a LUT box)

 Pre-graded clip (look has already been applied to still before capturing (e.g. by a LUT box)

Additionally every Type can have a chain icon overlay that symbolizes a linked look (e.g. a still with a linked look):

 Linked Look Still

Read more about linked looks in the article Linked Looks.

Adding
items
to
the
shot
library

There are different ways to add an item to the shot library. The create buttons behave differently depending on the current mode:

Create: Create a new shot with metadata and capture a frame grab
Record
All: Start recording a new clip

See the article HD-SDI Signal Recording and Frame Grabs for more information about capturing stills and clips.

Additionally, you can import images from .JPEG, .TIFF and .DPX files. Still frames can also be imported from .MOV files. This way you can use them to
create looks on your computer display or as a reference to compare against the live video signal.

To import an image into the Library, select “Import Image / Movie File…” or drag a file onto the application’s dock icon.

It is possible to enable/disable the forcing of the color profile to Rec.709 of the loaded images. This setting tells the application not to use the embedded
color profile of the imported media asset and use Rec.709 instead. You can modify this setting in Preferences>Advanced.

Adding
metadata
to
a
new
shot

When creating a new shot (with the “Create Shot” menu entry in the Library menu, or with one of the “+” buttons in the slot UI), the global metadata (e.g.
for slate information), and metadata from each slot (e.g. technical metadata) is used for the new shot.

In case the metadata table in the slot UI is currently not shown, a quick entry panel is shown in order to review metadata bore storing it in the shot library.

You can

always show the quick entry panel by choosing “Create Shot With Entering Information…”, or
never show the quick entry panel by choosing “Create Shot Without Entering Information”

in the “Library” menu.

 

Metadata quick entry panel

Review
a
recording
in
the
library
slot
and
create
new
shots
with
stills

You can review a movie recording by loading it into the library slot. You can playback or scrub through the clip to find significant frames that are valuable
to keep as reference. With the libary menu item “Create Shot With Still at Playhead Position” or an associated controller action you can create a new
standalone shot with a still taken at the playhead’s position. The new shot will inherit the metadata from the original movie recording.

Note: Similarly, you can duplicate a shot with a recording as a new shot with a still image taken at the thumbnail frame’s position directly in the shot
library.
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Working
with
Look
Presets
Presets are files that contain specific look settings that you can apply to an image. You create, store, and modify your custom looks. Looks can be only
stored directly in Bins, and Bins can be grouped in Folders.

The
Look
Presets
library

All actions with Look Presets are grouped in the Look Presets panel in the upper right of the Livegrade UI.

Figure 1: Look Presets

The Look Preset panel’s toolbar contains controls to switch between  Information
Tab,
Look
Presets
Tab
,
 and History
Tab . The “plus” icon creates a
new Bin and the “folder” icon creates a new Folder. A “Presets” bin is already created for each project.

When you right click a bin or folder you have the options to add new folders, bins, and delete items in the Look Preset library and set the Default Bin. You
can also access same actions from the drop down menu on the main menu toolbar.
“⌥B” the default shortcut assigned to create a “New
Look
Preset
Bin”.

The
Default
Bin

When you collect a set of bins in different sub folders/folders in order to categorise them you have to choose which bin should be act as the “Default
Bin”. This helps you to target where to add a new look in a selected folder. If you skipped this decision, the moment you add a new look in Looks
panel, a
“Default
Bin” will be created automatically within selected folder on the Look
Presets panel . A “Default
Bin”
is distinguished from other bins by his
name converted in italic.

The
Look
Presets

Below the Look
Presets library, the Look
panel  is ready to collect your new looks with thumbnails and quick informations like name of the created look
and Look configuration source, your colour management starting point. A Look Preset has a thumbnail, a name, and the grading mode it has been created
in.

Inspecting
Presets
in
the
Look
Library

Collection
view.
In the Look Library’s collection view look and node presets are indicated by a little icon top-left corner. You can click on the little
“i” in the bottom left of a preset to display information about the presets.
List
view.
To see all your presets listed including metadata, switch to the list view.
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Presets Collection View

 

Presets List View

How
to
create
a
new
Look
Preset

There are several ways of creating Look Preset.

Choose a Slot. When you are done with adjusting the current look of the slot, give a name to your look and click the “+”
button above the Look
Presets collection. When the new Look Preset has been created you can edit its name.
You can also use Livegrade main menu toolbar, choose Create
Look
Preset from the Look
Presets menu. (Default Shortcut G).
You can also create a Look Preset from a shot in the Shot table. Drag and drop directly on the Look
Presets
 panel.

Both of these actions will create a thumbnail which contain the same image and look with the Slot panel or Shots panel.

Navigate
Main
Menu
toolbar
>
Import
Look
As
Look
Preset
>
select
the
look
>
select

Grading
Mode.
Choose your Look in .cdl or .xml from
your desired look archive.
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Figure 2: Import Look As Look Preset

Then the new imported look file goes to the currently selected bin or to the assigned Default
Bin. If there is no Default
Bin in the folder, it’s automatically
created.

Figure 3: Import Look As Look Presets

Every look that you store on the Looks panel is also stored in a bin selected by user on the Look
Presets panel. Numbers indicates how many looks are
in that bin or folder.  You can reorder any time your Look
Presets panel simply by drag and drop bins or folder within each other. Thumbnails also can
be dragged to the desired bin.

HOW
TO
UPDATE
A
PRESET
AND
REPLACE
A
THUMBNAIL
LOOK



There are several ways to update a preset and replace a thumbnail look.



Select the thumbnail that you want to update on the Looks
panel toolbar. Click on the middle icon.

Figure 4: Update selected look preset

Or  Select from the main Menu toolbar Look
Presets
>
Update
selected
Look
Preset

Figure 5: Menu toolbar-Look Presets-Update selected Look Preset

 

You can select the thumbnail that you want to update on the Looks panel. Right click on the thumbnail. Select Update
Preset from the drop down
menu.

Figure 6: Looks panel-Update Preset

These actions replace only the old look with the new one from the selected slot . The  original Thumbnail (image)  remains the same.

  On the Looks panel you can also right click on the thumbnail. Select Update
Preset
and
Replace
Thumbnail from the drop down menu.
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This action replace either the look and the thumbnail with the same image and look based on the selected Slot.

HOW
TO
APPLY
SELECTED
LOOK
PRESET

You have multiple choices to apply selected look preset. Select the Slot  that you want to update look.

  Click on the first icon.

Figure 7: Looks-Apply selected look preset

Navigate main menu toolbar Look
Preset
>
Apply
selected
Look
Preset
.
( shortcut H
)

Figure 8: Apply selected Look Preset drop down menu

If
Library
Slot
is
selected
Apply
selected
Look
Preset
is
disabled.

HOW
TO
APPLY
SELECTED
LOOK
PRESET
TO
MULTIPLE
SHOTS
IN
YOUR
LIBRARY

You can apply a Look Preset to update Shots in your library.

Select the shots in your Library you would like to update
Right-Click on the Look preset that you would like to be applied
Choose
Apply
Preset
to
Selected
Shots

Apply Look Preset to Selected Shots

HOW
TO
DELETE
A
SELECTED
LOOK
PRESET

1. Select the thumbnail that you want to clear from the bin or folder on the
Looks panel
2. Main menu toolbar Look
Presets
>
Delete
selected
Look
Preset
Folder
>
confirm

Deleted look is also removed from the associated bin on the Look
Presets panel.

This
action
cannot
be
undone!

You can also duplicate a selected thumbnail. They will have the same name as the original file with and additional number 1,2,3… and so on.

It could be easier to navigate between thumbnails via shortcuts ⌥1,⌥2,⌥3,…⌥9.

HOW
TO
STORE
SELECTED
LOOK
PRESET
ON
DEVICE

Main
Menu
toolbar
>
Look
Preset
>
Permanently
store
Selected
look
Preset
on
Device
>
choose proper device from the drop down menu
Or just Right
Click
on the thumbnail
>
Store
permanently
on
Device
> choose proper device from the drop down menu.

HOW
TO
SAVE
SELECTED
LOOK
PRESET

1.  Choose  your look or looks  to export on the Looks panel.
2. Main
Menu
toolbar
>
File
>
save
selected
Preset
Look
As
>
choose one from the drop down menu.

Figure 9: save selected Preset Look As
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Using
Video
Scopes
Livegrade comes with a set of typical video scope tools:

Waveform,
histogram, and
vector scopes.

You can switch between different selections of tools in the List above the scopes area.

Video scopes with view “All Scopes” enabled

Show
and
hide
scopes

You can show and hide the scopes area with the “Scopes” button in the toolbar. You can also “undock” the scopes area from the main window by
clicking the window button on the right on top of the scopes area.

Settings

Each tool comes with its own settings. You can choose to show the desired settings panel in the gear menu besides the tool selection above the scopes
area. The “Color Primaries” menu allows choosing the appropriate colorimetry (Rec.709 / Rec.2020) for your incoming video signal. With the “Auto”
setting enabled the scopes switch to the correct colorimetry automatically based on the current slot’s output colorspace.

Video scopes with settings
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Processing

The scopes always process the image currently shown in the selected slot. This can be a still frame as well as a live captured signal.

The video scopes in Livegrade always analyze the currently processed image. In order to see scopes of the original image, switch to the “Original”
viewing mode for the slot.

Result
curve

The waveform panel shows also a RGB curve of the resulting color transform. It represents the curve of all combined transforms including 3D LUTs and
CDL transforms. You can disable the result curve in the Settings panel of the scopes.

Using
the
False
Color
Mode

What
is
False
Color?

False color is an exposure tool that colorizes different luminance values to quickly evaluate the quality of an image.

Different manufacturers have integrated this tooling into their cameras in different ways and tailored it to their respective original log formats.

 

 

How
does
Livegrade’s
False
Color
work?

To accommodate different log formats, color scales, and individual user needs, Livegrade introduces an
1D
LUT-based
False
Color
mode.

This mechanism converts the incoming image into a black-and-white image version first. After that, a selected 10bit 1D LUT that defines certain color
ranges will be applied to output the false color image.

 

1D-LUT based False Color Mode

Setting
up
Livegrade’s
False
Color
Mode

Go to Settings
>
Grading
to adjust Livegrade’s false color mode to your individual needs by going through the following settings:

Force
to
Apply
False
Color
On

This setting determines when the false color mechanism should take effect.

Original
(recommended)
Apply false color always to the original image (without grading and LUT). This ensures that you always check the actual image regardless of the
selected LUT and grading.

Bypass
Apply false color always to the image after the output transform (last LUT node) has been applied – any grading is bypassed for the moment.

Graded
Apply false color always to the graded image
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Uncheck
If you want to apply false color depending on your current mode (Graded / Bypass / Original), uncheck this option.

Based on the selection for the when, you can use the following settings to select which false color LUT should be applied.

False
Color
LUT
for
Original

With this selection, you set the false color LUT which will be applied when you are in Original mode. Since each log format distributes color and
luminance differently, Livegrade offers many manufacturer LUTs out-of-the-box to get the same result in Livegrade as it would be the case in the internal
false color processing of the respective camera.

Note: If you have previously activated the option “Force to Apply False Color On” and set it to “Original”, False Color will always use this LUT and apply it
to the original image.

False
Color
LUT
for
Graded

Use this drop-down to select which false color LUT is applied to the graded or bypassed image at the end of your pipeline.

False
Color
User
LUTs

It is possible to include your 10bit 1D LUTs in the .cube format. This option is available for the original as well as the graded selection.

To create your own false color LUT, we recommend our Pomfort False Color LUT Creator.

With this you can load existing presets of common log formats, edit and download them as 10-bit 1D LUT to your computer.

To load the created False Color LUT in Livegrade select for Original or Graded

False
Color
User
LUTs
>
Show
in
Finder.

This is the folder where you can save your LUTs.

Click the Refresh button to be able to list your LUT in the hierarchy.

False Color User LUTs

Common
False
Color
Setups

To give you an example how your setup could look like, check the following table:

Alexa
35 Alexa
Classic Sony
Venice
2

Force
Apply
False
Color
On:Original Uncheck Original

False
Color
LUT
for
Original:ARRI > LogC4 EI 800 ARRI > LogC3 EI 800 Sony > SonySlog3

False
Color
LUT
for
Graded:disabled Pomfort > Ranges disabled

Note:Choose False Color LUT for Original according
to the selected EI

Choose False Color LUT for Original according
to the selected EI
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Advanced Grading Features
Using
Node
Presets
for
Looks
and
Offsets
In contrast to Look Presets, which store an entire look with all nodes in the look library, a node preset only contains one or several nodes of a look.

When a node preset is applied to the current slot, only the nodes of the current look with the same name are updated, while other nodes are left
untouched.

An important detail: Node
presets
can
also
include
metadata. This makes them a powerful tool for managing offsets of lenses, filters, or camera bodies.

Use
Cases
for
Node
Presets

Node presets can be used to store and apply single aspects of a look. Common use cases for node presets could be:

Look
adjustment: A single CDL node, that corrects a look just to be a little warmer or cooler
Correction
for
a
camera-,
lens-
or
filter
offset: A single CDL node including metadata, that represents the correction of a certain color cast
Change
of
colorspace: a 3D-LUT node with a LUT representing a color space conversion
Replacing
the
look: a CDL and a saturation node representing a creative look without the log-to-video conversion LUT
Replacing
the
LUT: a 3D-LUT node with a specific log-to-video conversion LUT

Naming
nodes

When working with node presets the naming of the single nodes becomes very important, because node presets will always override look nodes with the
same name. If a matching node can’t be found, the node(s) will be added to the current look.

To edit the name of a node, move the mouse cursor over the name and click the little pen icon that appears to change it to your needs.

Naming Nodes

Note: Nodes need to have unique names within a look and we recommend carefully choose meaningful names.

Managing
Slot
Metadata

If you are going to use metadata within your node presets, you can manage them via your slot.

It’s possible to save the following fields into a node preset

Camera Model
Lens Model
Focal Length
Aperture
Filter
Custom 1
Comment

If fields are set to be automatically set by the SDI signal of the camera (indicated by an ‘A’ icon instead of a pen next to your slot metadata field), those
fields won’t be overridden when applying a node preset including metadata. Change them to be manually set by clicking on the ‘A’ so the pen-icon is
shown next to the metadata field.
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Managing Slot Metadata

Saving
a
Node
Preset

To save a node preset, click the Color button in the toolbar to show the Look
Library in the right bar. You can then save a node preset by clicking the
“Add
Node
Preset” button above the Look Presets.

Save a Node Preset

A panel is displayed where you can choose, which grading node(s) and which metadata should be stored in the node preset.
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Nodes. The nodes list shows all nodes of the current grade together with their names and types. Check them on the left of each row if you want
that node to be part of the node preset.
Metadata. Below the grading nodes, you find slot metadata of your current slot. Check those you want to save with your node preset. If you want
to change certain values, close the dialog again and change the values via the slot metadata.

Clicking “Save” saves a new node preset into the look library.

Inspecting
Node
Presets
in
the
Look
Library

Collection
view.
In the Look Library’s collection view, node presets are indicated by a little icon with an N in the top-left corner. You can click on
the little “i” in the bottom left of a preset to display information about the nodes of the node presets.
List
view.
To see all your presets listed including metadata, switch to the list view.

Presets Collection View

Presets List View
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Apply
Preset
To
Current
Slot

You can apply the look information (without metadata) of a node preset by simply double-clicking it or via the contextual menu by selecting Apply
Preset
to
Current
Slot.

The selected node preset is also applied when clicking the Apply button above the Look Presets or via the menu

Look presets > Apply
selected
Look
Preset


Note: If the current look doesn’t have nodes that match by name with the node preset, additional nodes will be added. This can also result in a necessary
change of the grading mode, e.g. from CDL and LUT to CDL Advanced mode.

Apply
Preset
Including
Metadata
to
Current
Slot

To override slot metadata with saved values of your node preset, open the contextual menu from your node preset and choose Apply
Preset
Including
Metadata
to
Current
Slot.

Look information will also be applied to the current slot by using this functionality.

If fields are set to be automatically set by the SDI signal of the camera (indicated by an ‘A’ within your slot metadata), those fields won’t be overridden.
Change them to be manually set by clicking on the ‘A’ so the pen-icon is shown next to the metadata field.

Note: If the current look doesn’t have nodes that match by name with the node preset, additional nodes will be added. This can also result in a necessary
change of the grading mode, e.g. from CDL and LUT to CDL Advanced mode.

Apply
Preset
To
Selected
Shots

You can also update existing shots in your library with a node preset. The behavior will be the same:

If there is a node with the same name in the shot(s) you selected, the grading of the certain node will be overridden
If there is no matching node, the grading node of the node preset will be added

This functionality is also provided for Look Presets.

Metadata won’t be overridden with this function.

Note: When there is no matching and the node has to be added, this can result in a necessary change of the grading mode, e.g. from CDL and LUT to
CDL Advanced mode.

Example:
Lens
Correction

Let’s illustrate the use of a node preset with an example.

You have a look consisting of a creative CDL node, a second CDL node correcting the color cast of the lens, and a 3D LUT node with the log-to-video
conversion.

Example Grade Setup for Node Presets

Let’s assume you have to switch between three lenses regularly, which all have different color casts. You want to save a node preset for each lens, that
only consists of the CDL node representing the correction of the lens’s color cast.

1. Prepare
Switch to “CDL Advanced” grading mode, click on “Edit”, and remove all nodes except two CDL nodes and one 3D-LUT node.
Click on the right bar of the second CDL node “CDL 2”, and rename it to “Lens Correction”. You should now have one CDL node named
“CDL”, and one “Lens Correction”.
Use the color controls and set a creative look in the “CDL” node and a 3D LUT for the log-to-video conversion.

2. Color
correct
Use the color controls of node “Lens Correction” and set it to correct the color cast for your lens

3. Edit
slot
metadata
Use slot metadata and change the field for Lens Model (e.g. “Vintage Prime T2.0”) and Focal Length (e.g. “35mm”)

4. Add
Node
Preset
Click on the “Add node preset” button above the presets.
In the appearing panel with the list of nodes select the “Lens Correction” node.
As metadata to be saved, choose the fields Lens Model and Focal Length and double-check them for the correct values. If the values are not
correct, close the dialog, change the values via the slot metadata fields, and open the dialog by pressing the “Add node preset” again.
Check that all unused nodes and metadata fields are unchecked.
Click “Save” and give the new node preset a name (e.g. “Lens Correction”).

5. Repeat steps 2 to 4. for two more lenses.
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You now should have three new node presets containing only the lens correction for your three lenses including their descriptions.

To get a better overview of your corrections, switch to the list view that will show you their metadata as well.

When lenses are switched next time, you can simply right-click on your node preset and choose “Apply
Preset
Including
Metadata
to
Current
Slot” for
the corresponding lens in the look library. The node with the name “Lens Correction” will then be updated with the correction for that particular lens as
well as the slot metadata fields.

Using
the
RGB
Curves
Editor
The RGB curves editor allows you to precisely grade your footage, either by applying a single master curve or by creating curves for individual channels
luma, red, green, blue and/or a custom color.

There are two modes to choose from: 
“RGB-Based” adjusts the selected color channel including its luma and saturation values, while the “Master” curve is a ganged RGB
curve influencing the red, green and blue channel at the same time
“Luma-Based” adjusts the colors red, green, blue and/or the custom set color without influencing their luma and saturation values,
while the “Luma” curve can be adjusted independently 

In the “Custom” color curve you can pick a custom target hue, for adjusting a certain color in your image precisely
To add a curve point just click on a curve, and in order to modify it’s value just drag and drop. You can adjust curve points using the left/right and
up/down arrow keys as well.
To remove a point, select the point and press Backspace.
When you move your mouse over the curve editor, the graph shows you the value of the exact point where it is. When the mouse pointer is not
moving or it is outside of the curve editor window the values of the currently selected curve point are being displayed.
There is a color picker tool, that lets you pick a specific target color value in the viewer window. Picking a color automatically creates a curve point
in the graph of the current tab. The color picker tool can also be used to pick the target hue of the “Custom” color curve.

RGB Curve Editor

 

Note: There is another curve editor in the Alexa grading mode, that is limited to a “Master” curve.
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RGB Curve Editor Alexa grading mode

 

Using
the
ACES
CDL
Grading
Mode
Livegrade implements the ACES color pipeline including IDT transforms, working color spaces such as ACEScct and ACEScc, LMT, RRT and ODT
transforms to be used on camera live signals and still images (e.g. for reference) on the film set.

The ultimate goal is to create the same visual result on an on-set monitor (showing the ACES-processed live signal of a camera) compared to the monitors
in a color corrector (showing the ACES-processed recorded source clips from the camera). Livegrade also offers export of ACES-based looks in the
ACES Metadata File format (for ACES version 1.2 and newer).

The following diagram shows an example ACES pipeline as implemented in Livegrade.

Example ACES pipeline in Livegrade

Step-by-Step:
How
to
Configure
Livegrade
to
Start
Using
ACES

1. Open the Livegrade Pro or Livegrade Studio application.
2. Go to the the “ACES” section in the application preferences (Main Menu: “Livegrade > Preferences…”) to set the ACES version for new looks and

download desired ACES versions.
3. Choose the grading mode “ACES CDL” or “ACES CDL Advanced” by selecting it from the dropdown positioned on top of the grading interface next

to the label “Look”.
4. Select the intended input and output transform for your setup depending on camera input and display output. That can be done with of the IDT and

RRT+ODT nodes of the grade.
5. You will now be able to preview and manipulate the image signal in the selected ACES working space (ACEScc or ACEScct).

ACES
grading
modes

Livegrade implements this pipeline in the ACES (Academy Color Encoding System) grading modes. You can see the nodes and controls of the “ACES
CDL” grading mode in the screenshot below. On every interaction with the color controls of the ACES grading mode (e.g. change of IDT, modify of ASC-
CDL) all transforms are baked together automatically and sent to an attached LUT box.
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ACES CDL Grading Mode

Livegrade also offers the “ACES CDL Advanced” grading mode. This grading mode lets you add multiple grading nodes between the IDT and ODT and
LMTs for advanced workflows.

You can take a look at how to use the advanced modes in the article Grading Modes in Livegrade.

The CDL controls behave the same way as in the CDL Grade mode and can also be exported as usual from a saved grade. ACES grades can also be
exported as 3D LUTs, including the CDL values, IDT and ODT.

Using
the
FilmLight
BLG
Grading
Mode
Livegrade Studio supports using the FilmLight color pipeline and round-tripping with the FilmLight product family via BLG import/export and a dedicated
“FilmLight BLG” grading mode. 

Activate
FilmLight
BLG
grading
features

To activate the FilmLight BLG grading features you need to install

a compatible Livegrade Studio version,
a compatible Daylight version, with a valid Daylight license or a free “BLG Tools” license, available on the FilmLight website.

As soon as you have installed the compatible versions of Livegrade Studio and Daylight and activated the required license the FilmLight BLG grading
features will be unlocked in Livegrade Studio.

THE
FILMLIGHT
BLG
GRADING
MODE

Livegrade Studio comes with a dedicated grading mode supporting the FilmLight color pipeline.

You can import a BLG (.blg.exr) file as a shot into your shot library and apply the look to your slot. The FilmLight BLG grading mode automatically applies
all parameters set in the loaded BLG, including input transform, working color space, grade stack and viewing color space.

To import a BLG into your shot library choose “File” > “Import Look As Shot…” > “FilmLight BLG (blg)”.

Note: Spatial layers such as shapes will be skipped on import.

If you apply the imported look to your slot you are able to use its parameters as a starting point for creating a new look in the FilmLight BLG grading
mode.

The grade editor in the FilmLight BLG grading mode lets you apply the following color controls:

In: This section includes all available input transforms (“Input Colorspace”) and working colorspace transforms (“Working Colorspace”) of the FilmLight
color pipeline.

CDL: This is a creative grading node compatible with ASC-CDL. The ASC-CDL is applied in the selected working colorspace (e.g.,  FilmLight’s E-
Gamut/T-Log). The CDL correction can be passed on as an additional CDL-layer into the FilmLight grade stack via BLG look export.

Click “Edit” in the header bar of the grade controls to add additional CDL-based nodes (CDL or Saturation nodes) or remove nodes. 

Note: Several CDL-based nodes that are applied after another are combined into one CDL node when transferring look metadata as BLG file. 

You can also move an additional CDL node after the “Grade” node, which will result in an additional CDL node in the target FilmLight application that is
applied between the current grade stack and the output transform (viewing colorspace).

Grade: This node holds the complete grade stack applied in the loaded BLG. The grade stack is not editable within Livegrade but is applied to your
current look and will be transferred completely when exporting a BLG.

Out: This section includes all available display rendering transforms (“DRT”) and output transforms (“Viewing Colorspace”) of the FilmLight color pipeline.
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FilmLight BLG grade editor

 

RESETTING
LOOKS

When clicking “Reset Colors” in the bottom bar of the main window, or choosing “Reset Color Nodes Only” from the Grade menu, all CDL and Saturation
nodes are reset. All other parameters stay untouched.

When clicking “Neutral” in the bottom bar of the main window, or choosing “Reset All Nodes To Neutral” from the Grade menu, all CDL and Saturation
nodes and the Grade node are reset to the grading mode’s default settings. 

TRANSFERRING
LOOK
METADATA

Looks stored in the application’s shot and look library can be exported as BLG files for further processing in products capable of processing images in the
FilmLight color pipeline.

The following shot metadata fields can be passed on via BLG:

Livegrade
Metadata FilmLight
Metadata

Clip-Identifier Clip

Comment Comment

Camera Camera

Scene Scene

Take Take

Reel Tape

Aperture Aperture

EI/ISO ISO

Lens Model Lens

Shutter Angle Shutter Angle

Tint Tint

White Balance Colour Temp

Frames (frameCount) Length

TC Start Ref TC

Note: For matching your BLG files to camera originals in FilmLight applications, you can use the “Clipname” metadata field. To do so, make sure to set
your Default Clip-Identifier to “D3: Clipname” in the library preferences. If there is no Clipname metadata available, you can also match clips using
timecode if the shot creation was in the timeframe of the recorded clip (make sure to set your match setting in Daylight to “fuzzy”).

KNOWN
ISSUES

Spatial layers such as shapes will be skipped on import
After installing new custom DRTs Livegrade needs to be restarted in order to import a BLG using the new DRT
Reading and transmitting the “Graderesult Colour Space” is currently not supported
Shots created if the grade node is disabled will still have the grade node included inside of the exported BLG

Using
the
Colorfront
Film
Grading
Mode
Livegrade Studio supports the “Colorfront Film” transform of the Colorfront Engine. From Colorfront’s document “Using the Human Perceptual Model for
Multiple Display Mastering”:

“The
Colorfront
Engine
is
a
state-of-the-art
parametric
color
processing
pipeline
mapping
various
input
formats,
including
camera
original
(scene-referred)
and
graded
(display-referred)
images,
to
a
wide
range
of
SDR
and
HDR
output
formats
at
user
definable
brightness
levels
and
gamuts
while
maintaining
the
creative
intent.”
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Using
Colorfront
Film
with
AJA
FS-HDR

The Colorfront Engine implemented in AJA FS-HDR device can be controlled by Livegrade Studio. Setting up AJA FS-HDR for details on how to connect
to FS-HDR.

The
Colorfront
Film
Grading
Mode

Livegrade Studio comes with a grading mode supporting all parameters of the Colorfront Film color processing pipeline.

The controls of the Colorfront Film grading mode

The controls are grouped into three sections:

CFE
In: This section includes the input transform (for matching the incoming signal color space), scene-referred parameters (e.g. exposure and color
temperature), and the grading color space.

CDL: This is a creative grading mode compatible with ASC-CDL. The ASC-CDL is applied in the color space selected as “Grading Colorspace”. 

Although the Colorfront Film color processing pipeline only supports one set of ASC-CDL, you can have more than one CDL nodes in the grading mode.
All CDL nodes are combined into one set of CDL nodes when transferring look metadata for the Colorfront Film color processing pipeline.

Click “Edit” in the header bar of the grade controls to add additional CDL nodes or remove nodes.

CFE
Look: In this section you can set additional creative parameters such as two independent looks (selection of a set of predefined looks), a blend
factor between these looks, and an HDR amount.

CFE
Out: This section holds all controls that define the output, such as output range and colorspace, a SDR preview and PQ output nit level for HDR
output transforms.

The order of the mentioned sections cannot be changed.

Resetting
Looks

When clicking “Reset Colors” in the bottom bar of the main window, or choosing “Reset Color Nodes Only” from the Grade menu, the following
parameters are reset:

Exposure, Color Temp, Tint
All CDL and saturation nodes
Look selection and look blend
HDR amount

All other parameters stay untouched.

When clicking “Neutral” in the bottom bar of the main window, or choosing “Reset All Nodes To Neutral” from the Grade menu, all parameters are reset
and the color processing pipeline set to Rec.709 input and output.

Transferring
Look
Metadata

Looks stored in the application’s shot and look library can be exported as CFE files for further processing in products capable of processing images in the
Colorfront Film color processing pipeline.

See Exporting Look Metadata for more information on exporting CFE files.

Limitations

Using the proprietary Colorfront Film color processing pipeline has a few consequences for other features in the application. 

As the processing is happening in the FS-HDR, the application is currently only communicating and storing parameters for the color processing pipeline,
but has no information about the actual color transforms.

This means that the following features are not working the same way as with non-proprietary color processing pipelines (such as LUT and CDL or ACES):

Processing of framegrabs and recorded clips in the viewer
Display of scopes of a captured live signal, framegrabs, and recorded clips
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Exporting processed still images

You can work around a few limitations by capturing a pre-graded image (capturing the output of FS-HDR) in Livegrade Studio. See HD-SDI Signal
Recording and Framegrabs  for information about capturing “LUT box output (graded)”.

Setting
up
Brompton
Tessera
processors
Livegrade Studio comes with support for remote LUT control Brompton Tessera processors (starting with firmware v3.2.0). This feature enables the user
to control
the
LUT inside the Tessera processor that affects the processing of image on the LED wall. Livegrade Studio can connect and control to
multiple Tessera processors as long as they are reachable via a network connection (LAN or WiFi depending on your setup).

Prerequisites

In order to exchange LUT information with Livegrade Studio, the Tessera processor needs to have a working network connection with the Mac where
Livegrade Studio is running on. You can test that by using the “ping” command in the Terminal on macOS to check if the IP address of the Tessera server
is responding.

In the Brompton Processor configuration make sure that

“IP
Control“, and
“3D
LUT“

are switched on.

Setting
up
the
Connection

Once a connection is established, launch Livegrade Studio and you can proceed to add the Tessera server as a device.

In order to do that, you can choose “Slots” in the main menu and then “Add Device” and choose “Brompton device”. Alternatively, you can add the
device through the Device Manager.
A window will appear that asks for an IP address of the processor to add it as a device. Enter the IP address of the camera as displayed in the
camera settings. Click “Add
Device”.

Enter the IP address of the device.

If you open the device manger in Livegrade Studio by clicking the button “Devices…” on the left side of the Livegrade Studio user interface. The device
manager will show a connected Brompton processor:

Two Brompton devices connected to Livegrade Studio.

Livegrade Studio is now able to control the LUT of the device. Please refer to the article Color Controls and Grading Modes for more information on
grading controls in Livegrade Studio.

Setting
up
Pomfort
Virtual
LUT
Box
for
Unreal
Engine

Note: This is documentation for features available with Livegrade Studio 6.x or newer and the PomfortVL plugin for Unreal Engine version 5.1 or newer.
Latest downloads for the PomfortVL plugin can be found on the virtual production workflow page.

The Pomfort Virtual LUT Box for Unreal Engine allows creatives to interact with the Unreal Engine’s image through Livegrade Studio. It is intended to
provide the typical behavior (for example, ASC-CDL in working color space ACEScct) and known tools (standard grading controls and color wheel
controllers) for creative color adjustments in virtual production environments. While being color managed in itself, the color adjustments of the Pomfort
Virtual LUT Box should be used for creative adjustments of the image only and are not intended to be used for calibration efforts or other color
management tasks.

The Pomfort Virtual LUT Box for Unreal Engine consists of two parts:
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Plugin,
components,
and
assets
for
Unreal
Editor include the PomfortVL plugin, a custom actor component, several shaders and materials, and
example actor blueprints for Unreal Editor that perform the color manipulations in Unreal Engine.
Device
support
in
Livegrade
Studio for controlling the Pomfort virtual LUT box from the grade controls in LiveGrade Studio.

Unreal Engine Viewport with active Pomfort Virtual LUT Box

The Pomfort Virtual LUT Box is intended to be used to apply a shader to the entire scene (as a post process material), or to individual frustums, for
example, in an nDisplay setup. That way the appearance of a scene on certain parts of the LED wall can be changed interactively from Livegrade
Studio. The example blueprints’ shaders are configured to apply an ASC-CDL color filter in the working color space ACEScct and can be easily modified
to individual project setups.

Installing
the
Pomfort
Virtual
LUT
Box
Plugin
with
the
Example
Assets
(Shaders
and
Blueprints)

Unzip the download for the Pomfort Virtual LUT Box. It contains the plugin as well as the assets.
Move the folder for the plugin (“PomfortVL”) to the “Plugins” folder of your project. You might need to create a folder “Plugins” in the root directory
of your project if it doesn’t exist.

PomfortVL
Plugin:

After restarting Unreal Editor make sure you see the “PomfortVL” plugin installed in the plugin overview (via “Plugins” in the “Edit” menu). If the Unreal
Editor shows a message that the plugin needs to be recompiled, do so. The source of the plugin is contained in the plugin’s folder.

Note: Using the plugin with a newer Unreal Engine version may require re-compilation of the plugin (you are prompted to do so when opening a project
with the plugin for the first time in the new Unreal version). All necessary source code is part of the plugin download. Visual Studio including Desktop
Development with C++ and the .NET SDK needs to be installed to compile plugins.

PomfortVL Plugin

Plugin
Assets:

Make also sure the plugin’s assets are visible in the Content Browser in Unreal Editor. The assets are located in the plugin’s Content folder and don’t
need to be installed separately, but may not be shown by default in the Content Browser.

Enable plugin assets to be shown in the Content Browser to see the plugin’s assets:
Click on the “View Options” button of the Content Browser
Make sure the “Show Plugin Content” option is checked

To navigate to the plugin’s assets, click on the folder icon in the title bar of the Content Browser and choose “PomfortVL Content”.
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Displaying assets of the Pomfort Virtual LUT Box in the Content Browser

Basic
Setup

Follow the steps below to get started with the virtual LUT Box:

Unreal
Editor:

1. Set the “MPCInnerFrustum-PostShader-CDL-OCIO” material as a Post Process Material in your scene.

Set post process material in Unreal Editor
2. Navigate to the PomfortVL plugin’s assets in the Content Browser.
3. Drag the “LGVL-InnerFrustumMPC-CDL-Actor” into your scene. The ChannelName of the LivegradeVLComponent for that actor is “innerfrustum”.

LivegradeVL actor component with channel name

Note: The look of CDL-based actors is applied in “play”-mode and also in Editor (“non-play” mode). LUT-based actors are only active in the scene
rendering when the scene is in “play”-mode.

Livegrade
Studio:

1. Set up a new slot and switch the grading mode to “ACES CDL”.
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2. Add the “PomfortVL for UE” virtual LUT box device to the slot (for example, in the device manager). Enter
the IP address of the machine running Unreal Editor,
the ChannelName value of the LGVL-InnerFrustumMPC-CDL-Actor that you plan to control (for example, “innerfrustum” for the example
above), and
the Channel Mode to “CDL”.

Connect to a workstation with Unreal Editor

 

3. [OPTIONAL] Set the IDT to “Academy – Reverse sRGB 100 nits (ODT)” and the ODT to “sRGB – sRGB 100 nits (dim)”. With these settings, an
ungraded/neutral reference still in sRGB (for example a hires screenshot from Unreal Engine) can be used in Livegrade Studio for preview. With the
correct color pipelines set up, Livegrade’s  viewer should reproduce the same image as the Unreal Engine with the PomfortVL plugin.

You now should be able to control the look of the scene by changing the CDL controls/color wheels of the configured slot from that Livegrade. The
Output Log in Unreal Editor shows one line per change of CDL values (see screenshot below).

Example Output Log of the Pomfort Virtual LUT Box

Channel
Mode:

A connection between Livegrade and Unreal Engine is made either using CDL parameters or a 3D LUT for communicating look information. Depending on
this setting, Livegrade prepares information differently:

CDL: Livegrade only sends the parameters of the CDL grading nodes, no matter what additional nodes or IDT/ODT nodes are set.
LUT: Livegrade combines all grading nodes into a 3D LUT, except IDT and ODT nodes. It is always assumed (and implemented in the example
Blueprints), that the working color space is set up in the shaders and materials in Unreal Engine.

Persistence
of
Look
Information
in
the
Unreal
Engine
Project:

CDL and LUT values are stored in the project so that the last look can be recalled even if no Livegrade is connected. The information is stored in the
PomfortVL plugin’s folder named “SaveState”.

As soon as Livegrade connects again, the current values from Livegrade are applied.

Assets
of
the
“Pomfort
Virtual
LUT
Box”
in
Unreal
Editor

The Pomfort virtual LUT box for Unreal Engine comes with the following assets and components:

MPCs
(Material
Parameter
Collections),
in
Materials/:

The MPCs act as an intermediate storage of look metadata between the PomfortVL plugin (through the actor components) and the post process
materials.

Frustum_Global_MPC, Frustum_Inner_MPC, Frustum_Outer_MPC: Material parameter collections for the individual actors/materials.

The mechanism to connect post process materials to parameters from the PomfortVL plugin through MPCs enables instantiation of multiple, independent
materials to be controlled from Livegrade Studio, e.g. for different frustums (the different materials are bound to independent MPCs, which get their
updates from independent PomfortVL instances/actor components, which can be controlled from different connections/channel names from Livegrade
Studio).

Note: MPCs can only store parameter values, not textures. That’s why the MPC mechanism can only be used with CDL-based looks, but not for LUTs-
based looks.

Main
Actor
Components:

LGVL-GlobalMPC-CDL-Actor,
LGVL-InnerFrustumMPC-CDL-Actor,
LGVL-OuterFrustumMPC-CDL-Actor: An example actor that updates a
certain MPC with a CDL  values. The actor uses an instance of the LivegradeVLComponent (e.g., ChannelName “innerfrustum”) to provide remote
access to the color grade parameters (CDL parameters).

Actor components from previous versions of the PomfortVL plugins:

LGVL-GlobalCDLGrade-Actor: An example actor setting up a dynamic material with a CDL shader as a post-process material. The actor uses an
instance of the LivegradeVLComponent (ChannelName “global-cdl”) to provide remote access to the color grade parameters (CDL parameters).
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LGVL-GlobalLUTGrade-Actor: An example actor setting up a dynamic material with a 3D LUT shader as a post-process material. The actor uses
an instance of the LivegradeVLComponent (ChannelName “global-lut”) to provide remote access to the color grade parameters (dynamic 3D LUT
texture).

You can set the identifier in the detail section “Live Grading” as the “ChannelName” property (see screenshot).

Note: Multiple instances of LivegradeVL Component must have different/unique values for ChannelName. Identical values for ChannelNames will lead to
undefined behavior.

Other
Actor
Components
and
Assets:

LGVL-CylinderCDLGrade-Actor: An example actor setting up a dynamic material with a CDL shader as a surface material for a cylinder object.
The actor uses an instance of the LivegradeVLComponent (ChannelName “cylinder-cdl”) to provide remote access to the color grade parameters
(CDL parameters).
LGVL-CylinderLUTGrade-Actor: An example actor setting up a dynamic material with a 3D LUT shader as a surface material for a cylinder object.
The actor uses an instance of the LivegradeVLComponent (ChannelName “cylinder-lut”) to provide remote access to the color grade parameters
(dynamic 3D LUT texture).
LGVL-GlobalCDL+InvGradeActor: An example actor setting up a dynamic material with two CDL shaders as a post-process material. The actor
uses two instances of the LivegradeVLComponent (ChannelNames “global-cdl” and “global-invcdl”) to provide remote access to the color grade
parameters (CDL parameters). See Setting up PomfortVL for Foreground Grading for use cases.

 

LGVL_EditorTick_BPI and LGVL_EditorTicker_BP: Blueprints with functionality for triggering updates of CDL-based post process materials also
in non-“play” mode.

These assets illustrate the basic functionality and interaction of the virtual LUT box, can be used as a starting point for your own integration development.

Color
Management
and
Grading
Shaders:

MPCGlobal-PostShader-CDL-OCIO, MPCInnerFrustum-PostShader-CDL-OCIO, MPCOuterFrustum-PostShader-CDL-OCIO: Post-process
shaders bound to corresponding MPC objects, to be instantiated manually

Grading shaders from previous versions of the PomfortVL plugins:

CDLPostShader-sRGB and CDLPostShader-Rec2020PQ: Post-process shaders used to color grade the entire scene. A CDL is applied in
working color space ACEScct. The blendable location is set to “After Tonemapping” and the shader is built for tone mappers to sRGB and PQ (with
Rec.2020). The shader CDLPostShader-sRGB
is used by default by the LGVL-GlobalCDLGrade-Actor.
LUTPostShader-sRGB: Post-process shaders used to color grade the entire scene. A 3D LUT is applied in working color space ACEScct. The
blendable location is set to “After Tonemapping” and the shader is built for tone mappers to sRGB.
CDLPostShader-OCIO: A post-process shader used to color grade the entire scene. A CDL is applied in working color space ACEScct. The
blendable location is set to “Before Tonemapping” and the shader is built for OCIO-based ACES processing in the viewport. The shader assumes
the color space of the engine’s rendering to be sRGB with linear enoding.

Color pipeline in Unreal Engine with PomfortVL shaders

CDLSurfaceShader: A surface shader used to color grade the emissive color of a material. A CDL is applied in working color space ACEScct. The
shader is used by default by the LGVL-CylinderCDLGrade-Actor.
LUTSurfaceShader: A surface shader used to color grade the emissive color of a material. A 3D LUT is applied in working color space ACEScct.
The shader is used by default by the LGVL-CylinderLUTGrade-Actor.

Other

Setup
Options

Bottom
Color
Bars

The color bars on the bottom of the image can be used to quickly indicate if a grade is applied. This is especially helpful when setting up the Pomfort
Virtual LUT Box.

If the color bar has only one row, no grade is applied. If the color bar is split into two rows (a neutral on the bottom and a modified row above), a grade is
applied.

You can modify or bypass the ramps in each shader asset by manipulating the “Patch-Ramp” nodes in the Material assets. The neutral and the graded
 color bar are created by one “Patch-Ramp” node each.
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You can change the height of both bars by changing the yStart parameter of each PatchRamp node. yStart is a value from 0.0 to 1.0 spanning the y
axis from top (0.0) to bottom (1.0). The color bar is painted from yStart to the bottom of the image.
You can disable the color bar by bypassing the “Patch-Ramp” nodes (i.e. connecting the output of the previous node directly with the input of the
next node).

You can explore the blueprints and shaders for more options.

Trouble
Shooting

If you start the Unreal Engine after you configured the devices in Livegrade Studio, you can click the “Reload devices” button beside the “Devices…”
button in the main window to reconnect to the PomfortVL plugin. A yellow warning triangle in the slot UI can indicate that the slot is not in Play mode.

Known
Issues

Amount of logging in Output Log cannot be configured yet.
LUTs used in CDLPostShader-sRGB and CDLPostShader-Rec2020PQ currently only for tone mapping to sRGB and PQ (with Rec.2020) output
color space. In case you are using the tone mapping to other output color spaces, different LUTs need to be used. Please contact us at
virtualproduction@pomfort.com.

Setting
up
PomfortVL
for
Foreground
Grading

Note: This is documentation for features available with Livegrade Studio 6.0 or higher and the PomfortVL plugin (in Beta). Latest beta downloads for the
PomfortVL plugin can be found on our virtual production workflow page.

This article documents an example setup for foreground grading in virtual production. Foreground grading uses the concept of manipulating the image of
the camera with a LUT box while compensating that grade with an “inverse” grade in the background, i.e., the LED wall. This can be set up with the
Pomfort Virtual LUT Box for Unreal Engine, a regular LUT box, and Livegrade Studio.

For the basic setup of the Pomfort Virtual LUT Box for Unreal Engine, please see the article Setting up Pomfort Virtual LUT Box for Unreal Engine.

Hardware
Requirements

The necessary hardware setup for foreground grading is as follows:

Hardware setup for foreground grading

 

Concept

Foreground grading aims to isolate the foreground elements (for example, an actor in the scene) from the background image and color-grade these
elements independently. This is not possible directly, so the idea is to compensate the grade of the entire image with the grade of the background.

A LUT box offers the capability to grade the entire captured image (foreground and background), and the PomfortVL plugin introduces the ability to grade
the background (i.e., the LED wall). Having access to both grades from Livegrade and linking the two grades, you can achieve the effect of grading the
foreground while the background appears to stay unchanged.
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Color pipeline for foreground grading

Example

If the actor in the image should appear “greener” while the background should stay unchanged:

the LUT box is grading the entire camera image greener while
the grade of the LED wall gets the inverse of the warmer look, i.e. it shows a “pinker” image.

Graded foreground example

On the camera monitor, the foreground actor now appears greener (per grade of the LUT box). In the background, the LUT box’s greener look is
compensated with the pinker look of the foreground. As a result, the background appears unchanged.

Setup

Unreal
Engine:

Add the LGVL-GlobalCDL+InvGrade-Actor actor to your scene (instead of any other “global” grade actor).
The actor is configured with two LivegradeVL actor components, one for regular grading and one for the compensation grade. Both grades can be
controller independently from Livegrade.

Livegrade
Studio:

Set up three slots.
The first slot connects to PomfortVL component with ChannelName “global-cdl”.
The second slot connects to PomfortVL component with ChannelName “global-invcdl”.
The third slot connects to LUT box (camera monitoring).
Link the second and the third slot in the device manager.
Setup the third slot so that it has two CDL nodes. One will be used for global (non-compensated) grading with the LUT box, one for compensated
(foreground-only) grading. Name the grading nodes accordingly (for instance, “All” for non-compensated and “FG-only” for compensated grading.
Make sure the CDL node “FG-only” is shared between the second and the third slot (linking checkbox is on), and the “All” CDL node is not shared.
Optionally set up two saturation nodes (one linked and one non-linked) the same way as the CDL nodes.

Now you can use

the first slot to grade the background,
the “FG-only” node of the second or third slot to grade the foreground, and
the “All” node of the third slot to grade the entire camera image.
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Device manager and grade controls

Additional
Constraints

Only looks with no or just a little clipping work well for inversion. So use moderate grades only for foreground grading. Remember, this is a
“blending tool” or a “correction tool”, it doesn’t want to replicate the role of lighting on set.
The camera’s exposure and image processing must be chosen so that the camera’s captured dynamic range is (roughly) the same as the displayed
dynamic range of the LED wall. This also means maintaining the LED wall’s exposure quite well balanced with the scene’s overall exposure and the
relative camera exposure. For instance, if the LED wall shows a series of grey patches from black to white, the camera monitor image also needs to
show the same range of grey patches (and not multiple black patches or multiple white patches). This is required so that the inversion of the
camera’s grades (in the LUT box) and the look in Unreal Engine (in the virtual LUT box) cancels out.
The LED panels should not light the foreground objects so that the foreground objects are affected by the inverse grading applied to the
background. If the object is lit by the LED wall only, the inverse look on the LED wall will also change the foreground object’s appearance (acting as
the only light source). This compensates the grade of the LUT box and reduces or even cancels the desired effect. The solution is to light the
foreground objects with a preferably “constant” light source. That can be achieved by limiting the inverse grading to only a smaller portion of the
LED wall like the inner frustum (what the camera sees) or applying the inverse grade to the background but not the ceiling and the frontal LED
panels.

 

Linked
Looks
Livegrade allows to link slots and sync image processing nodes between slots. Thus it is possible to build two independent processing chains that can
contain unique as well as shared processing steps.

Content

Sections:

Basic Principles
Linking Slots
Syncing Nodes
Saving Linked Looks to the Library
Creating Individual Looks from a Linked Look
Editing Individual Looks from a Linked Look
Exporting Linked Looks
Create Shots from Linked Slots

This
article
will…

…help you understand the basic principles of Linked Looks in Livegrade.
…teach you how to link slots and sync nodes.
…give you insights how to handle Linked Looks in the library and for export.

Basic
Principles

The basic idea of the Linked Looks feature is to control two slots at the same time. Also important is being able to adjust parts of a look
separately and other parts simultaneously.

While two or more devices are involved you can adjust certain parameters of the look simultaneously for all devices while other parameters can be set
uniquely for each device.

Basically that will be achieved with two simple steps:

Linking slots
Syncing and unsyncing nodes between the linked slots
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By linking slots you decide which two or more slots will synchronize nodes between each other. Then you can decide which nodes to sync and which not
to sync.

Linking
Slots

In order to link two slots, open the Device Manager via the “Devices” button on the left side of the Livegrade main window.

Tip: In case you are dealing with longer slot names (e.g. “A Camera SDR”), you could use the function “Show Slot Label only” as done within this
example. As a result, the Slot Label will be used for the “Camera” metadata field.

Inside of the Device Manager click the “Link
Slot” dropdown in the first slot. From the dropdown choose “Link
with
slot” which will also contains the
according letter or slot label of the other slot you link with:

Fig. 1: Linking slots in the device manager

After successfully linking the slots a chain symbol will appear next to the dropdown. Additionally the slot characters of the slots that are linked appear
next to the chain icon:

Fig. 2: Linked slots

 

Syncing
and
Unsyncing
Nodes

Close the Device Manager to go back to the main window of Livegrade.

You may have noticed that on the right side of each node in the grading panel a chain symbol appeared:
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Fig. 3: Nodes showing the chain indicator for connected processing

It indicates the synchronization state of the node:

Blue
chain
button: Node is synced between linked slot 
Grey
chain
button: Node is unsynced between linked slots and therefore controlled independently

You can switch the linked state of a node by clicking on the chain buttons.

You can now switch between the two slots to build your look with synced and unsynced nodes. If you have a node unsynced and change its setting, it
will only change in the edited slot. If you then click the chain icon to sync it with the linked slot the settings of the node will simultaneously be applied to
the according node in the linked slot.

Tip: If your set-up requires SDR/HDR monitoring, leave the LUT node disconnected and choose a SDR LUT for your SDR slot, and an appropriate HDR
LUT for a HDR slot. The other nodes could be connected, so that all look decisions will be applied on both slots wheras the technical conversions stays
different for SDR and HDR monitoring.

Important

When you connect slots they will always keep the same grading mode and exact same node structure in the grading panel. If you delete a node from one
slot it will also be deleted from the linked slot and vice versa. The same behaviour takes effect when adding nodes.

Saving
Linked
Looks
to
the
Library

To save Linked Looks from linked slots to your shot library when triggering “Create
Shot”, open

Livegrade > Settings >
Library and check “Create
linked
looks
from
linked
slots”

From now on, every time you hit the “Create Shot” button, Livegrade will save a Linked Look for the linked slots.

You will immediately recognize a Linked Look by the chain symbol overlay in the Type column of the library:

Fig. 4: Linked Look Type in the library

A Linked Look saved to your Shot Library contains:

A still image of the currently selected slot
Metadata of the currently selected slot
Look information of linked slots

When you have two or more slots linked the stored look will contain the node structure for both slots in the exact configuration at the point of time you
stored them.

If you apply a look from the library that was saved in linked slot configuration it will restore the same node structure and the same sync status and setting
of the nodes and slots you configured before.

The
Linked
Slots
Column

You will be able to identify linked looks by taking a look at the “Linked
Slots” column. It contains the information about the linked slots. It is easily
detectable of how many independent looks the linked looks persists of and from which slots they were saved.

Fig. 5: Linked Slots column
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Creating
Individual
Looks
from
a
Linked
Look

You can split linked looks up into their separate, standalone looks. The Linked Look consists of several standalone looks that come from the different
slots. For each slot a standalone look is stored as part of the linked look. The number of standalone looks that will be created is easily predictable by the
number of slots the Linked Look possesses (see also Linked Slots column). The Linked Look stays in the library unaltered.

To create individual looks from a Linked Look select the Linked Look in the library and then perform a right click on the linked look:

From the context menu choose “Creating
Individual
Looks
from
Linked
Look”. You will then receive two or more standalone looks depending on the
number of linked slots.

Fig. 6: Context Menu of a Linked Look

 

Fig. 7: Individual Looks of Linked Look

The example above shows a Linked Look and the result of creating individual looks from it. The resulting standalone looks receive individual thumbnails
and the slot name from the Linked Nodes column. Therefore the Linked Slots column is empty, which is always the case for standalone looks.

Editing
Individual
Looks
from
a
Linked
Look
in
the
library
slot

You can drag a Linked Look to the Library Slot and switch between the individual Looks via the Linked
Look pop-up menu.

Edit a linked look in the library slot

As soon as you finished your adjustments, click the button in the toolbar to save your changes.

Exporting
Linked
Looks

3D
LUT,
ASC-CDL,
Pomfort
Look

There are several possibilities to export a look:

3D
LUTs: Linked Looks will be exported to all LUT formats by splitting up the Linked Look into its different standalone looks.
ASC-CDLs
(.cdl): For each standalone look one .cdl file will be exported.
Pomfort
Look
(.pfl): As for the 3D LUTs the look will be split into its standalone looks.

Similar to creating individual looks from Linked Looks the export functionality with linked looks will always add “Slot” and the character or slot name
(depending on preferences) to the end of the file name.
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Pomfort
Look
Archive

A Pomfort Look Archive can be exported including Linked Looks. A compatible version of Livegrade will be able to import the Look Archive again
including the intact Linked Looks. Importing the Look Archive into Silverstack will result in standalone looks in the Silverstack Look Library.

CREATE
SHOTS
FOR
LINKED
SLOTS

If you prefer working with individual shots in your library rather than with linked looks, the function “Create
Shots
for
Linked
Slots” could be of interest
for you.

Working this way you are able to use the functionality linked slots while shooting (e.g. grading the look node simultaneously for several cameras, while the
conversion LUTs are different) but storing individual shots into your library.

To use this function, deactivate “Create
linked
looks
for
linked
slots” in “Livegrade
>
Settings
>
Library” first.

From now on you can use the menu items

Livegrade > Library >
Create
Shots
for
Linked
Slots
and
Livegrade > Library >
Create
Shots
for
Linked
Slots
(with
Secondary
Label)

Legal
and
Extended
–
SDI-Signals
and
LUTs

HD-SDI
signals

Devices supporting HD-SDI (YCbCr) signals can be configured to carry either legal range signals (which is a standard use case for most of all HD-SDI
signals) or extended range signals (which is only used in special, rare use cases).

A 10-bit digital signal can theoretically carry code values from 0 to 1023. A legal range signal only uses code values 64 to 940 (for the Y channel) while an
extended range signal uses code values 4 to 1019 (for the Y channel).

3D
LUTs

3D LUTs are applied on RGB images. In post production systems, RGB images are usually using all the code values available – so for example a 10-bit
RGB image uses code values 0 to 1023. This means that lookup tables made for post production systems expect that code values 0 to 1023 should be
transformed with that LUT.

Processing
chain
in
Livegrade

To be able to compute color manipulations in a defined code value range, Livegrade converts incoming signals so that code values 0 to 1023 are used
(see Figure 1). So the processing chain of Livegrade simulates a post-production pipeline for color processing. This means that Livegrade’s
CDL
mode
always
will
expect
regular,
“extended-range”
lookup
tables
(3D
LUTs).

Please note that the order of CDL and LUT can be changed. Please see KB 435 for more information about the CDL grading mode.

Figure 1: Color processing in Livegrade

The device doesn’t know what kind of signal is coming in (legal or extended), so Livegrade takes care about this and converts the signals accordingly as
part of the color processing – depending on what is set in the device manager. So as long as you properly specify  in the device manager which kind of
signal you’re feeding in, the look (e.g. CDL and and imported LUT) will always be applied correctly. See KB 238 and KB 216 for more information about
the device manager.

Another example shows a situation, where the input signal is an extended range SDI signal, Livegrade (as always does the color manipulations in RGB
(“full range”) and converts the signal in a way that the device sends it out as a legal-range SDI signal (Figure 2).

Figure 2: Color processing with Extended-IN and Legal-OUT settings
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NOTE: A situation where you would use a “legal range” 3D LUT is when you want to load it directly onto the device for use with legal SDI signals. Then
the LUT will have to be suited to the signals coming in. In Livegrade only “full range” 3D LUTs are used, as in most post production tools.

 

Processing
SLog3
signals
in
Livegrade

As SLog3 signals are always full range on the SDI output, officially provided LUTs by Sony have a baked-in conversion from full range to legal range.
Therefore it is important to set LUT boxes in the device manager to “full range” input when receiving SLog3 signals via SDI-connected Sony cameras. The
output range should generally be set to “legal range,” although there may be exceptions depending on your setup.

Consequently, capture devices need to be set to decoding levels “full range” and playback devices to “legal range.”

Figure 3: Setting LUT box to “full range” input and “legal range” output in device manager

 

 

 

Color
management
with
ICC
profiles
For a color managed workflow for displaying digital images on a monitor, the color profiles of the source image data as well as the display device must be
known.

Source
images

Images sent as SDI
Signals
usually
conform
to
the
Rec.709 color space. So for example the Alexa’s output can be set to Rec.709 directly or the Livegrade
application converts the Log-C signal from an Alexa to a Rec.709 signal.

Display
devices

Reference monitors with SDI inputs usually come with their own calibration tools so that they always conform e.g. to Rec.709. When you use the HDLink
devices to transform an SDI signal to HDMI, DisplayPort or DVI, you will have a monitor attached, that is most
probably
not
calibrated
to
the
Rec.709
color space.

Color
management

For computers color management takes care about the proper transform of image data so that it is displayed properly on a certain device. So for example
on Apple’s OSX the ColorSync system transforms
the
image
before
it
sent
to
the
monitor
in
according
to
the
monitors
characteristics. This is done by
using ICC profiles to characterize image sources such as QuickTime clips as well as display devices such as monitors.

Livegrade

Livegrade can use the ICC profiles available for a certain monitor to do the same color management.

For more information on how to set up the ICC profiles in the device manager see the article DVI, HDMI and DisplayPort setup for Livegrade. In figure 1
you can see the color pipeline for ARRI Alexa that Livegrade sets up to apply it to images going through a HDLink box:

Figure
1:
Color
pipeline
for
Alexa
with
Livegrade

ICC
profiles
for
your
monitor

There are two possibilities for getting the right ICC profile for use in Livegrade. Either the ICC profile comes with the display or is downloaded from a
database of such profiles (e.g. http://www.tftcentral.co.uk/articles/icc_profiles.htm ), or you create it yourself by using a color probe and a profiling
software.

To give you an idea, here are the basic steps needed to create an ICC profile for example with the I1 Display Pro probe by X-Rite:

1. Attach the DVI/DisplayPort/HDMI monitor that you want to use with Livegrade and HDLink later to your computer.
2. Start the profiling application (e.g. the i1Profiler application that comes with the i1 Display Pro probe).
3. Attach the color probe to your monitor. The probe is a small device that measures the colors displayed by the display.
4. Perform the profiling. The profiling application will display a bunch of colors on the monitor, the probe will measure these colors and from this

information an ICC profile is created.
5. Save the resulting ICC profile for the monitor.
6. Remove the monitor from your computer and attach it to the HDLink box.
7. In Livegrades open the device manager and load the freshly created ICC profile for the attached monitor / HDLink.
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Note: If you experience banding artifacts in the image while using ICC profiles you can limit the use of ICC profiles to display curves in the preferences.
You can find more info and examples here http://kb.pomfort.com/?p=303.

Conclusion

The resulting color reproduction will be much closer to what you would see on a reference monitor as without the profile. Computer monitors come with
all kinds of “wide gamut” and “super contrast” panels that are far away from the way smaller color space and gamut of Rec.709. Your image will in almost
any case look way too saturated and crunchy without the ICC profile.

This can finally be corrected by using ICC profiles for HDMI/DisplayPort/DVI monitors with Livegrade.
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Browsing and Exporting
The
Shot
Library

Shots

The shot library stores all shots of the current project. Users can view, manage, and recall their shots in the shot library. 

Shots are stored in bins, and bins can be grouped in folders. You can organize folders within folders to create a project hierarchy. Selection of bins and
folders behaves recursively: Selecting a folder shows the shots of all the bins and folders in the selected folder.

The shot library with bin and folder outline

Each “shot” (e.g. each entry in the shot library) consists of 

all associated clip
metadata received from the camera and from custom-filled metadata fields,
the look
metadata with all grade settings from the slot where the shot has been created from, and
an optional media
asset, such as a framegrab or movie recording (if available from a capture device in the slot where the shot has been created
from).

All shot information is collected at the moment of creation, but can be either edited or updated at a later time if needed.

Note: You can update the clip identifier of selected shots via the “Recreate Clip Identifier” menu item. The clip identifier values are then updated based
on the current shot metadata and the active naming scheme set in the shot creation preferences.

Media assets can be framegrabs or movie recordings generated within Livegrade while creating the associated shot, or imported images, imported still
images from a movie or imported movie files.

Shots can be tagged with a color
labels and a customizable label text. The custom label text can be edited in the “General” preferences. A default label
or secondary label can be applied on shot creation. Set values for default label and secondary label in the “Library” preferences. “Create Shot” and
“Create Shot (with Secondary Label)” then apply the desired label directly on shot creation.

Shots tagged with labels

The primary actions for lists of shots are:

Export look metadata of selected shots as CDLs or lookup tables
Create shot reports as PDF from a bin or folder
Export a bin or folder to Silverstack’s automatic look matching feature.

The primary actions for single shots are:

Apply the shot’s attached look of a selected shot to the current slot
Use the shot’s attached still frame or movie clip as a reference (e.g. split screen) in the current slot
Output the shot’s attached still frame or movie clip to HD-SDI (either in the current slot or permanently in the library slot)

All actions are available through context menus (right-click) or main menu entries / keyboard shortcuts. PDF reports are now customizable, the selection
of columns in the report follows the selection of columns in the shot library.

Smart
Groups

There is an advanced “Smart Groups” view accessible from the shot library window, that displays a hierarchical structured outline of the currently
selected folder level of the shot library.

Smart groups are auto-generated based on shot metadata. You can define the hierarchy levels for the outline in a gear menu, that provides the metadata
fields “Season”, “Episode”, “Flagged”, “Label”, “Crew Unit”, “Shooting Day”, “Scene”, “Shot”, “Take”, “Camera”, “Caption”, “Location” and “Rating” to
choose from. You can also apply from predefined layouts or save custom layouts.
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Smart Groups

 

If you like to work with Smart Groups only you can hide the Shot Library Outline on the left side via

unchecking View > Show
Shot
Library
Outline
or by pressing the following button above the Shot Library:

Note: Smart groups are pre-filtered by the selected folder/bin in the shot library sidebar. When you want to view all available items in the library, make
sure to select the “Library” home folder in the shot library sidebar.

The path in the “Shots” sub-toolbar shows the current library folder and smart groups level and lets you browse and choose within the library.

Library path with smart groups level

 

Shot
Info
Panel

The right panel besides the shot library has three tabs: One for the shot info, one for look presets, and one for the history.

The Info tab shows detailed information about the currently selected shot and a preview image. You can resize the preview image by resizing the right
panel. You can also edit metadata field of the selected shot or multiple selected shots. A search bar on the top lets you filter the displayed fields and
metadata.
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Info Tab

Importing
Reference
Images
and
Reference
Movies

When building a new look it can be beneficial to import a reference image or reference movie in order to compare color, lightning and exposure with the
current grade:

Import images and movies by choosing “Import Media…” from the “File” menu and selecting one or multiple files. 
Import a still image from a movie file also by choosing “Import Sill From movie…” from the “File” menu. A pop-up window lets you playback and
scrub through the selected movie and lets you set the position of the still image.

Note: The original media file will be copied into Livegrade’s recordings folder. Depending on the file size this might take a while. Imported reference media
will show up in the shot library as soon as the copy process is done.

Search Code: LG-SL1

Exporting
Look
Metadata
Livegrade offers multiple options for exporting looks e.g. for sending to post production. For an overview of all ways to export information from the shot
library, please see the article Exporting Shot Information.

Look metadata can be exported as a 3D LUT, as an ASC-CDL file, a camera format like ALEXA Look and AMIRA Look, AMF (for ACES), or as Colorfront’s
CFE file.

Additionally there are two formats for transporting look metadata between Livegrade and Silverstack: Pomfort Looks and Pomfort Look Archives.

Exporting
a
Look
from
Livegrade

To export a look from the shot library perform the following steps:

1. Select one or multiple looks from the library:
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Figure 1: Multiple looks selected

2. Go to the Main Menu. Choose “File>Save
selected
Shots
as”
to export the selected looks (you can also use Shift+Command+S as keyboard
shortcut). You can also select
“File>Save
current
Look
as”
to only export the look that is applied in the currently selected slot.

3. In the export wizard you will then be able to select the desired format for your export:

Figure 2: Choose the desired format for the export

Not all looks can be exported to all formats, so the displayed list of available formats is dependent on the grading mode of the selected shots in the shot
library.

Available export formats:
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3D
LUTs
for
Software: includes the CDL values and the Log to Rec.709 conversion LUT when created on the CDL Grade mode. If it has been
created on the ACES mode, it has the IDT and ODT embedded in addition to the CDL values. Multiple export formats are available, which are
described below.

Pomfort Livegrade (33x33x33, RGB order, .cube file)
Pomfort Silverstack (33x33x33, RGB order, .cube file)
Adobe (32x32x32 3D LUT, .cube file)
Assimilate Scratch (32x32x32 .3dl file)
Autodesk Lustre (33x33x33 .lut file)
Colorfront OSD (17x17x17 .3dmesh file)
Convergent Design Odyssey (17x17x17 .cdlut file)
DaVinci Resolve (33x33x33 3D LUT, .dat file)
DigitalVision Nucoda (17x17x17 .cms file)
Filmlight Baselight (32x32x32 .cube file)
REDCINE X PRO (33x33x33, rgb order .cube file)

3D
LUTs
for
Devices:
includes the CDL values and the Log to Rec.709 conversion LUT when created on the CDL Grade mode. If it has been
created on the ACES mode, it has the IDT and ODT embedded in addition to the CDL values. Multiple export formats are available, which are
described below.

BlackmagicDesign HDLink Legal to Legal (17x17x17 .cube file)
BlackmagicDesign HDLink Extended to Extended (17x17x17 .cube file)
AJA Lut box (17x17x17 .cube file)
Panasonic Varicam (17x17x17, rgb order .vlt file)
Teranex Mini (33x33x33, rgb order, with float values RGB full range, .cube file)

Note: Due to lacking accuracy 17x17x17 LUTs are not recommended for color critical decisions in ACES workflows, but will still provide useful results for
on-set preview

Pomfort
Look
Exchange
Format
(*.pfl):
It creates a .pfl file that can be used to transport looks to another Livegrade or Silverstack instance. You
can learn about transporting looks from Livegrade to Silverstack in the article Transferring Looks from Livegrade to Silverstack.​
ASC-CDL: it creates a .cdl file containing the color values as specified by the ASC-CDL standard. It does not include the Log to Rec.709
conversion LUT.

If you select the according grading modes the export options will also include:

ASC-CDL
+
3D
LUT
[combo]: Advanced look export splitting CDL and non-CDL components of a grade into ASC-CDL and 3D LUT files (e.g. for
re-building a look in third party software)

Note: For looks including non-CDL nodes before a CDL node ASC-CDL + 3D LUT [combo] export is not possible. When importing the files into third-party
applications, make sure to re-build the order of nodes like in the original look for consistent results.

ALEXA
Look: a .xml file that can be loaded on ARRI ALEXA cameras or used in post production tools. It includes the standard LogC to Rec.709
conversion LUT and the color values used on the ALEXA Look mode.
AMIRA
Look: an .aml look is created, which can be loaded on ARRI AMIRA cameras. It can be saved from grade created on the CDL Grade mode.
It includes the cdl values and a neutral LUT. A custom LUT is included instead if a different one than the AMIRA LUT is used or the 1d LUT filter is
modified.
ACES
Metadata
File
(AMF): An XML-based format specified by ACES for interchanging the entire  setup of an ACES pipeline, including IDT, and
ODT, ACES version information for all transforms, ASC-CDL values and the working color space for the ASC-CDL.
ACES
Metadata
File
(AMF)
+
CLF: Look exchange format compatible with advanced ACES pipelines including LMTs, can be exported from the
ACES CDL Advanced mode and allows round-tripping with third-party applications

Note: Non-CDL compliant grading nodes are passed on as an LMT in the Common LUT Format (.clf)

CFE: it creates a .cfe file containing all parameters of the “Colorfront Film” grading mode, including e.g. input and output color spaces, looks,
and scene referred parameters.

4. Choose your desired destination on your hard-drive and hit “Save”. For more information about using naming schemes, please take a look at the article
Using automatic naming schemes when exporting grades.

5. You can also export the still images associated with a certain look. Simply mark the check box on the export dialogue:

Figure 3: still image export

 

Export
a
LUT
Package
of
the
Selected
Look

With this option, you can export a look to every available 3D LUT format. Just select the grades you have to export and then click on File>Export a LUT
package of the selected Grade. Finally choose the save destination and a naming scheme (more information on Using automatic naming schemes when
exporting grades). Livegrade will create a folder with all the LUT formats of that grade.

Custom
grading
modes
limitations

Looks stored in some grading modes have limitations regarding the available export formats. For a detailed list see Grading Modes.
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Exporting
a
Look
Archive
from
Livegrade

A Look Archive can contain one or multiple looks along with all the further metadata acquired in Livegrade.

Look archives can be exported from the whole library (“Library” folder), folders, bins or smart groups. You can export your selected folder, bin or smart
group by right-clicking on it and choosing “Export Look Archive” from the context menu.

Figure 4: Export PFLA from smart group

Save the resulting .pfla (Pomfort Look Archive) file to the desired destination.

Note: You can also choose to save your hi-res frame grabs, movie recordings or imported reference media together with the PFLA in order to share your
work with other units or transfer your project to another machine. See the article Sharing look archives with media for more info.

Importing
a
Look
Archive
into
Livegrade

To import a Look Archive into Livegrade go to the Main Menu. Choose “File
>
Import
Look
Archive”
and select the desired look archive from the Finder.
The look archive will be imported as a folder in the Livegrade look library.

You can learn how to handle look archives with Silverstack from the article Transferring Looks from Livegrade to Silverstack.

Sharing
look
archives
with
media
You can export and import a Pomfort look archive (.pfla), including references to a media folder. When exporting a PFLA, you can choose to leave the
associated media files in their original location or copy the media files to another location (e.g., to an external hard drive).

Each Livegrade media folder contains a JSON file with an UUID for unambiguous referencing of media assets in Livegrade projects. As exported PFLAs
also hold the media folder UUID, Livegrade can pick up the correct media folder and import the shots from a PFLA and link them to the correct media
asset. This way, you can share PFLAs with project media flexibly across multiple machines and teams. Learn more about Media Folders.

PFLA
Export

Depending on the used export option, your referenced media folder can either be:

the same media folder used in the original project (or an exact copy of the folder),
or a new media folder exported together with the PFLA.

Export
options:

“Media
References:
Current
media
folder” exports the PFLA using the existing media folder references.
“Media
References:
New
media
folder
with
copies
of
all
media” copies all associated media files into a new media folder that is saved together
with a PFLA using the references to the new media folder.
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PFLA
Import

You can now import the PFLA, including media, to another machine or into another project on the same machine.

Depending on the used import option, you can import the referenced media:

by copying the media files into your project’s current record folder,

by adding the referenced media folder as new media folder to your project’s recording preferences,

or you can just import looks with thumbnails without the hires media references (with offline media).

Import
options:

“Media:
Copy
media
to
record
folder” imports the PFLA and copies the referenced media files to the current record folder. For PFLAs exported
using the option “Media References: Current media folder”: You need to select the referenced media folder during the import process.

“Media:
Add
directories
with
media
as
new
media
folders” imports the PFLA with media directly by automatically adding the associated
media folder as a new media folder to the project’s recording preferences.  For PFLAs exported using the option “Media References: Current
media folder”: Either add the referenced media folder to your project’s recording preferences manually before the import, or you need to select
the referenced media folder during the import process.

“Media:
Import
looks
only
(without
media)” imports only the looks of the PFLA with thumbnails but without references to the original hires media
files.

Using
Automatic
Naming
Schemes
Different metadata information can be added to each grade through the Grade Library panel. Adding this information can be helpful to identify your
grades and to automatically match them to clips using Assimilate Scratch.
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When these grades have to be exported, Livegrade offers the possibility to name them using a combination of the metadata fields. This way, grades can
be easily identified along the post workflow. The naming schemes are also available when saving grades or exporting the LUT package. You can learn
about the general export process from the article Exporting Grades.

In order to export a look, go to “File
>
Save
selected
Looks
as…”:

Figure 1: Exporting a look

A dialogue will open showing the destination options, format options and Naming Scheme:

Some wildcard presets are shown (figure 2), but you can create a custom file naming scheme by clicking on “Custom” in the drop down menu. After
clicking on the appearing button “Customize…” , the naming scheme editor window will appear:
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Figure 4: Naming scheme editor

 

Here you can edit the naming scheme by replacing the original wildcards with the available ones. Simply drag and drop them on the «Name» box to
create the custom name. However, have in mind that Livegrade can only use information already added to the grades, otherwise a placeholder will be
written in its place. You can see if a grade has a certain information in the «Availability» column.

Note: wildcards are usually separated by an underscore sign «_». In addition, a forward slash «/» can be used to create a folder structure. Here you can
see an example:

 

figure 5: result of using an underscore sign

 

figure 6: result of using a slash sign

Creating
Look
Reports
Look reports can be exported as a PDF document containing the thumbnails and the metadata of each library item –look, still or clip–. This feature can be
very useful to communicate the different grades of a shooting day for example.

In order to create a clip report, select a folder from the library and click on File > Export Folder Report (PDF):

figure 1: exporting a PDF Look report

95

Livegrade Studio 
Browsing and Exporting



Customizing
the
Look
report

The contents of the Look report are based on the metadata columns shown in the Library. You can set which columns are shown by clicking on the «gear»
icon on the top right of the Library.

figure 2: customizing the information on the Looks report

 

3D
LUT
export
for
Odyssey
7Q+

Livegrade lets users export their grades to be used on the Odyssey 7Q+ recorder from Convergent Design. The grades can be loaded into the Odyssey
7Q+ device in order to be applied to the live HD-SDI signal on the built-in monitor.

You can use Livegrade’s broad range of grading features to create and export LUTs in Convergent Design’s .cdlut format. It is possible to get the
same look on the field recorder display as in Livegrade and in post production tools (e.g. for dailies creation or color grading) – offering valuable technical
as well as creative real-time feedback for DPs and DITs.

 

Exporting
the
grades
to
Odyssey
7Q+
devices

Once the grade has been created, it has to be selected from the library and then it can be exported as a 3D LUT.

 

A 3D LUT format selection wizard appears. The «Convergent Design Odyssey» format has to be selected:
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After the .cdlut17 3D LUT file has been saved on the desired destination, it is ready to be used. For more information on how to export grades, please
check the article Exporting Grades.

 

Loading
the
grade
into
the
Odyssey
7Q+
device

Once the 3D LUT has been exported, it has to be loaded into the Odyssey 7Q+ SSD drive. You can use Finder to place the .cdlut17 file into the specific
folder on the SSD drive to help the Odyssey 7Q+ locate the grade.

Note: The
.cdlut
file
file
has
to
be
placed
into
the
LUT
folder
in
the
root
directory
of
the
SSD
which
has
to
be
named
“}CD_LUTS{”
.
If
it
does
not
already
exist
you
have
to
create
it.

After the grade has been copied into the SSD, you can attach it to the Odyssey 7Q+ device. If the SSD is correctly mounted you can see the LUTs load in
the lower left corner of the home display.

To open the “LUT-Menu” perform a long tap on “LUT” in the home display:

Step 1: open the LUT menu

 

Then tap on «Import from SSD» and select all the LUTs that you would like to load:
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Step 2: import the LUT files

 

Confirm the operation:

step 3: confirm the operation

 

Finally the imported grades should be available on the LUT selection menu:

step 4: select the LUT to be applied.
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At this point you should be able to apply the LUTs imported previously to the current SDI signal. To select a specific LUT just tap on it in the menu and it
will turn green. After closing the LUT menu you will be able to enable or disable the LUT by performing a short tap on “LUT” in the home display.

 

 

Export
LUTs
for
the
AJA
LUT-box
Due to the design of the AJA LUT-box Livegrade is not able to use it for real time color grading. However a 3D LUT can be created with Livegrade and
exported and uploaded onto the AJA LUT-box.

In order to be able to upload a LUT into the AJA LUT-box, you have to export it from Livegrade into a specific format. To do so select it form the Grade
Library and go to File > Save selected Looks as:

 

figure 1: exporting a 3D LUT

 

Then on Look format, you have to select «AJA LUT Box» on the drop down menu:

 

figure 2: LUT format selection

 

Once the format has been selected, the LUT export wizard will display the format specifications. Now you only have to save the grade to the specified
location.

 

figure 3: AJA LUT Box format

 

Finally, the LUT has to be uploaded into the AJA LUT-box device using the MiniConfig software downloaded along with the hardware drivers.
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figure 4: MiniConfig software UI

 

To upload a LUT the user needs to select “3D-Lut” from the main menu and the choose the slot he wants the LUT to be written on:

 

 

figure 5: Mini Config menu

 

Then an open dialog is shown where the LUT that has been exported from Livegrade has to be selected.
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Advanced Hardware Setup Options
Setting
up
HD-SDI
Video
Capture
Devices
Livegrade supports the capturing of live HD-SDI signals for reference and display purposes. Therefore a supported HD-SDI video capture device is
required. See the “Capture Devices” section of the article All supported devices for more information on supported devices.

The various HD-SDI setup options with Livegrade are described in the article HD-SDI Setup Options.

Capturing video signals with a capture device with Livegrade

 

For a list of compatible devices for HD-SDI output in LiveGrade Pro 3 and 4 please see the article Image View Output to HD-SDI in LiveGrade Pro.

Setting
up
a
video
capture
device

You can add a capture device to a slot by choosing “Add Capture Device…” in the “Add Device” submenu of the “Slots” menu, or in the device manager.

Configuring and adding a capture device

Choose one of the connected capture devices in the table on the left.

You can then choose from the following options:

Video
Format: Some capture devices allow to select a video format. Choose the appropriate video format for the captured signal.
Camera
Type: If not chosen automatically, choose the camera type here. This enables metadata capture from ANC for that camera type.
Decoding
Levels: Choose the video levels that shall be used for decoding the signal (ARRI cameras for example usually are decoded “Legal
Range”, while Sony cameras might be captured “Full Range”).
YCbCr-RGB
Conversion: Choose the appropriate color conversion matrix (Rec.709/Rec.2020) for your incoming video signal. This parameter will
also be passed on into the metadata of your recorded movies.
Capture
Source: Tell the application if the incoming signal is the “log” output of the camera (which is recommended), or if the signal is pre-graded
(e.g. when capturing the output of a LUT box controlled by the application). This setting avoids “double LUTting” in the case when you need to
capture a pre-graded signal.
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Auto
Record: Enable / disable and choose the method for detecting the record state of the camera for auto-record functionality.
Note that the appropriate “Record Trigger” method depends on your setup and camera:

All SDI connected cameras support “RecRun Timecode”
“Vertical ANC Record Flag” is only supported by older Arri Alexa camera models
Choose “Horizontal ANC Record Flag” for supported AJA capture devices (Kona 4 or newer and IO 4K series) when using ARRI, RED and
Sony cameras

Click “Add” to add the capture device to the slot.

The capture device appears as a new row in the device manager. You can enable and disable auto-record functionality for that capture device from the
capture device row with the button “Auto Record”.

When the device is added to the slot and configured properly, you can watch the live video signal on your computer monitor. The live image can be
shown

in the thumbnail view the slot (updated about every second), or
in the applications image viewer.

How to use the image viewer to compare different image sources is explained in the article Image viewer.

Capturing
media
assets
with
shots

Once the setup is complete, it is possible to record clips or grab frames for storing them in the shot library. Both recordings and frame grabs are saved as
captured (e.g. “log”), but the currently applied look is also saved with the shot in the shot library. This way the look will be applied during playback of the
clips and frame grabs.

See the article Collect Shot, Clip, Still, and Look Information for more information about storing captured media assets in the shot library.

Taking
frame
grabs

Frame grabs can be taken in two ways:

Click the refresh button in the slot UI or in the image viewer to manually create a new frame grab
Create a new shot entry in the shot library. When the option “Refresh frame grab….” in the General section of the Preferences is set, a new frame
grab will be taken.

Recording
clips

To start a recording for a single slot, click the record button the slot UI. To start a recording for multiple slots, click the «Record» button in the toolbar, or
choose “Start Recording” from the main menu.

You can enable and disable recording for a slot by clicking the arrow button besides the record button in the slot UI. When set, the slot is “armed” for
multi-slot recording.

The default destination for storing recorded clips is ~/Movies/LiveGrade Recordings in the user’s home directory. This folder can be configured in the
Preferences>Recording settings.

During recording the slot UI will indicate that the recording is running:

Recording indicators in the slot UI

The header bar of the slot will be marked red, and the record button will also become red. The image preview will show a record indicator with the current
length of the recording.

Updating
frame
grabs

To update the framegrab and a selected shot entry in the shot library choose

“Replace Image of Selected Shot” in the “Library” menu in order to only replace the image
“Update Selected Shot and Replace Image”  in the “Library” menu in order to only replace the image

Please be aware that frame grabs from pre-graded image source cannot be updated when the look of the shot is updated.

Image
View
Output
to
HD-SDI
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Livegrade comes with HD-SDI output to mirror the Image Viewer to HD-SDI via supported third party devices. The current Image Source in the Image
Viewer is mirrored to the HD-SDI output showing the image in full-screen and 10 bit color depth.

The various HD-SDI setup options with Livegrade are described in the article HD-SDI Setup Options.

Video output to HD-SDI

Supported
Devices
for
Playout
to
HD-SDI

To enable the HD-SDI output you need one of the following devices:

AJA Io Series (e.g. AJA Io XT or IO 4K Plus)
AJA KONA Cards (e.g. KONA 5G)
Blackmagic Design UltraStudio Series (e.g. Ultrastudio HD Mini, Ultrastudio 4K or Ultrastudio Mini Monitor)
Blackmagic Design DeckLink Cards (e.g. DeckLink Duo 2)
AJA T-TAP

For a list of supported capture devices in Livegrade 3 and 4 please see the article SDI Signal Recording and Framegrabs.

Schematic
Overview:
How
to
Connect

Attach the according interface to your Mac (Thunderbolt or PCIe) and connect the HD-SDI output of the device to the selected destination.

Figure 1: Schematic presentation of a Livegrade setup with HD-SDI output

Please
be
aware that the Ultrastudio Express can only be used either as an input or as an output to or from Livegrade. It can not be used as in- and
output at the same time. This is due to hardware limitations of the product. The output will show the loop through of the signal that is not equal to an
output out of Livegrade that mirrors the Image Viewer and can contain looks or a reference image.

Trouble
Shooting
–
AJA
Devices

In case your AJA video output device does not respond to the video preferences set in Livegrade, try following these steps to rest the device:

1. Quit Livegrade
2. Open AJA Control Panel
3. Go to presets and press Reset Device
4. Open Livegrade again

Drivers

In order to use the supported devices you have to install all drivers and necessary software provided by the the manufacturer.

For Blackmagic Design devices that is the “Desktop
Video” software you can download in their support area.

For AJA Devices that are the “AJA
hardware
drivers” included in the latest “AJA
software
installers” also available in their support area.
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External
Video
Preferences

To enable the HD-SDI device in the preferences. Go to “Preferences>Video”. Choose the intended device from the dropdown.

You can disable the use of the device from the same menu in case another application demands its use (i.e. parallel use of the hardware with other
software). If you have multiple output devices attached, you can select which one to use by choosing it in the drop down menu:

Figure 2: Livegrade Video preferences

 

Additionally you can choose to release the device when Livegrade is in background. By default it will be kept even if Livegrade is in background.

Mirroring
the
Image
Viewer
Including
References

The HD-SDI output will display the Image in the Image Viewer. The
Image
Viewer
has
to
be
opened
in
order
to
send
an
image
to
the
HD-SDI
output.


You can set a reference for the current Image Source to attain a split screen to compare two looks or stills. The reference will also be visible on your
external HD-SDI reference monitor.

Fig. 3: Livegrade Image Viewer with a reference image set in split screen.

Learn more about the Image Viewer and References from the article Image Viewer
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HD-SDI
Features
and
Quality
Characteristics

Color
Reproduction HD video matrix and gamma (ITU-R BT.709; ITU-R BT.1886)

Timing Sync to closest matching video frame rates

Code
Values 10-bit legal range YCbCr output (internal 16-bit RGB processing)

Embedded
Audio Not supported

Metadata
Output Not supported

Grouping
Slots
Into
Stages
Livegrade Studio lets you group slots into stages for handling independent scenes (e.g., from multiple units) within one project.

You can configure stages in the device manager. You can set a custom name for your stages, e.g., “Main Unit” and “Splinter Unit”. Slots are
automatically assigned to the first configured stage. You can change the assignment individually for each slot in the device manager. 

Configuring stages within the device manager

The selection of the current stage follows the slot selection. When selecting a slot, all slots from the associated stage are highlighted in a lighter grey color
in the slot UI. Slots from other stages are displayed in the darker grey background color.

Slots with stage “Main Unit” selected

Slots with stage “Splinter Unit” selected

With stages configured,

the global metadata panel shows the metadata of the current stage,
you can edit a stage’s metadata panel independently from other stages,
“all slots” menu items and actions for shot creation, still image export and recording transform into “all slots of current stage” equivalents so that
only slots of the current stage are affected.

The stage attribute is included in the shot metadata and can be used in the shots table, the info tab and the smart groups for filtering, searching and
exporting purposes.

Frame
Callback
on
FSI
BoxIO
devices
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Display
Still
as
Frame
Callback:

Livegrade supports Flanders Scientific’s “Frame Callback” functionality, built into FSI BoxIO LUT boxes.

You can display a shot’s graded still image (or thumbnail frame from a recorded movie) on any connected BoxIO device via the library menu or the
contextual menu of a selected shot in the shots table.

Display Still as Frame Callback on

The BoxIO icon in the slot UI shows an “/FC” icon as overlay indicating the active frame callback status. You can toggle the frame callback on/off to
compare a still with your live image in the contextual menu when right-clicking on the BoxIO icon. 

Slot UI with enabled Frame Callback

 

Grade
Still
as
Frame
Callback:

For advanced workflows, you can enable “Grade Still as Frame Callback” in the devices preferences. This option adds additional “Grade Still as Frame
Callback on” menu items allowing you to apply, re-grade, and update looks from shots via the frame callback mechanism.
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“Grade Still as Frame Callback” displays a shot’s graded still image (or thumbnail frame from a recorded movie) on a connected BoxIO device and applies
the look to its slot. You can then edit the look and update the shot using the “Update” button in the toolbar or the associated menu items and controller
actions.

Note: If you choose to apply a look of a shot via frame callback, the current look in the slot will be overwritten and not be restored after disabling frame
callback again.

Controlling
an
External
Video
Router
Video routers often sit at the core of a flexible video setup in a DIT cart. Video routers have multiple input and output ports and allow to easily switch the
connections between these ports. Livegrade comes with the ability to control a video router and to apply pre-defined configurations of connections –
either manually or on certain events such as switching slots in the application’s user interface.

The various HD-SDI setup options with Livegrade are described in the article HD-SDI Setup Options.

Video routing with cameras, monitors, LUT boxes, capture devices and video output devices

 

Livegrade Studio has an additional, dedicated view for directly controlling a video router and monitor routings visually. See Interactive Router
Control for detailed information.

You need to have a working network connection between the computer running Livegrade and the video router. For setting up the network, please refer to
the manual of your video router.

Managing
Video
Routing
Configurations

From the main menu, you open the Video Routing Configurations window by choosing “Video Routings -> Manage Configurations…”  from the
application menu.
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Video Routing Configurations panel

The Video Routing Configurations window shows a list of your configured configurations, and options to edit, duplicate, and delete a selected
configuration. You can also test the selected configuration by clicking the “Apply Configuration…” button.

You can rename a configuration by double-clicking the entry in the list.

The configurations have an automatically assigned index number for easier referencing (e.g. when using Stream Deck devices for remotely applying
configurations).

You can change the order of the configurations by dragging and dropping a configuration entry in the “Manage Configurations” window.

Creating
a
new
video
routing
configuration

By clicking the “New Configuration…” or choosing  “Video Routings -> New Configuration…”  from the application menu, you open the dialog for creating
a new video routing configuration.

In order to be able to create connections between in and out ports of your router, you need to connect to the router first. This is needed, so that the
application can fetch a list of ports and their names from the router.

Choose an auto-detected router in the “Router” popup button, or choose the router model family you have (AJA Kumo or Blackmagic Design Smart
VideoHub) and enter the IP address or hostname of your router. Click the “Fetch IN/OUT Information” button. If the router’s information has been fetched
successfully, the controls below the connection table get enabled and you can start create new connections.

108

Livegrade Studio 
Advanced Hardware Setup Options



Editing a video routing configuration

Click the “+” button to create a new connection and “-“ to remove the selected connection.

When clicking the “+” button below the connection table, you can choose which input (IN) port should be connected to which output (OUT) port. Choose
the ports according to your setup and click “Add”. You can edit the connection at any time by double-clicking the connection.

Only connections of shown OUTs will be changed when the routing configuration is applied. All other output ports of your router will remain unchanged
when applying this configuration.

You can test your current configuration by clicking the “Apply Configuration” button. The configuration will become active in the connected video router.

You can sort the connection table by IN our OUT ports, and you can choose if the selected column is sorted by name or port number with the “Sort
Criteria” controls below the table.

When clicking “Load All Connections…” you can fill the connection table with the current, complete routing configuration of your video router. This can
be useful as a starting point for complex routing configurations with lots of connections.

When clicking “Save…”, you will be prompted a name for the video routing configuration, and the configuration appears in the list of configurations in the
Video Routing Configurations window.

Applying
video
routing
configurations
via
the
menu
and
keyboard
shortcuts

Once a video routing configuration is saved, it will also appear in the “Video Routings” submenu of the application menu. When choosing one of the
stored configurations in the menu, the configuration gets applied to the connected router.

You can assign keyboard shortcuts to the menu entries for individual video routing configurations with the Keyboard Shortcuts Manager. This allows you
to easily switch between video routing configurations with keyboard shortcuts.

See the article about the Keyboard Shortcuts Manager for more information.

Applying
video
routing
configurations
from
Stream
Deck

You can also apply up to 20 video routing configurations from Stream Deck devices using the Stream Deck plugin.

Additionally you can edit your video routing remotely using Stream Deck, by selecting up to 20 video inputs and video outputs on your active video
router.

Automating
video
routing
configurations

You can automate video routing configurations by using them as actions in the Automation Manager. This allows you to for example change the routing
configuration when switching slots.

With the automation actions, you can also move a configured capture device from one slot to another. When the routing automation routes the right signal
into the capture device, you can use one capture device for multiple cameras – e.g. for monitoring live image and camera metadata in the current slot.
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See the article about the Automation Manager for more information.

Interactive
Router
Control
In addition to defining routing presets (see Controlling an External Video Router for more information) Livegrade Studio has a dedicated view for directly
controlling a video router and monitor routings visually. 

The video router view displays all inputs and outputs of a connected video router, and lets you interactively change routings.

Show
and
Hide
the
Video
Router
View

You can show and hide the video router view with the “Router” button in the toolbar. You can also “undock” the video router view from the main window
by clicking the window button on the right top of the header bar of the video router view.

Connecting
to
a
Video
Router

Choose an auto-detected router in the “Router” popup button, or choose the router model family you have (AJA Kumo or Blackmagic Design Smart
VideoHub), enter the IP address or hostname of your router and click the connection button besides the field for the IP address. You can disconnect the
video router at any time by clicking the connection button again.

Managing
Connections


The Video Router view displays all connections between input ports and output ports currently active in the connected video router.

Usually an input port can be connected to multiple output ports, but an output port can only be connected to one input port. Connections between ports
are displayed as colored lines.

Input ports are displayed on the top of the view (on the left in vertical layout), output ports are displayed on the bottom of the view (on the right in vertical
layout). The ports display the port number in the router (the circled number), and one or two rows of the name of the port.

Names of ports can be configured in the administration interface of your video router. Please refer to the manual of your router how to do that.

When connections change (either from within the application or from outside, e.g. by using a hardware control panel or the web UI), the changing
connections flash in white to indicate the change.

Changing
Connections
via
Selecting
Ports

You can select a port by clicking on it. The port and it’s current connections get highlighted. You then can click on one of the ports of the other port type
to change a connection:

For example when an input port is selected first and an output port is selected second, the output port changes its connection to the selected input port.
You can achieve the same effect by selecting an output port first and selecting the input port second.

Changing video routing connections by clicking on ports

You can select ports also from the utility menu in the wedge button in the header bar of the Video Routing view, or from the main menu by choosing one
of the entries in the “Interactive Video Routing” submenu of the “Video Routing” menu in the application menu.

You can assign keyboard shortcuts to the selection of ports with the Keyboard Shortcuts manager.

You can assign MIDI events to the selection of ports with the MIDI mapper.

You can also right-click on each port button to inspect and change the connected port(s).

Changing
Connections
via
Drag-and-Drop

Each port has a small colored circle besides it. You can drag a line from this circle to the port that you want to make  connection with.

Video Routing Configurations

You can setup video routing configurations as shortcuts to changes of one or more connections. See Controlling an External Video Router for more
information.

Configured video routing configurations show up as menu items in the in the wedge button in the header bar of the Video Routing view.

You can also use the current state of the video router with all its connections as a starting point for a new configuration. Choose “Save Current
Connections…” in the menu of the wedge button in the header bar of the Video Routing view.

Configuring
the
Video
Routing
Interaction

You can view connections either in horizontal layout or vertical layout. Choose “View in Vertical Layout” or “View in Horizontal Layout” menu items in the
in the wedge button in the header bar of the Video Routing view to change the layout.

You can set the color of the connection lines in the Preferences.  Choose a color scheme in the “Interactive Video Routing Appearance” section of the
“Advanced” preferences tab.
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ZEISS
CP.3
XD
Lens
Correction
Livegrade is able to receive realtime lens correction information from a ZEISS CP.3 XD lens that is connected to an Ambient MasterLockit Plus.

Please learn more about the general workflow concerning the ZEISS CP.3 XD lenses in the article ZEISS CP.3 XD Lens Correction: Workflow Overview.

Prerequisites:

MasterLockit Plus is connected to the lens and camera correctly
MasterLockit Plus is connected via WIFI or Ethernet to the Mac
Lens is connected and recognized by the MasterLockit Plus.

Adding
the
MasterLockit
Plus
as
a
Device

The MasterLockit Plus has to be added to Livegrade as a device in the Device Manager to receive live lens correction data from the ZEISS CP.3 XD lens.

To add the MasterLockit Plus as a Device go to the main menu and select “Device
>
Add
Device..
>
Add
Lockit…”:

Fig. 1: Add the MasterLockit Plus as a device in Livegrade

 

After successfully adding the MasterLockitPlus it is shown in the device manager as a device in a slot. You can open the device manager with the
“Devices…” button on the left side of the Livegrade user interface above the slot section:

Fig. 2: The device manager with the added MasterLockit Plus

Adding
a
Capture
Device
As
Image
Input
for
the
Lens
Correction

The lens correction preview will be performed on the image viewer in Livegrade. Livegrade is capable of capturing camera signals through third party
devices. Please learn more about capturing SDI signals in Livegrade in the article SDI Signal Recording and Framegrabs.

To add a capture device to Livegrade click “Add
Device…” and choose “Add
Capture
Device…”:

Fig. 3: Adding the capture device to receive a live image in Livegrade

After a successfully adding the Ambient MasterLockit Plus and the capture device the device manager should look like this:
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Fig.4: The device manager with an active MasterLockitPlus and a capture device

The
Lens
Correction
Controls

Now open the ZEISS lens correction controls from the “Window” menu by selecting “Lens
Correction
Controls…”:

Fig.5: Open the Lens Correction Controls

The lens correction control window opens:

Fig. 6: The lens correction controls window

From top to bottom it contains the following elements:

Shading
Correction: The checkbox enables/disables the shading correction applied in the image viewer
Distortion
Correction: The checkbox enables/disables the distortion correction applied in the image viewer

Distortion
Zoom: Sets the zoom level to balance possible visible image borders when applying the distortion correction
Sensor
Information: Depending on the recording camera and format the active sensor width differs. The active sensor width in mm is necessary to
correctly calculate the lens correction. Please take a look at the detailed camera specs to learn more about the sensor width for your specific
recording format.
Lens
Communication: This section displays the live information that is coming from the lens including TC, Focus, Aperture and detailed shading
and distortion information

Here’s how a completed setup including image viewer with live image, lens correction controls window and the device manager looks like:
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Fig. 6: Image viewer, lens correction controls and device manager in a completed setup

Shading and distortion correction can independently be enabled or disabled to be applied on the image in the image viewer.
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Setting up Control Devices
Setting
Up
Tangent
Grading
Panels

Livegrade supports the hardware grading panels
Tangent
Wave, Tangent
Element and Tangent
Ripple. This article describes the use with the  Tangent
Element
series and the Tangent
Wave in detail. For the use with Tangent
Ripple please refer to the section about the Element Tk control panel that
works similar to the Ripple.

Sections in this article:

Connecting Your Tangent Grading Panel
Preferences For Your Tangent Grading Panel
Tangent Element (Element Tk, Element Mf, Element Kb, Element Bt)
Tangent Wave / Wave2

 

CONNECTING
YOUR
TANGENT
GRADING
PANEL

Please follow these steps to get Livegrade up and running with your Tangent panel:

1. Connect the Tangent panel to your Mac.
2. If you did not installed your Tangent Device Driver yet, then this would be a good moment. You can find on Tangent Support website.
3. Start Livegrade.
4. Wait until the panel is recognized, indicated by a blue glow at the lower left of the main window.
5. You are ready to grade!

 

PREFERENCES
FOR
YOUR
TANGENT
GRADING
PANEL

1. Choose “Preferences…” from the “Livegrade” Menu Bar or use the keyboard shortcut “⌘+,”

2. You can customize the level of sensitivity for your panel in the grading preferences under “Hardware Panels” > “Sensitivity”.




figure
1:
Grading preferences

 

 

 

Tangent
Element

Livegrade allows you to connect hardware grading panels, including the Tangent Element, to precisely and physically manipulate your grades. The
Tangent Element offers a variety of controls, ranging from Color Balls, Color Wheels, Command Keys to Precision Knobs. The controls utilized by
Livegrade are depicted below.

The
“Element
Tk”
control
panel
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figure
2:
“Tangent
Element
Tk”

 

1. The Page
Button allows you to cycle through different configurations of the Color Wheels. Depending on the grading mode and active the page, the
wheels/balls control different aspects of your grade.

2. The Status
Display
shows which values can be manipulated using the respective controls.
3. The Color
Balls
manipulate the Hue and Saturation values of their respective color ranges.
4. The Color
Wheels manipulate the Level value of their respective color range.
5. The Ball/Wheel
Reset buttons reset the values of the Ball/Wheel right next to it.
6. The
Node
Button
«A» lets you switch the panel between the CDL nodes if there are multiple, i.e. in the Freestyle grading mode.

Additionally, Livegrade lets you map different actions for the Element Tk panel using the Tangent Mapper.

 


The
“Element
Mf”
control
panel

 

figure
3:
“Tangent
Element
Mf”

1. The Status
Display
shows which values can be manipulated using the respective controls.
2. The first row Command
Keys
perform the following commands from left to right:

1. New Grade, Update Grade and Apply Selected Grade.
2. New
Grade: Adds a new grade in your Livegrade Grade Library
3. Update
Grade: Updates your current adjustments to the selected grade in your library
4. Apply
Selected
Grade:

Apply the selection from your Grade Library to your actual grade.

3. The second  row Command
Keys
perform the following commands from left to right:
1. Bypass Color, Show Original Signal and Enable False Color.

4. The third row Command
Keys
perform the following commands from left to right:
1. Set To Neutral, Next Device, Previous Device
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The
“Element
Kb”
control
panel

figure
4
:
”
Example
Tangent
Kb
in
CDL
Mode”




 

1. The Precision
Knobs
each (depending on the grading mode) manipulate one specific aspect of your grade, such as ‘Saturation’, ‘Shadows (RGB
channels)’, ‘Midtones’, Highlights or in Alexa Mode also the ‘Printer Lights’.

2. The Page
Buttons allow you to cycle through different configurations of the Precision Knobs. Depending on the Grading Mode, the knobs control
different aspects of your grade.

3. The Status
Display
shows the meaning and value of multiple controls. It is split into three rows and three columns. Depending on grading mode the
first line is either empty(Alexa Grading Mode) or setup with Saturation. Saturation is on the first page in both grading modes, only one knob is
assigned to saturation. The second line displays the meaning and value of the respective Precision Knob above, such as ‘Shad R’ for ‘Shawdows
Red’  or ‘Mid R’, standing for ‘Midtones Red’ and so on.

 

The
“Element
Bt”
control
panel

figure
5:
“Tangent
Element
Bt”

The Tangent “Element Bt” panel got the same functionality like the “Element Mf”.

 Additionally, you can use the software Tangent Mapper to assign different actions to the buttons on your Tangent panel. These are the actions that can
be mapped:

Apply Look
Select Look 1 – 6*
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Node Selection
Select CDL Node 1-2
Select previous node
Select next node

Temperature
Increase Temperature
Decrease Temperature

Tint
Increase Tint
Decrease Tint

SlotSelection
Select Slot 1-6*

*1-6 means that there are 6 actions the first one applies the first and so on.

 

TANGENT
WAVE
/
WAVE2

Livegrade allows you to connect hardware grading panels, including the Tangent Wave and the Tangent Wave 2, to precisely and physically manipulate
your grades. Tangent Wave panels offer a variety of controls, ranging from Color Balls, Color Wheels, Command Keys to Precision Knobs. The controls
utilized by Livegrade are depicted below.  

 

figure 6: “Tangent Wave”

 

1. The Page
Buttons allow you to cycle through different configurations of the Precision Knobs. Depending on the page, the knobs control different
aspects of your grade.

2. The Precision
Knobs each manipulate one specific aspect of your grade, such as Offset, Power, Slope for Red, Green and Blue or alternatively
(holding ALT button): Saturation, Contrast, Stretch, Warmer and Greener.

3. The Status
Display
shows which values can be manipulated using the respective controls.
4. The Command
Keys perform the following commands from left to right:

Standard:
New Grade, Update Grade, Apply Selected Grade, Bypass Color, Show Original Signal, Enable False Color, Set To Neutral,
Previous Slot and Next Slot
Alternative
(holding
ALT
button):
Create Grade For All Slots, Replace Image of Selected Shot, Update Selected Shot and Replace Image,
Create Preset, Update Selected Preset, Apply Selected Preset, Reset Colors, Select Previous Shot, Select Next Shot

5. The Color
Balls manipulate the Hue and Saturation values of their respective color ranges.
6. The Color
Wheels manipulate the Level value of their respective color range.
7. The Ball/Wheel
Reset buttons reset the values of the Ball/Wheel right next to it.

Additionally, the panel can be individually set up to your requirements e.g. if you prefer to use the trackballs for lift, gamma, gain or if you want to store
look presets to the F1-9 buttons. You can use the software Tangent Mapper to create your individual control mapping.

 

 

Setting
up
MIDI
Controllers
MIDI controllers offer an easy possibility of mapping application features to physical buttons (besides configuring custom keyboard shortcuts).

To inspect the list of available actions and controls for mapping to MIDI controllers go to “MIDI Controller Mapping” in the application menu. This will
open the MIDI Controller Mapping window (figure 1).
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Listing
and
Searching
MIDI
Mappings

The MIDI Controller Mapping window shows a table with a list of all actions in the main menu as well as additional controls with their currently set MIDI
mappings for a certain MIDI device. 

Choose the MIDI device in the pop-up button. You will only see mapped events for that events in the table below.

You can search the list by typing into the search bar on top of the table.

Edit
MIDI
Mappings
for
Main
Menu
Actions

To set or edit a MIDI mapping for a menu item in the main menu:

1. Choose “Button” as control type.
2. Select “Map Controls” to allow changes on the key mapping list.
3. Choose the command row.
4. To set or modify a MIDI mapping press the button on your MIDI controller.

The MIDI channel and MIDI note will appear in the control row.

To remove the associated MIDI mapping press ⌫ (delete / backspace) button.

Close the MIDI Controller Mapping window when you are done.

Edit
MIDI
Mappings
for
Grade
Controls

To set or edit a MIDI mapping for a grade control:

1. Choose “Encoder” as control type.
2. Select “Map Controls” to allow changes on the key mapping list.
3. Choose the control row.
4. To set or modify a MIDI mapping turn the knob or encoder on your MIDI controller.

The MIDI channel and control number will appear in the control row.

The application supports absolute and relative / endless encoders. You can set the behavior with the checkbox “Encoders are relative”.

When using absolute encoders the application simulates relative encoders: 

In the middle position the mapped control is not changed.
As long as the encoder is right / higher than the middle position, the mapped control will be increasing.
As long as the encoder is left / lower than the middle position, the mapped control will be decreasing.
Return the encoder to the middle position to stop any changes of the mapped control.

To remove the associated MIDI mapping press ⌫ (delete / backspace) button.

Close the MIDI Controller Mapping window when you are done.

Reset
Mappings

You can remove all MIDI mappings by clicking “Clear All Mappings…”.

Setting
up
Stream
Deck
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Livegrade integrates with Elgato’s Stream Deck devices. There are pre-configured profiles for

Stream Deck Classic
Stream Deck XL
Stream Deck +

devices.

Stream Deck+ Integration in Livegrade

Installation
of
Your
Stream
Deck
Device(s)

To get started with your Stream Deck device(s),

download and install the latest Stream Deck configurations app from Elgato’s website,
attach all Stream Deck device(s) you want to use with your computer and
open Livegrade and click Livegrade
>
Install
Stream
Deck
Plugin…

Livegrade will then install

Actions for Stream Deck devices
Default
Livegrade
profiles with recommended configurations for all currently attached Stream Deck devices

Add
another
Stream
Deck
Device

If you already installed a Stream Deck device on your computer and want to use another one, attach it via USB to your computer and click Livegrade
>
Install
Stream
Deck
Plugin…
to add default Livegrade profiles for your attached Stream Deck device.

Configure
and
Manage
profiles

After you install the Livegrade plugin to Stream Deck, open the configuration app and start to configure the profiles to your personal needs. There you can
assign, move, or delete actions to the buttons and dials of your Stream Deck.

Tip: If you would like to customize the text and backgrounds of your Stream Deck key icons using the Livegrade design as a starting point, download the
Photoshop template Stream Deck Icon Creator For Livegrade.psd. The Miso font can be downloaded for free at http://www.fontspring.com/fonts/marten-
nettelbladt/miso.

Backup
your
Stream
Deck
profiles

As soon as you configured one or more profiles that fit your needs, we recommend you to backup those by

Open the Stream Deck configuration app
Click on your profile and select
Edit
Profiles…
Right
click on your profile and select Export…
Save the file to a place on your computer

Adjust
Step
Sizes
for
your
Stream
Deck
device

To change the sensitivity for your Stream Deck device open the Livegrade settings and go to the Grading tab.

There you find the Grading
Control
Step
Sizes area where you can adjust the sensitivity to your individual needs.
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Grade Control Step Sizes

Troubleshooting

“My
Stream
Deck
buttons
show
?
question
marks.”

A
re-install
of
the
Stream
Deck
plugin
most
often
helps.

Make sure that you are on the latest Livegrade version
Close Livegrade
uninstall the Livegrade plugin in the Stream Deck configurations app

De-Install Stream Deck plugin

open Livegrade and go to Livegrade
>
Install
Stream
Deck
Plugin…

“My
buttons
are
gone,
the
actions
suddenly
disappeared.”

Most
commonly
you
just
switched
to
an
empty
profile.

When installing the Stream Deck configuration app, there will be added an empty “Default Profile” by default. If you just added Livegrade profiles through
the Livegrade plugin installation process, you might run into a situation where you switch from one of the Livegrade profiles to the empty default profile
unintentionally. It seems like all actions suddenly were gone, but in fact, you just switched to an empty profile.

We recommend deleting the empty default profile as soon as you have installed your Livegrade profiles.

Open the Stream Deck configuration app
Click on your profile and select Edit
Profiles…
Select the empty Default
profile (NOT the Default Profile Livegrade) and click the –
button
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Stream Deck+ profiles for Livegrade

 

Migrate
Stream
Deck
Profiles
from
Livegrade
Pro
to
Studio
There are two options to migrate your profiles from Pro to Studio:

Automatically
Manually

 

Automatically
Migrate
Pro
to
Studio
Profiles

Download and install the latest Stream Deck configurations app from Elgato’s website
Attach all Stream Deck device(s) you want to use with your computer
Go to Livegrade
Studio
>
Install
Stream
Deck
plugin…
Click
Migrate
Now

Livegrade will then

Install actions for Stream Deck devices
Duplicate your old Pro Stream Deck profiles that can now be used with Livegrade Studio
Create a new Default Profile for Livegrade Studio

To continue

Click Restart
Stream
Deck
Confirm in the two following Stream Deck’s dialogues to install the default profiles

When you open the Stream Deck configuration App you should now see your duplicated Pro profiles as well as new Default Profile(s) for Livegrade Studio

Manually
Migrate
Pro
Profiles
to
Studio
Profiles

1.
Install
Livegrade
Studio
Stream
Deck
Plugin
without
automatic
migration

Download and install the latest Stream Deck configurations app from Elgato’s website
Attach all Stream Deck device(s) you want to use with your computer
Go to Livegrade
Studio
>
Install
Stream
Deck
plugin…
Click Do
Not
Migrate

Livegrade will now install Livegrade Studio’s Stream Deck plugin and add a new default Stream Deck profiles of all currently attached Stream Decks for
Livegrade Studio

Confirm in the two following Stream Deck’s dialogues to install the default profiles

When you open the Stream Deck configuration app you should now see a new Default Profile for Livegrade Studio

2.
Export
the
profile
you
want
to
migrate

Open the Stream Deck configuration app
Click on your currently selected profile
Right click on the profile you would like to export and choose Export…
Choose a location for your Livegrade Pro profile

3.
Migrate
the
profile
via
Livegrade
Studio

Open Livegrade Studio
Go to Livegrade
Studio
>
Migrate
Stream
Deck
Profiles
from
Livegrade
Pro…
Choose the profile you exported in step 2
Click Migrate
Click Reveal
in
Finder
to locate your migrated profile
To import the profile, double click on the created file with “…(Livegrade
Studio)” in its name
Stream Deck configuration app will be automatically opened and your imported profile will be automatically chosen
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Automation, Remote Control and 3rd Party Integrations
Automating
with
Events
and
Actions
Livegrade allows you to automatically trigger certain actions by events within the application. This can be used to configure the user interface, apply a
video routing configuration, or perform other actions for certain situations.

Managing
automations

You can create and manage automations in the Automation Manager window. Choose “Automation Manager…” from the application menu to open the
Automation Manager window.

Automations panel

By clicking the “+” button below the automations table you can add a new automation. By clicking the “-“ button you can remove the selected
automation. By clicking “Edit…” you can modify the selected automation.

Adding
an
automation

Setting up an automation

When clicking “+” below the automations table of the Automation Manager, a panel is opened that lets you choose

the event, that shall trigger the event, and
the action, that shall be performed when the event happens.
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Available events:

Switch to Slot: Choose one of the options to trigger an action when the user switches to a specific device slot, the library slot, or if any slot change
occurs (“Any”).
Recording: Chose one of the start or stop events for recording in individual or any slot.
Application: Choose one of the options to trigger an action when the application started or is going to quit, or goes to foreground or background.

Available actions:

Slots: Choose one of the actions with slots such as switching viewing modes, refreshing framegrabs, or locking external control panels.
View: Choose one of the actions for configuring the user interface, such as showing or hiding scopes, configuring the slot appearance, or enable or
disable dim mode.
Video Routing Configurations: Choose one of the saved video routing configurations to apply the configuration, or create a new configuration.
Video Capture Device: Chose a configure capture device to move it to the current slot. This can be used to use one capture device for multiple slots
together using video routing configurations.

Scripts: Choose one of the installed and executable scripts. See Scripts and Automation for more details on scripts.

Click “Add” to save the new automation. If the automation is enabled, the chosen action will be triggered automatically when the selected event occurs.

Enabling
and
disabling
automations

You can enable and disable single automations by checking the checkbox besides the automation in the automation table.

You can completely disable automations by clicking the automations button in the bottom bar of Livegrade’s main window. Please note that the
automations button is only shown, if at least one automation is configured.

Event
and
action
logging
and
error

In the bottom bar of Livegrade’s main window the automation button indicates when an action has been triggered by switching to a blue icon if a n action
has been triggered successfully.

You can click on the automation button to disable all automation temporarily.

If an action failed (e.g. because a video routing setting cannot be applied), the automation button indicates this with a yellow icon. The tooltip of the
automation button shows additional information about the failed automation.

A complete log of all automation can be reviewed in the “Event Log” tab of the automation manager. Successful automations, but also error messages of
failed actions are displayed there. The event log is cleared when the application quits, so you only see log entries of automations since the last start of the
application.

Scripts
and
Automation
The application comes with the capability to run scripts from within the application. Scripts can be run manually (e.g. via keyboard shortcuts), or
automated (via the Automation Manager).

The application provides environment variables to pass information of the current state of the application (e.g. current slot name, currently selected folder
name) to the script.

Installing
Scripts

You can use any script that is executable in Terminal. The script language is only limited by the available interpreters on your computer. macOS comes
with most common interpreters pre-installed (e.g. Python, perl, Bash, ruby), but you can also install you own interpreters (e.g. Lua).

In order to be usable by the application, scripts need to be 

installed in the Scripts folder in ~/Library/Application	Support/Pomfort/LivegradeStudio5/and 
have the executable-flag set.

You can open the Scripts folder by choosing “Show in Finder…” in the “Scripts” submenu of the application menu. Move any scripts to this folder.

For a script file to be executable by the application, the executable flag must be set for that script file in the file system. You can use the Terminal to set
the executable flag:

$	cd	“~/Library/Application	Support/Pomfort/LivegradeStudio5/Scripts”
$	chmod	+x	MY-CUSTOM.SCRIPT

All scripts also need to start with a Shebang with an interpreter directive (e.g. #!/usr/bin/ruby ) so that the application knows what interpreter to use
in order to run the script.

Running
Scripts

Installed scripts that have the executable flag set will show up in the “Scripts” submenu of the application menu. 

You can run these scripts manually by choosing the menu entry for a scripts.

You can assign keyboard shortcuts to run these scripts with the Keyboard Shortcuts manager .

You can assign MIDI events to run these scripts with the MIDI mapper.

Automating
Scripts

You can let the application run scripts automatically on certain events by configuring script actions in the Automation Manager.
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Example
Script
and
Environment
Variables

If the Scripts folder doesn’t contain executable scripts (e.g. on first start of the application), a sample shell script is installed in the Scripts folder, that
illustrates the use of the environment variables. 

You can inspect the script by choosing “Show in Finder…” in the “Scripts” submenu of the application menu.

Debugging
Scripts

You can see the output of a script in the Automation Manager’s “Logs” tab – no matter of the script has been run manually or through automation. 

The log shows both the standard output pipe and the standard error pipe.

The event log is cleared when the application quits, so you only see log entries of automations since the last start of the application.

If a script doesn’t exit with exit code “0” (which is the default exit code), the application plays the system beep.

The
iOS
Remote
for
LiveGrade
Pro
and
Livegrade
Studio
Along with Livegrade PRO 2.0, the Livegrade PRO Remote iOS app has been released. This app will let you use any iOS device to remotely control basic
functions like applying grades form the library, showing original signal, by-passing color and showing False Color while away from the computer.

figure 1: iOS Remote

 

In order to use the remote, open Livegrade’s Preferences panel and check the «Enable Livegrade Remote Access» check box as shown in Figure 2:

figure 2: Remote preferences

At this point, any iOS device with the Livegrade PRO Remote app connected to the same wireless network will be able to control Livegrade PRO. For this
reason, we recommend to set a password in the Preferences panel.

The Livegrade PRO iOS Remote is available from the App Store.

Setting
up
ScopeBox
Video
Scopes
You can use ScopeBox by Divergent Media for software-based waveform and video scopes Livegrade’s Image View. ScopeBox offers a variety of
waveform monitors and video scopes that enable image analysis and color control of the content in the Livegrade Image View.

You can receive information about how to download, setup and license ScopeBox software on Divergent Media’s Website. To use the integration of
Livegrade in ScopeBox you have to run version 3.5.3 or later of the ScopeBox application.

Connecting
Livegrade
and
ScopeBox
via
ScopeLink

Livegrade sends the current image of the player directly to the ScopeBox application by DivergentMedia’s ScopeLink technology. To enable ScopeLink
open the ScopeBox application.

Click in the upper left area of the ScopeBox main window to set a new source. Choose “Add
ScopeLink
Source
>
Pomfort
Livegrade” from the context
menu:
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Figure 1: Add Pomfort’s Livegrade as a source.

After that the source should show a pending image:

Figure 2: ScopeBox waiting for the Livegrade connection.

If not already open, now open Livegrade. Open the Image View.

Make sure that in the preferences of Livegrade under “External
Video” the checkbox “Connect
to
ScopeBox” is enabled. You reach the preferences
from the Main Menu by choosing “Livegrade
>
Preferences…”:

Figure 4: ScopeBox Preference in the External Video tab

There you can also choose if you want to reduce the number of updates per second. Checking this box reduces the required computing resources for the
ScopeBox integration.

When you switch to ScopeBox you should then see the default view including an image preview of the image showing in the Livegrade Image View:
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Figure 3: The ScopeBox UI showing the image of the Livegrade Image View and scopes.

Please be aware that the Livegrade Image Viewer has to be open to send the current image to Scopebox. Closing the Image Viewer in Livegrade will
continue showing the last frame in Scopebox. When reopening the Image Viewer, Scopebox will refresh the input with the current image from Livegrade.

Learn how to use ScopeBox with this tutorial (from Divergent Media):

By loading the video, you agree to Vimeos’s privacy policy.
Learn more

Load video

 Always unblock Vimeo

Find more tutorial videos from Divergent Media about ScopeBox here.

Because of Livegrade’s internal RGB processing, signals from of YCbCr based clips sent to ScopeBox via ScopeLink don’t contain code values outside
the legal range (even if they might be present in the source files).
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Tags: waveform, vectorscope, histogram, rgb parade

Using
Corrective
3D
LUTs
from
SpectraCal
CalMAN
With SpectraCal’s software package CalMAN it is possible to create corrective 3D Cube LUTs that are compatible with Livegrade. Based on
spectrometric measurements, CalMAN produces a 3D LUT for a specific display device that compensates deviations from the targeted color space.
These 3D LUTs can be used in Livegrade to sustain an ideal performance of the connected display devices.

Figure 1: Build a calibration LUT in CalMAN

 

For further information on how to use CalMAN to create corrective 3D LUTs you can refer to SpectraCal’s Overview Guide or check their complete
walkthrough of Creating 3D LUTS in CalMAN 5.

 

How
to
import
and
use
corrective
3D
LUTs
in
Livegrade

To import the corrective 3D LUT from CalMAN into Livegrade you have to add a new 3D LUT Node to your grading mode. To be able to do that you have
to select a grading mode that offers the possibility to add nodes as e.g. “CDL Advanced”:

Figure 2: Press edit to add 3D LUT node

 

Make sure to add the 3D LUT node with the corrective 3D LUT as the last node. As the processings get applied from top to bottom the corrective LUT
should be last to compensate the measured deviations of the display. With the “Edit”-Mode enabled you will be able to move the node to the final
position:
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Figure 3: Use the Edit-Mode to move nodes

 

Exit the “Edit”-Mode by clicking on “Edit” again.

 

Use the load button in the final 3D LUT Node to choose the CalMAN calibration LUT you generated from Finder.

As soon as the LUT is chosen the connected display will show the corrected signal as measured by the CalMAN software.  The corrective 3D LUT will
make sure to correctly display all color processing applied above the corrective 3D LUT node.

How to use Livegrade on an HD-SDI signal can be learned from the article HD-SDI setup for Livegrade.
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Step-By-Step Tutorials
Dailies
Workflow
with
DaVinci
Resolve
Using
look
information
from
set
for
the
creation
of
dailies
saves
time
and
communication
efforts.
Blackmagic
Design’s
“DaVinci
Resolve”
(http://www.blackmagic-design.com/products/davinciresolve)
is
a
powerful
and
widely
used
software
to
create
dailies
on
or
near
set.
This
article
shows
how
color
information
from
Livegrade
can
be
used
to
save
extra
grading
time
in
Resolve
by
using
the
looks
created
in
Livegrade.

CDL
Grade
mode

Livegrade’s CDL-Grade mode lets you export ASC-CDL files of current color settings in Livegrade. These CDL files can be used in various dailies and
post-production  tools.

To
transfer
ASC-CDL
files
to
Resolve
or
Resolve
Light
follow
these
steps:

1.
Export
ASC-CDL
file
from
Livegrade

Make sure that your are in “CDL Grade” mode in Livegrade. Do so by switching the grading mode above the color controls or apply a grade from
the grade library of the type “CDL Grade”

Choose “File” -> “Save current Grade as…” or “Save selected Grade as…” and save the .cdl file. You can open this file with a text editor and see
the typical ASC-CDL XML syntax.
Hint: To simplify matching of the CDL files with the clips you can use an automatic name scheme when exporting.

2.
Import
ASC-CDL
file
in
Resolve

In Resolve go to the “Color” room.
In the “Stills” panel right-click and choose “Import”.

Select “CDL files (*.cdl)” at the bottom of the Open Dialog and navigate to the CDL files just saved in Livegrade.
A new “Still” with the name of the CDL file will appear in the “Stills” panel.
Select a one or multiple clips in the timeline that you want the CDL apply to.
Right-click the new Still and choose “Add correction” in the context menu.

You should see the controls in 3-WAY COLOR of the selected clips be set according to the CDL values initially coming from Livegrade.

3.Applying
a
lookup
table
(3D
LUT)

If you are using a 3D LUT in the LUT panel of the CDL grading mode in Livegrade (for example as a preview LUT for log-material), make sure that this LUT
is also used in DaVinci Resolve.

Depending on the order of filter panels in Livegrade you might configure Resolve for Loading a “3D Input Lookup Table” or a “3D Output Lookup table” in
the “Config” room.

If in Livegrade the CDL controls are in the upper slot, the LUT is applied after the CDL values and you need to set the LUT in Resolve as output LUT.
If in Livegrade the CDL controls are in the lower slot, the LUT is applied before and you need to set the LUT in Resolve as input LUT.
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Learn more about Livegrade’s CDL grading mode.

 

Alexa
Look
mode

Resolve doesn’t support the import of Alexa Look files (xml) directly, but you can instead export a 3D LUT in Livegrade and import that on a per-clip base
into Resolve.

1.
Export
3D
LUT
from
Livegrade

Make sure that your are in “Alexa Look” mode in Livegrade. Do so by switching the grading mode above the color controls or apply a grade from
the grade library of the type “Alexa Look”

Choose “File” -> “Save current Grade as 3D LUT…” or “Save selected Grade as 3D LUT…” and save the look as a “DaVinci Resolve” .dat file.
Hint: To simplify matching of the LUTs with the clips you can use an automatic name scheme when exporting.

2.
Install
.DAT
files
for
Resolve

In Finder navigate to /Library/Application Support/Blackmagic Design/DaVinci Resolve/LUT/Arri
Copy the created .DAT files into this folder.
Either restart Resolve or click on “Update Lists” in the “LUTS” tab of the “Config” room.

3.
Choose
3D
LUT

In Resolve go to the “Color” room.
In the “Clip” panel right-click the node and navigate to the right LUT

Dailies
Workflow
with
Assimilate
Scratch
Using look information from set for the creation of dailies saves time and communication efforts. Scratch is a powerful and high performance software tool
that helps you out to create dailies, additionally primary and secondary grading, sound syncing and much more. For additional information take a look at
www.assimilateinc.com
This article provides you with  information about how to transfer your  pre-grades made with Livegrade on set to Asssimilate Scratch, to save you some
extra time with creating dailies by the end of a hard day on set.

Note:
There
are

various
approaches
to
apply
a
LUT
&
CDL
grades
in
general,
accordingly
also
in
Assimilate
Scratch.
The
steps
below
describe
a
typical
DIT
workflow,
which
we
also
recommend.


This article describes a manual matching process, if you want to match grades in Scratch automatically you please see:

Exporting grades to Scratch via ALE
Using an automatic name scheme when exporting CDL or 3D LUT files

CDL
Grade
mode

Livegrade’s CDL-Grading mode lets you export ASC-CDL files of current color settings in Livegrade. These CDL files can be used in various dailies and
post-production tools. To find out more about CDL please take a look on the ASC Society Website.

To
transfer
ASC-CDL
files
to
Assimilate
Scratch
follow
these
steps:

1.
Export
ASC-CDL
file
from
Livegrade

Choose “File” -> “Save current Grade as…” or “Save selected Grade as…” and save the .cdl file. You can open this file with a text editor and see
the typical ASC-CDL XML syntax.
Hint: To automate matching of the CDL files with the clips you can use an automatic name scheme when exporting.

2.
Export
log-to-video
LUT
separately

1. Set your grade to neutral (see figure 1.)
2. Choose a camera preset or load a custom log-to-video 3D LUT
3. Select “Export current Grade as 3D LUT” .
4. In the “Save To” dialog menu choose  “Assimilate Scratch LUT” as the desired format.
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Figure 1: “Set Look Up Table to Neutral”

 

Order
of
Operations

Note: To receive the desired result it is necessary to keep the same order of operations in Livegrade and Scratch. In our example the CDL Grade is
applied before an Alexa Neutral 3D LUT camera preset like in figure 2. In this article we illustrate how to create this same order of operations in Scratch.

Figure 2: “Order first the CDL Grade then the 3D LUT”

Import
ASC-CDL
file
in
Scratch

At first you will apply a CDL look for every clip. Then you can add the log-to-video LUT in an Output Node for your whole construct, assuming you used
the same 3D camera preset LUT in Livegrade. If you have different LUTs applied for different scenes you must apply the 3D LUT separately to every clip.
Therefore you can use the copy & paste tool from Scratch. You can also apply  a CDL to every clip in you scratch construct by simply copy paste.

Set
Color
Settings
with
CDL
file

Switch to your matrix tool set inside your desired CONstruct
Load the exported CDL from Livegrade by clicking load…
Select “CDL files (*.cdl)” at the bottom of the Open Dialog and navigate to the CDL file just saved in Livegrade.

Figure 3: “Select CDL”

Set
3d
LUT
if
you
use
a
3d
LUT
Presets
for
log-to-video
in
output
node

Switch from the Timeline to the Output mode like in figure 4.
Add a “Single Output” and enter the new node
Under the “FX Ctrls” hit “Insert” and add a new Plugin
From the “Plugin” Dialog choose your desired dailies output format
Switch to the “Matrix” with a right click
Load the exported 3d LUT or Camera preset from Livegrade by clicking load like in Figure 6
Set “3d LUT Formats” filter at the bottom of the Open Dialog
Select the desired .cube” file from Livegrade and press “Load”.
Hit the “Add to Queue” and switch back to your construct to start the Queue process by
hitting the “Process” button to start the rendering of dailies

figure 4: “Output mode”

 

Figure 5: “Output Node View”
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Figure 6: “Load exported .3dl file from Livegrade”

Alexa
Look
mode

Scratch does not support the import of Alexa Look files (xml) directly, but you can instead export a 3D LUT in Livegrade and then import it on a per-clip
base into Scratch.

More information about the Livegrade’s Alexa Look grade mode.

Export
3D
LUT
from
Livegrade

Make sure that you are in “Alexa Look” mode in Livegrade. Do so by switching the grading mode above the color controls or apply a grade from the
grade library of the type “Alexa Look”

Select all the grades you want to export to Assimilate Scratch.
Choose “File” -> “Save current Grade as 3D LUT…” or “Save selected Grade as 3D LUT…” and save the grades as a “Scratch LUT File”  file.
Hint: To simplify matching of the 3D LUTs with the clips you can use an automatic name scheme when exporting.

Import
LUT
to
Scratch

Switch to your matrix tool set inside your desired CONstruct and navigate to a certain clip
Load the exported LUT in Scratch by selecting “(*.3dl)” at the bottom of the Open Dialog and navigate to the LUT file which you just saved in
Livegrade.

 

Apply
to
all
your
clips
by
using
the
Copy
Paste
Feature

If you use the same baked LUT for more than one clip you can use the copy/paste feature as follows in Figure 7 and 8.

Figure 7: “Load Baked Alexa 3D LUT from Livegrade”

 

Figure 8: “Copy Paste Feature to apply baked 3D Lut to other clips”

Exporting
Grades
to
Scratch
via
ALE
Livegrade offers the possibility to transfer CDL grades to Assimilate Scratch through an ALE file. This feature will help you to match the grades with each
clip automatically using their metadata information. In addition, there is the advantage of having all the grades in one single ALE file. As long as camera
and scene information are entered for each grade in Livegrade, the exported ALE file will transfer the metadata along with the CDL values to automatically
apply the grades to each clip in Scratch.

There are some considerations to have in mind when using this feature:
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it only applies to grades created in the CDL or ACES grading mode
the 3D LUT information is not included (i.e. a LogC to Rec.709 LUT). Only the CDL information and the LUT name is transferred. The same LUT has
to be applied down the post workflow
camera and scene information has to be properly set on the grades

In order to start the ALE export, you have to select the Grade Group from the Livegrade library. Then select File>Export grade Group for Scratch (ALE) as
shown in figure 1.

figure 1: exporting grade group as an ALE file

This will bring you to a save destination dialogue:

figure 2: save destination selection

 

Once the ALE file has been saved, you can load it into Assimilate Scratch to match the grades with the clips.

 

Transferring
Color
Decisions
to
REDCINE-X
Livegrade offers the possibility to export .cdl (Color Decision List) files that can then be imported to the REDCINE-X software offered by RED Digital
Cinema. With this workflow you will be able to transfer color decisions from Livegrade to REDCINE-X.

Exporting
a
CDL
from
Livegrade

To export a CDL from the Livegrade library perform the following steps:

1. Select one or multiple looks from the library:
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Figure 1: Multiple looks selected

2. Go to the Main Menu. Choose “File
>
Save
selected
Looks
as…”
to export the selected looks (you can also use Shift+Command+S as keyboard
shortcut):

Figure 2: The «File» menu

You can also select
“File
>Save
current
Look
as
..”
to only export the look that is currently applied.

3. In the export wizard you will then be able to select the desired format for your export:
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Figure 3: Choose the desired format for the export

Choose “ASC-CDL
(*.cdl)” from the dropdown and hit “Save”.

Please be aware that you cannot export a CDL from every grading mode with any node constellation. Please refer to the article Exporting Grades for more
information.

 

Importing
a
CDL
in
REDCINE-X

Open REDCINE-X.

In the File Browser on the left side navigate to the folder with your desired clips and then load it into the viewer.

Select the “Look” tab from the tabs on the right side. “Post
:
Look
:
Effects” should contain a subsection “Look:
Effect
:
CDL” :

Figure 4: The REDCINE-X “Look” tab with the CDL effect.
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From the “Load” button (marked with a yellow box in Fig. 4)  you can now select the CDL you saved from Livegrade. You can see it taking effect when
the Slope, Offset and/or Power values below become altered.

To see the CDL take effect you have to enable the checkbox above the Effects tab (see blue box indicator in Fig. 4).

You  will also be able to add a 3D LUT to the color processing in REDCINE-X. This way you can rebuild the CDL+LUT node structure used in Livegrade.

Make sure that you are using the latest version of REDCINE-X. It may appear that you will not be able to use certain functionalities including CDL import
when you are not working with the latest release.

For more information take a look at the REDCINE-X Pro Operations Guide.
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Additional Settings and Preferences
Application
Preferences
You can find the Livegrade preferences within the main menu under Livegrade
>
Preferences… The preferences window is divided into the following tabs:

General

Localization: Choose your desired unit for focus distance and the preferred language to be used in the Livegrade user interface.
UI
Appearance: Set the brightness of the User Interface Dimming effect.

Livegrade Settings General

Projects

Labels:
You can define a project-based custom label text for each color label. The custom text is displayed together with the color label in the shot
library, the info tab and can also be included in reports.

Note: You can exchange the label preferences with other machines or users via settings export/import; see the article Exchange Settings. 

Titles
for
Custom
Fields: You can assign project-bases titles for the “Custom 1” – “Custom 6” fields.

Projects preferences

Library

Shots
Table: Choose which action to apply when double-clicking a shot in the shots table and set if the library slot should always follow the
selection in the shots table.
Shot
Creation: Set your preferred default values for new shots: Clip identifier, automatic camera value, default label, and secondary label.
Furthermore, set if you want to increase clip number and take number automatically on shot creation. Choose if you want to add a “modified”
postfix to your look name for edited looks and if you want to create linked looks from linked slots, see the article Linked Looks for further
information.
Still
Image
Export: Choose your default directory for still image exports, your preferred file naming scheme for still image exports, and your
preferred image file type.
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Library preferences

 

Slating

Slating
System:
Choose a “Slating System” to show only relevant menu items within the “Edit Global Metadata Field” menu for your preferred
slating system:

“Standard” lets you work with continuous slating with scene / shot / take fields (e.g., Scene “56” / Shot “4” / Take “2”)
“American” lets you work with American slating with scene / take fields (e.g., Scene “56C” / Take “2”)
“All” lets you see all available menu items for full flexibility

Custom
reset
values:
choose reset values for scene, shot and take metadata fields
Scene
Letter:
The “Scene Letter” checkbox allows you to enable/disable the behavior to append a letter on “Increase Scene” actions automatically
(e.g., increment “5” to “5A”). “Scene Letter “is enabled automatically when switching to the “American” slating system and disabled when switching
to the “Standard” slating system.

Note: Incrementing letters in the scene/shot/take fields use the overflow system (e.g., “Z” to “AA”, etc.)

Skipped
Characters: You can also define specific characters to be skipped when incrementing letters in the scene/shot/take fields.

Livegrade Settings Slating
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Grading

Grade
Controls
Step
Sizes: Set the sensitivity for printer lights (for PRT tab in the CDL node), simple grade parameters (for the SPL tab) and
saturation.
False
Color: Toggle between the different false color modes. For more information, please check the article False Color modes in Livegrade.
Look
History: The look history can be updated to either 1 second (which is the default), 3 or 10 seconds. Additional settings are available to limit
the look history for increased performance.
Hardware
Panels: If you are using a hardware panel to accomplish your grading tasks, you can set the sensitivity of the panel controls by adjusting
the slider.
Hue-Sat-Lum
Curves:
Choose if the “Hue-Sat-Lum Curves” should show the primary color hue points by default.

Livegrade Settings Grading

 

Devices

Apply
Look
on
Startup:
Enable the use of the last look used when Livegrade starts.
Identify
Devices: Set a mode for temporarily blinking to identify a device.
Store
Look:
The next option allows you to store the look you have currently selected on the third-party device (e.g., IS-mini, Teradek COLR)
connected to Livegrade when quitting the app.
Framegrab: Choose if to refresh the framegrab from devices before shot / look creation.
Capture
Devices: You can enable “Use all video connectors as inputs” for using all SDI-connectors of half-duplex capture devices as inputs (e.g.,
AJA Io4K Plus).  If this option is disabled one connector remains available for video output.
ARRI
Alexa: Set if Livegrade should automatically store looks on ARRI cameras.
IS-Mini: Choose if Livegrade should search for IS-Mini devices connected via ethernet. Note: It is recommended to connect IS-Minis via USB if
possible. You can also disable the automatic framegrab creation of IS-mini devices to prevent the framegrab from being added automatically when
connecting a new device.
Interactive
Video
Routing
Appearance: Set a color scheme for the UI of the interactive video routing panel.
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Devices Preferences

Recording

Media
Folders/Record
Folder: Set the storage location/s for your project’s media files and inspect information like the name of your “Volume”, the
media folder’s “Path”, the available “Disk Free” space of the media folder,  amount of media “Files” stored in the folder, the “Last Used” date, and
your media folder’s “UUID”. “Reveal in Finder…” opens the selected media folder/record folder in a new Finder window.
Disk
Space: You can define a size limit for a warning letting you know that you are soon running out of disk space.
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Note: Livegrade Pro is limited to one active media folder (record folder) per project, while Livegrade Studio also supports multiple media folders
simultaneously. Learn more about Livegrade’s media storage system in the article Media Folders and Record Folder.

Recording:
For general information about the image capturing feature, please check the article SDI signal recording and Framegrabs. It’s possible
to set the following options:

Record
Format: Choose between the following formats:
ProRes 422 Proxy
ProRes 422 LT
ProRes 422
ProRes 422 HQ

Trigger
Record
Behavior/Trigger
Stop
Behavior: Set if the record flag should toggle (start/stop) recording in all slots or just in the triggered
slot.

Recording preferences

Video

External
Video:
All the details about this feature can be found in the article Image View Output to HD-SDI in Livegrade. Additionally, you can
choose to release the SDI Output device when Livegrade is in the background so that you can use the device with other software apps.
ScopeBox
Integration:
Livegrade can be connected to ScopeBox to get advanced video scopes. All the details about this feature are found in the
article Professional Video Scopes for Livegrade with ScopeBox.
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Video preferences

ACES

In the Livegrade preferences, you can manage the available ACES versions and transforms. For more details about this feature, please read the
article Using the ACES CDL Grading Mode.

ACES preferences
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Advanced

Image
preview:
Force color profile of loaded images to Rec.709
LUT
Interpolation: You can choose between different interpolation methods. It is recommended to choose tetrahedral interpolation for improved
color accuracy on video output and still image export.
Image
Export: You can enable/disable color profile tagging for still images and apply the appropriate color profile for most common colorspaces
(Rec.709/Rec.2020/Rec.2100 PQ/Rec.2100 HLG/sRGB).
ICC
Profiles:
The setting within the “Advanced” section allows you to limit the use to ICC profiles to your Display Curve. This may result in a less
accurate color display but, on the other hand, decreases the possibility of banding effects.
ColorSync:
Check the article Matching Livegrade’s Image View with a broadcast-video display to learn how to ensure the correct display of images
in the Image Viewer on different monitors (e.g., broadcast-video displays).

Advanced preferences

Remote

Enable the use of the Livegrade Remote app through this tab. For more information about the Livegrade Remote app, please check the article Livegrade
iOS Remote.

Remote Preferences

Updates
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Automatic
Updates:
Updates for Livegrade will automatically be delivered through the built-in update mechanism. If a new update is available,
Livegrade will notify you and ask for permission to install the update. To check if the automatic update function is enabled, go to Livegrade
>
Preferences…>
Updates. There you also can change the interval of how frequently Livegrade should look for updates. If you disable automatic
updates, you can start a manual update via the Livegrade
>
Check
for
Updates option at any point. However, we strongly recommend using the
automatic update notification feature.
Data
Collection:
The anonymous usage statics is selected by default and allows the Pomfort development team to improve the functions and
features of Livegrade. If you do not want to supply this information, just deselect the checkbox. Also, choose if Livegrade should automatically send
your crash reports to the Pomfort development team, helping them to analyze problems and fix potential issues.

Updates Preferences

Accounts

In the accounts tab, you can add your ShotHub accounts to upload your project to ShotHub. Learn more in the article Connecting Livegrade to Pomfort
ShotHub.

Accounts Preferences

 

Search Code: LG-AP1

144

Livegrade Studio 
Additional Settings and Preferences

http://kb.pomfort.com/?p=15267


Editing
Keyboard
Shortcuts
There are a variety of keyboard shortcuts available for commands in the main menu of the application. Keyboard shortcuts help you to boost your
productivity by offering direct physical buttons to features of the application.

Note: Livegrade also has the capability to map actions of the main menu as well as certain additional controls to MIDI controllers. See Setting up MIDI
Controllers for more details.

Some shortcuts are already predefined. You can also set shortcuts for selected commands that you perform quite often in order to memorize the
interaction with the application more easily.

To inspect the exact list of available keyboard shortcuts go to
 “Keyboard Shortcuts” in the application menu. This will open the Keyboard Shortcuts
Editor (figure 1).

Figure 1: The Keyboard Shortcut Editor

Listing
and
Searching
Keyboard
Shortcuts

The keyboard shortcut editor shows a table with list of all actions in the main menu with their currently set keyboard shortcuts. You can search the list by
typing into the search bar on top of the table.

Edit
Keyboard
Shortcuts

To edit a keyboard shortcut:

1. Select “Map Keys” to allow changes on the key mapping list.
2. Choose the command row.
3. To set or modify a shortcut press the key or keys to use as the new keyboard shortcut. You can use modifiers, numbers, letters and characters

individually or in combination.

To  remove the associated shortcut permanently press ⌫ (delete / backspace) button.

Close the Edit Keyboard Shortcuts window when you are done.

If you choose a shortcut already assigned to a command, a warning dialog box will be displayed that shows which command already used the chosen
shortcut.

Figure 2: Alert showing used keyboard shortcut

Select “Cancel” and choose another keys for your current command, or select “Reassign” which removes the shortcut from the  old command and sets it
for the selected command (figure 2).
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Restoring
Sets
of
Keyboard
Shortcuts

You can reset all keyboard shortcuts to latest version of GUI-based default by clicking “Restore defaults…”.

You can also reset all keyboard shortcuts to previous version X default by clicking “Restore vX Shortcuts…”.

Note: Both of the restore actions require a restart of the application.

 

Change
the
Application
Language
Livegrade offers the possibility to change the language for the User Interface independently from the setting for Mac OS X.

To do so open the preferences. Go to the Main Menu and choose “Livegrade
>
Preferences…”.
In the “General” tab of the preferences you will find the
section “Language” right at the bottom:

 

Fig. 1: The General tab of the Livegrade preferences containing the language settings.

The dropdown lets you choose between automatic selection based on the system settings of macOS, or force a specific application language.

After changing the settings Livegrade will show an alert asking you to restart the application for the changes to take effect.

Exchange
Settings
Livegrade allows to export and import global settings and project settings to exchange them with other users or to transfer them to other machines.

Which
Settings
Can
Be
Exchanged?

Project settings:

Folder Structure
Record Folder and Media Folders
Label Preferences
(Titles for ) Custom Fields

Global settings:

Video Router Configurations
Keyboard Shortcuts
MIDI Controller Mappings
(Custom) Column Layouts
(Custom) Smart Groups Layouts
Custom Clip Identifier
Slot / Device Configuration
Global and Slot Metadata Layout
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Export
/
Import
Settings

To export or import project settings go to the Livegrade application menu and select “Settings
>
Export…
/
Import…”:

You can specify the individual settings to be exported after clicking on “Export…”:

Export Settings

Click “Export” to save the .plconfig file containing the settings information to the selected destination.

The export and import settings windows are symmetrical hence you can choose which content to write to the .plconfig file as well as which content to
import from a .plconfig file.

Import Settings
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Licensing Features
The
License
Window
In the license window you can activate the software with a purchased license and manage other aspects of licensing.

Trial
Period
and
Read-Only
Mode:

Without a valid license you can use the software in a trial mode for 10 days. You can extend the use at any time by entering a valid license.

After the trial mode or after a purchased license has expired, Livegrade still works in read-only mode. You cannot interact with hardware, but you can
browse all information stored in the application’s shot library, and even create reports and export data.

License Manager

Add
License:

By clicking the “Add License…” button a panel opens that allows you to activate a license. In the “License Key” field you enter the license code that you
received after purchase. A license code typically has the format: LGPro-123456AB-12AB-12AB-12AB-123456ABCDEF.

If you have entered license codes before, you can choose them directly with the button with the triangle besides the license key field.

In the “License Location” field is a field for you to descriptive the computer you are running the license on (see “License Location” below).

Click “Activate License” to activate the license. A working internet connection is needed so that the software can validate the license code against
Pomfort’s license servers.

If the activation fails with the error message “Activation failed”, there are three possible reasons for that:

You don’t have a working internet connection (or the Pomfort license servers are temporarily not reachable),
the license code is not correct (e.g. a character or number is missing), or
the license is activated on another computer already.

If the license is activated on another computer already, deactivate the license there first.

Installed
License
Keys:

The license table shows all installed Pomfort licenses on the computer with their expiration date. It also includes licenses of other products. Licenses (e.g
of other products) that cannot activate the installed software version are greyed out.

By clicking “Reload Licenses” the licenses and their activation and expiration information are refreshed from the Pomfort’s license servers.

You can deactivate a license by selecting it in the table and clicking “Deactivate License”. The license can now be activated on another computer (see
article How do I migrate a license from one computer to another?).

License
Location:

The license location text will appear in the Pomfort Account (see below) and is helpful for managing and locating multiple licenses in different computers.
You can edit the license location by clicking the “Edit Location…” button. You can either choose an arbitrary name (for example “Second Unit
Notebook”), or use the computer’s name as set in the Sharing tab of the System preferences by clicking the “Use Hostname” button. When clicking “OK”,
the license location will be transferred to Pomfort’s license servers.

Purchase
License:

By clicking “Visit Store…” the Pomfort online store opens in a browser window where you can purchase a license. You will receive a license code by
email only minutes after finishing the purchase process.

Pomfort
Account:

After the purchase of your first Pomfort product, you can create your personal Pomfort Account on Pomfort’s license servers. In Pomfort Account online
system you can see an overview of all your purchased licenses (of all products) and troubleshoot issues with your licenses.

Pomfort
Account:
Online
License
Management

In the Pomfort
Account you can manage your licenses online. Review the license status of all licenses purchased under a
specific
e-mail
address
and
easily track e.g. license expiration dates, renewal dates or the current activation status of your yearly subscriptions or temporary licenses. 

This article will help with the following topics
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How can I create the personal login to access my Pomfort Account?
Which information can I see in my account?
License Activation Modes
Emergency License for Subscribers
Using a custom License Location / Hostname
Troubleshooting

How
Can
I
Create
the
Personal
Login
to
Access
my
Pomfort
Account?

Purchasing a license for Silverstack or Livegrade qualifies you to create your personal Pomfort Account. It is not automatically created after the purchase
but requires only a few manual steps:

1. Go to http://pomfort.com and click the account sign in the upper right corner to access the Pomfort Account login page.
You can access the login page also directly through http://account.pomfort.com

2. Click “Create
New
Account”
3. Insert the email address your license(es) has/have been purchased with and enter a password.
4. After sending the form you will receive an email with an activation link
5. Activate the account through the link and log in on http://account.pomfort.com with your credentials.

To change your password click “Reset
Password”
on the login page and fill in your e-mail address in the following page. After submission you will
receive a link to create a new password for your account.

Which
Information
Can
I
See
in
my
Account?

Desktop
Applications

The core of the Pomfort Account is the
“User
Licenses
Overview”.

It is separated in three sections that hold different types of licenses:

Subscriptions: This section shows all your subscription licenses.
Project
Licenses: This section shows all your project licenses (e.g. 14-days or 1-month licenses)
Other
Licenses: All other licenses that do not fall under the above are listed here.

The “User License Overview” gives you a comprehensive overview by showing a unique license card for each of your licenses. Each license card contains
detailed information about the license status.

For subscription licenses this is in detail:

Subscription
Status: Shows whether your subscription is
Running
Cancelled
Expired

Activation
Status: Gives feedback about the activation of the license key in an application and can display
Active: The license is activated on a machine.
Inactive: The license is not active on a machine and can be activated for the product.

License
Key is the unique key that can be used to activate your product
License
Location
/
Hostname: Identifier for your machine that can be sent through the License Manager of the applications (see section License
Location / Hostname )
Machine
Hardware
ID: Each license can only be activated on one machine. The hardware ID is transmitted to the license server on activation. This
can help to identify the active machine for the user.
Subscription
Renewal
Date: The date the subscription will renew for the next yearly period.
Manage
Subscription
Link:
This link brings you to the manage subscription page in the Pomfort online store to show the billing history, edit
subscription details such as payment method or address, or cancel your subscription.
See
More: When expanding the ‘See More’ section on your license card, you can see additional info regarding your purchase, e.g., it will show the
date of purchase, the name/email address the license has been purchased with as well as a link to access your invoice from the account directly.
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For Project Licenses there are only small differences. Here’s an example:

Instead of the renewal date for subscriptions, project licenses show an expiry date after first activation.


License
Status: Show whether your license is
Not
in
Use: License has not yet been activated.
[Empty]: No status is shown as soon as the license has been activated.

Besides information about your license, you also have access to all software downloads in the “Downloads
Overview”.

The Downloads
Overview is separated in 4 sections:

Your
Downloads: Here you can see all direct software downloads that are available for you. What you see here depends on which active licenses
you own in your account. By clicking on “Start Download”, you can download the software immediately, without entering any further information. In
this section you will always download the most recent version of the software. Older software versions can be found in the changelog or in the
“Older Downloads” section further down.
Free
Trials:
This section shows you all free software trials that are available for you. By clicking on “Start Free Trial”, you will be taken to a separate
signup form, where you can start your free trial.
Tools:
In this section you can find useful tools for your daily work, such as Pomfort Seal Verify.
Older
Versions:
If you are looking for older versions to work with (e.g. because you are working on an older OS that is not supported in the new
versions), you can find the right version for you in this section.

Online
Services

This area of the Pomfort Account shows all important information related to our cloud solution ShotHub. The “Plans” overview is again divided into three
individual areas:

Active
Plans: This section shows your currently active plan.
Expired
Plans: This section shows your last expired plan.
Purchase
Options: If no plan is currently active, all ShotHub purchase options will appear here, and the required plan can be purchased directly
from your Pomfort account.

If a purchased plan expires, ShotHub will automatically transition to a Free plan with limited features. This then appears again under Active Plans.

Similar to the licenses for our desktop applications on the respective license cards, the different ShotHub plans (Free/Pro/Team Plan) are also shown on
the corresponding cards in the account. In addition, the activation status, the number of included users, and the renewal or expiration date of the current
ShotHub plan are displayed.

Furthermore, you can also find a link that will take you directly to the ShotHub login page.
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License
Activation
Modes

All customers with a yearly subscription to one of Pomfort’s desktop applications can choose from two different activation modes that allow them to use
a license, depending on their individual preferences:

Standard
License
Activation
Mode
(default)
Daily
License
Activation
Mode

Selecting
your
License
Mode

You can select your license mode in your Pomfort Account. Go to the tab “Licenses” to see your active subscriptions. All licenses that are yearly
subscriptions now show their “Activation Mode.” If you like to change the license activation mode choose “Manage Activation Mode” to adapt your
selection. Please ensure that the license you want to change is not in use on any machine, indicated by INACTIVE in the upper right corner of the license
card. Therefore the license should be removed from each license manager of your desktop application on all your devices.

For both license activation modes, you should add and activate your license in the license manager of the desktop application as described here: How do
I activate my license?

Emergency
Licenses
for
Subscribers

We’ve experienced that customers sometimes need a functioning license immediately, but cannot access their regular license due to various reasons.

To cope with such situations and to bypass possible extended solving times due to time zone differences, subscribers are now eligible for creating a
personal emergency
license.

How
to
Issue
an
Emergency
License

Click the  link at the bottom of the license card to reach the license troubleshoot page:
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On this page you find detailed steps to solve the license issue. If that should not be possible an emergency license can be created by clicking on the
“Issue
Emergency
License…” button.

The following restrictions apply to emergency licenses:

Only subscribers can issue emergency licenses
Limited number per subscription period
Valid for 5 consecutive days from moment of issue

Using
a
Custom
License
Location
/
Hostname

Since Silverstack and Silverstack Lab 6.3.3 and LiveGrade 3.9.3, a custom license location (host name) can be transmitted with the activation of a license.
This host name will be shown on the license card in your Pomfort Account in the “IN USE ON” section and can help to identify the machine a license is
active on with a descriptive name.

When activating a license key simply fill in your preferred host name in the “License Location” text field:

Additionally the hostname can be altered for all installed licenses by clicking the “Edit
Location..” button and filling in a new preferred host name:

After setting the license location in the application you can refresh your browser window with the Pomfort Account to see the license location name
appear in the license card of the activated licenses.
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Troubleshooting

This section holds an FAQ on the Pomfort Account and possible common problems that might occur.

Why
don’t
I
see
my
Licenses?

In case you logged into your account and do not see the expected license(es) please verify if the following is true:

You have bought the licenses with the same e-mail address the Pomfort Account is registered to. Only licenses bought with this e-mail address are
shown.
The expiration date of the license is no longer than 2 months in the past. Licenses that expired more than 2 months ago are automatically removed
from the license overview.
You received a proper license mail for your purchase.

If all of the above is true please contact sales@pomfort.com .

I
bought
my
licenses
under
different
email
addresses
but
want
to
see
them
in
one
Account
?

It is possible to manually merge licenses that have been bought with different email addresses to one address and therefore one Pomfort Account login.
Please contact sales@pomfort.com .
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Troubleshooting
Matching
the
Image
View
With
a
Video
Display

Background

In most applications on a Mac, displaying images and video is color managed in OS X by a technology called ColorSync. This is also the case for
Livegrade’s Image View that can display movies, stills and live video.

Color management in this case means, that the pixel values encoded in a movie file or live video are transformed for display in a way, so that the resulting
image on a specific computer monitor leads to the same
perception
as viewing the same image on a reference broadcast monitor. Due to the assumed
different viewing environments of broadcast monitors and computer monitors (dimly lit for broadcast video and brighter viewing conditions for computer
monitors), the video displayed on a computer monitor will intentionally not be exactly the same as the original signal displayed on a broadcast monitor (it
will basically have a less contrasty gamma of 2.2 instead of a more contrasty video gamma of around 2.4-2.5), but it will achieve the same perception
when taking into account the different viewing conditions.

For more information on this topic, please see Apple’s TN2257.

Displaying
Livegrade’s
image

If you want to

use a computer monitor (or a video monitor attached via DVI) for displaying movies or live video with Livegrade’s Image View in a broadcast-style
(e.g. dimly lit) environment,
exactly match Livegrade’s Image View with the image of a broadcast monitor, or
match Livegrade’s Image View to other, non color-managed software systems such as DaVinci Resolve,

you can perform one of the two actions described below:

Switch off color-management (ColorSync) for Livegrade’s Image View (for installation instructions see below), or
calibrate your monitor by creating a custom ICC profile – using a video gamma of your choice (e.g. 2.4 or 2.45) as the destination gamma of the
profile in the  calibration process.

Performing these steps should lead to the exact
same
image of Livegrade’s Image View on the attached monitor – when compared to a non color-
managed system or the camera signal displayed directly (e.g. via HD-SDI) on a broadcast reference monitor.

How
to
disable
color
management
(ColorSync)
in
Livegrade

Open Livegrade’s preferences, go to the “Advanced” tab (see Figure 1).
Check the checkbox “Disable ColorSync and use video gamma for Image View”.

Figure 1: Disabling ColorSync for Livegrade’s Image View

Note:
It’s possible to output the Image Viewer through the SDI Out when using Livegrade as described in the article Image View Output to HD-SDI in
Livegrade.

Avoiding
Banding
Artifacts
with
ICC
Profiles

For use in the HDLink box Livegrade transforms ICC profiles into 3D LUTs together with all other look processing. Due to the limited number of nodes in
the HDLink’s 3D LUT support (17 x 17 x 17 nodes), some ICC profiles may produce colored banding when used in Livegrade.
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Figure
1:
Sample
images
of
colored
banding
when
using
ICC
profiles.

You can limit the use of ICC to display curves, which in most cases avoids banding artifacts. You can set that in the Preferences dialog of Livegrade:

Figure
2:
Configuring
ICC
processing
of
Livegrade

Switching this setting on has the cause that only the response- or gamma-curve of the ICC profile is applied, but the matrix for the primary colors is
skipped.

 

Why
Does
the
Software
Tell
me
My
License
Is
Already
Activated
?
Each Livegrade license key can be activated on one computer at a time. If an error message appears when you try to activate your license on a new
computer please check if the license has been properly deactivated from the original computer.

You can do this check by logging into your Pomfort Account. The license status needs to be shown as “Inactive” for you to activate the license on
another computer. If this is not the case, please deactivate your license from the computer that it’s shown as activated on.

Find more information about the Pomfort Account here.

I
have
a
problem
with
the
license

The
activation
of
the
license
doesn’t
work

The
license
is
already
activated

According to our software license agreement, each Livegrade license can be active in one computer at a time. However, the license key can be
deactivated and reactivated as many times as needed. The article Migrate a license from one computer to another will help you in the process.

The
license
key
has
a
wrong
format

If the key has a wrong format, you won’t be able to activate it. Generally, the license key has the following format, accordingly to the Livegrade version you
have purchased:

LGPro3-xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx.

Make sure that no spaces are left when entering the key. We recommend to copy and paste the license key directly from the purchase email to avoid any
error.

Alternatively you can also log in to your Pomfort Account to look up your license key and copy it from there.

No
internet
connection

Livegrade needs an internet connection in order to activate and deactivate licenses. Once the license key is active, you can use Livegrade without a
connection.

 

Using
a
wrong
Livegrade
version

Each Livegrade version needs a certain license. The license purchase email we have sent you should show for which Livegrade version the license is
issued.

In case that you have a Livegrade 2 license and would like to upgrade it to Livegrade 3:

Download the latest Livegrade version here
Copy Livegrade to your applications folder and launch it
Open the license panel by choosing “Licenses…” from the Livegrade menu
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If not already activated, activate your existing Livegrade 2 license by clicking on “Add Licenses…”
Click the “Upgrade” button next to the Livegrade License you want to upgrade
Copy the upgrade key from above, paste the key into the upgrade key field, and click on “Upgrade License…”
Your existing license key is now upgraded, you will never need the upgrade key from now on.

For different Livegrade versions see our Download section.

If you still experience issues, then maybe Livegrade’s library is corrupted. The article Reset Livegrade’s Library and Preferences explains how to create a
new library in addition to the preferences reset.

The
license
is
expired

A
license
has
expired

The Livegrade licens is available as a yearly subscription. This way we can assure you always have the latest product. Maybe your license simply expired.

You can check the expiration date of your license either directly in the software, or by logging into your Pomfort Account. 

Visit http://pomfort.com/store/Livegradepro for a new license.

System
time
is
wrong

When the system time on your computer is wrong, the license might not work. Make sure that time and date is set properly in OS X’s System Preferences.

If none of the solutions described above have solved your licensing issues, please contact our support team.

I
have
a
problem
with
the
software

LiveGrade
doesn’t
start

In case that LiveGrade doesn’t launch on your computer, you can reset the preferences for a clean restart.

This is the process to deleting LiveGrade’s preferences:

Quit LiveGrade
Create a copy/backup of the following file (optional)

~/Library/Preferences/com.pomfort.LiveGrade3.plist

The
Library
folder
is
hidden
by
default.
You
can
open
the
Library
folder
in
Finder
when
opening
the
“Go”
menu
and
holding
the
“alt”
key.
You
will
see
an
extra
entry
“Library”
in
the
“Go”
menu.
Choose
this
entry
and
a
Finder
window
will
open
with
the
Library
folder.

Open up the Terminal application (type terminal in your spotlight or navigate within the Utilities folder of your application folder)

Type the following command in your terminal window

defaults	delete	com.pomfort.LiveGrade3

Start LiveGrade, now LiveGrade should start as usual.

If you still experience issues, then maybe LiveGrade’s library is corrupted. The article Reset LiveGrade’s Library and Preferences explains how to create a
new library in addition to the preferences reset.

If you have differing problems see the complete Troubleshooting section for more help articles (like e.g. Troubleshooting HDLink Devices in LiveGrade). If
the problems persist, please contact our support team.

LiveGrade
hangs
or
crashes
repeatedly

In the rare case that LiveGrade hangs or crashes repeatedly, you can send automatically created reports to our support. You can do this by:

Choosing “Contact Support” in the “Help” menu of LiveGrade.
Enter your personal information (name and email) so that we can get back to you.
Enter a short description:

What steps do you perform in the software that lead to the problem,
what happens, when you perform these steps, and
what you would expect the software to do instead.

In addition to your message, the form will include crash reports, log files and system information that will help our support to trace possible bugs.

 

Transfer
Large
Livegrade
Projects
If large projects are to be transferred from one computer to the other, the upper limit of 2GB for .PFLA Look Archives may exceed.

In this article, we will show you how to copy the folder of your Livegrade project, which is stored in the Library of your computer and can be located via
Livegrade
>
Show
Library
in
Finder.

Note: The Livegrade version of the new computer should be at least as advanced as that of the old one.

Export
project
settings
and
transfer
media
files

As copying the Livegrade project’s folder doesn’t contain your settings and associated media files, one should take care of them beforehand:

1. Copy
the
media
folder
of
your
project
to
the
new
computer.
To locate your currently used media folder, open Livegrade settings and go to the
recording tab. Copy the media files of this folder to your new computer, so that you can access them after transferring your project. Ideally, choose
the same on the new computer path as you did on the old.
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2. Export
Settings
via
Livegrade
>
Settings
Import/Export
>
Export
…
Make sure to select all types of settings you wish to transfer.

Copy
the
Project’s
folder
to
the
new
computer

As the media files are already copied to the new computer and your project settings have been exported, you are ready to copy the project:

1. Locate the currently used project folder in the library via Livegrade
>
Show
Library
in
Finder.

Locate the Livegrade project folder via Livegrade > Show Library in Finder

2. Quit
Livegrade on the old and the new computer. This is important before you continue with step 3.
3. Copy the whole project folder (e.g. Project-2329042CC769) to the same path (…/Library/Application

Support/Pomfort/LivegradeStudio6/) on the new computer.
4. Open Livegrade on the new computer
5. Open your project via the project chooser.
6. Import the settings via Livegrade
>
Settings
Import/Export
>
Import
…
7. If your media folder changed, add the media folder to your Livegrade project via
Livegrade
>
Settings
>
Recording
8. After adding your media folder to your project you should now be able to continue working as before.

How
to
Reset
Library
and
Preferences
In the unusual event that Livegrade is not able to launch, you will have to reset its Library and Preferences.

 

Warning:
This
can’t
be
undone,
deleting
the
library
will
delete
the
grading
history,
preset
grades
and
grade
groups.

 

Reset
Livegrade’s
Library

To reset the Library, please follow these steps:

1. Quit the Livegrade app

2. In Finder press ⌘⇧G and copy&paste the following line in the dialog box:

For Livegrade v6:

Livegrade Pro: ~/Library/Application
Support/Pomfort/Livegrade6
Livegrade Studio: ~/Library/Application
Support/Pomfort/LivegradeStudio6

For Livegrade v5:

Livegrade Pro: ~/Library/Application
Support/Pomfort/Livegrade5
Livegrade Studio: ~/Library/Application
Support/Pomfort/LivegradeStudio5

 

3. Rename the LivegradeX
folder to LivegradeX_old and back it up afterwards. All the grading history, preset grades and grade groups will be backed up in
the old database.

4. Open the Livegrade app again. It will automatically create a new library folder.

 

Reset
preferences

In order to reset Livegrade’s preferences, open a Terminal window. Then copy and paste the following line:

For Livegrade v6:

Livegrade Pro: defaults
delete
com.pomfort.LiveGrade6
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Livegrade Studio: defaults
delete
com.pomfort.LiveGradeStudio6

For Livegrade v5:

Livegrade Pro: defaults
delete
com.pomfort.LiveGrade5
Livegrade Studio: defaults
delete
com.pomfort.LiveGradeStudio5

 

Press “return” and the preferences will be reset.

 

Now Livegrade should start as usual.
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